
Bitte lesen Sie diese Bedienungsanleitung vor der Inbetriebnahme dieses Produkts aufmerksam durch, und 
bewahren Sie sie für späteres Nachschlagen auf.
Bitte den Abschnitt “Bitte lesen Sie zuerst diesen Hinweis!” (Seiten 3 bis 5) dieses Handbuchs 
unbedingt vor der Inbetriebnahme lesen.
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Warenzeichen und eingetragene Warenzeichen

	p Die Begriffe HDMI und HDMI High-Definition Multimedia 
Interface sowie das HDMI-Logo sind Marken oder 
eingetragene Marken von HDMI Licensing Administrator, 
Inc. in den Vereinigten Staaten und anderen Ländern.
	p NDI® ist eine in den Vereinigten Staaten von Amerika und 

anderen Ländern eingetragene Marke von NewTek, Inc.
	p Andere in dieser Bedienungsanleitung enthaltene 

Firmennamen und Produkte können Warenzeichen oder 
eingetragene Warenzeichen des jeweiligen Eigentümers 
darstellen.

Copyright und Lizenz

Verteilen, Kopieren, Zerlegen, Nacherstellen und Nachbauen 
der mit dem Gerät gelieferten Software, sowie auch deren 
Export unter Verletzung der Exportgesetze ist ausdrücklich 
verboten.

Abkürzungen

Die folgenden Abkürzungen werden in diesem Handbuch 
verwendet.
	p Personal Computer werden mit “Computer” bezeichnet.

Abbildungen und Bildschirmanzeigen im 
Handbuch

	p Der Inhalt der Abbildungen und Bildschirmanzeigen 
in diesem Handbuch kann vom tatsächlichen 
Erscheinungsbild abweichen.

	p Informationen zur Software für dieses Produkt
1.  Zum Lieferumfang dieses Produkts gehört Software, die unter den Benutzerlizenzen GNU General Public License 

(GPL) und GNU Lesser General Public License (LGPL) vertrieben wird. Der Benutzer wird hiermit darauf aufmerksam 
gemacht, dass er das Recht zu Erhalt, Modifikation und Verteilung des Quellcodes dieser Software besitzt.

  Um die Quellcodes zu erhalten, rufen Sie die folgende Internet-Seite auf:
 https://pro-av.panasonic.net/en/
  Der Hersteller bittet Benutzer darum, von Anfragen hinsichtlich der bezogenen Quellcodes und anderer Einzelheiten an 

seine Vertreter Abstand zu nehmen.
2.  Zum Lieferumfang dieses Produkts gehört Software, die unter MIT-Lizenz lizenziert wird.
3.  Dieses Produkt enthält Software, die unter der Lizenz des FreeType Project (www.freetype.org) lizenziert ist.

Weitere Informationen hierzu finden Sie auf der folgenden Website.
https://pro-av.panasonic.net/manual/en/index.html
Einzelheiten siehe Originaltext (in englischer Sprache).
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Bitte lesen Sie zuerst diesen Hinweis!

WARNUNG:
Zubehör (Masseschrauben, Kabelschellen) stets 
außerhalb der Reichweite von Säuglingen und 
kleinen Kindern aufbewahren.

WARNUNG:
Dieses Gerät ist mit der Klasse A von CISPR32 kompatibel.
In einer Wohngegend kann dieses Gerät 
Funkstörungen verursachen.

VORSICHT:
Öffnen Sie nicht das Gerät durch Abschrauben von 
Gehäuseteilen.
Zur Vermeidung von elektrischem Schlag darf das 
Gehäuse nicht geöffnet werden. Im Geräteinneren 
befinden sich keine Teile, die vom Benutzer gewartet 
werden können.
Wartungs- und Reparaturarbeiten grundsätzlich 
autorisiertem Kundendienstpersonal überlassen.

VORSICHT:
Im Inneren des Geräts befindet sich eine 
Knopfbatterie.
Setzen Sie das Gerät keiner großen Hitze aus, wie 
beispielsweise direktem Sonnenlicht oder Feuer.

VORSICHT:
Offene Flammen, wie brennende Kerzen, sollten nicht 
auf das Gerät gestellt werden.

WARNUNG:
•  Zur Reduzierung der Gefahr von Brand und 

elektrischem Schlag dieses Gerät weder Nässe 
noch Feuchtigkeit aussetzen.

•  Um Brand- oder Stromschlaggefahr zu reduzieren, 
muss dieses Gerät von allen Flüssigkeiten 
ferngehalten werden. Vermeiden sie Gebrauch 
und Lagerung des Gerätes an Orten, an denen 
die Gefahr besteht, dass es mit Flüssigkeiten 
betropft oder bespritzt wird, und stellen sie keine 
Flüssigkeitsbehälter auf das Gerät.

 ist die Sicherheitsinformation.

VORSICHT:
Nur das empfohlene Zubehör verwenden, um die 
Gefahr von Feuer und elektrischem Schlag sowie 
Störungen auszuschalten.

VORSICHT:
Um eine ausreichende Belüftung zu gewährleisten, 
dieses Gerät nicht in einem Bücherregal, 
Einbauschrank oder an einem anderen engen 
Platz aufstellen. Sicherstellen, dass die 
Ventilationsöffnungen im Gehäuse nicht durch 
Vorhänge oder andere Materialien blockiert werden; 
anderenfalls besteht die Gefahr von elektrischem 
Schlag oder Feuer aufgrund von Überhitzung.

VORSICHT:
Ein unbehinderter Zugang zum Netzstecker des 
Netzkabels muss jederzeit gewährleistet sein.
Die Steckdose (Netzsteckdose) sollte in der Nähe 
des Gerätes installiert werden und leicht zugänglich 
sein. Zur vollständigen Trennung dieses Gerätes vom 
Netz ziehen sie den Netzstecker aus der Steckdose.

WARNUNG:
Dieses Gerät muss geerdet werden.
Um sicheren Betrieb zu gewährleisten, darf der 
Drei-Stift-Stecker nur in eine standardmäßige 
Schutzkontakt-Steckdose eingesteckt werden, die 
über das normale Haushaltsnetz geerdet ist.
Die mit dem Gerät verwendeten Verlängerungskabel 
müssen drei Adern aufweisen und korrekt verdrahtet 
sein, um eine einwandfreie Erdverbindung zu 
gewährleisten. Falsch verdrahtete Verlängerungskabel 
stellen eine Hauptursache für tödliche Unfälle dar.
Die Tatsache, dass das Gerät zufrieden stellend 
arbeitet, bedeutet nicht, dass die Steckdose geerdet 
oder die Installation völlig sicher ist. Falls Sie Zweifel 
über die effektive Erdung der Steckdose haben, 
konsultieren Sie bitte zu Ihrer Sicherheit einen 
qualifizierten Elektriker.
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Bitte lesen Sie zuerst diesen Hinweis!

Vorsichtshinweis zum Netzkabel
BITTE LESEN SIE IM INTERESSE IHRER SICHERHEIT DEN FOLGENDEN TEXT AUFMERKSAM DURCH.
Dieses Gerät wird mit Netzkabeln in drei verschiedenen Ausführungen geliefert.

Bitte achten Sie unbedingt darauf, das für das jeweilige Bestimmungsgebiet vorgesehene Netzkabel zu verwenden, 
da die andere Ausführung nicht für Ihr Land geeignet ist.

FÜR KONTINENTALEUROPA USW.
Nicht für den Gebrauch in 
Großbritannien bestimmt.

NUR FÜR GROSSBRITANNIEN NUR FÜR INDIEN

 ist die Sicherheitsinformation.

Hergestellt von: 
Panasonic Connect Co., Ltd.
4-1-62 Minoshima, Hakata-ku, Fukuoka 812-8531, Japan
Importeur:
Panasonic Connect Europe GmbH
Hagenauer Strasse 43, 65203 Wiesbaden, Deutschland
Vertretungsberechtigter in der EU:
Panasonic Connect Europe GmbH
Panasonic Testing Centre
Winsbergring 15, 22525 Hamburg, Deutschland

Die Symbole an diesem Produkt (einschließlich Zubehör) haben die folgenden Bedeutungen:

Wechselstrom

Gleichstrom
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Entsorgung von Altgeräten und Batterien
Nur für die Europäische Union und Länder mit Recyclingsystemen
Dieses Symbol, auf den Produkten, der Verpackung und/oder den Begleitdokumenten, bedeutet, dass gebrauchte elektrische und 
elektronische Produkte sowie Batterien nicht in den allgemeinen Hausmüll gegeben werden dürfen.
Bitte führen Sie alte Produkte und verbrauchte Batterien zur Behandlung, Aufarbeitung bzw. zum Recycling gemäß den 
gesetzlichen Bestimmungen den zuständigen Sammelpunkten zu. Endnutzer sind in Deutschland gesetzlich zur Rückgabe von 
Altbatterien an einer geeigneten Annahmestelle verpflichtet. Batterien können im Handelsgeschäft unentgeltlich zurückgegeben 
werden.
Indem Sie diese Produkte und Batterien ordnungsgemäß entsorgen, helfen Sie dabei, wertvolle Ressourcen zu schützen und 
eventuelle negative Auswirkungen, insbesondere beim Umgang mit lithiumhaltigen Batterien, auf die menschliche Gesundheit und 
die Umwelt zu vermeiden.
Für mehr Informationen zu Sammlung und Recycling, wenden Sie sich bitte an Ihren örtlichen Abfallentsorgungsdienstleister. 
Gemäß Landesvorschriften können wegen nicht ordnungsgemäßer Entsorgung dieses Abfalls Strafgelder verhängt werden.

Hinweis für das Batteriesymbol (Symbol unten):
Dieses Symbol kann in Kombination mit einem chemischen Symbol abgebildet sein. In diesem Fall erfolgt dieses auf Grund der 
Anforderungen derjenigen Richtlinien, die für die betreffende Chemikalie erlassen wurden.

Bitte lesen Sie zuerst diesen Hinweis!

ENTFERNEN DER BATTERIE
Back-Up-Batterie (Lithium-Batterie)
• Zur Entfernung und Entsorgung der Batterie nach ihrem Lebenszyklus, fragen Sie bitte Ihren Händler.

EMV-HINWEIS FÜR DEN KÄUFER/ANWENDER DES GERÄTS

1. Erforderliche Bedingungen zur Einhaltung der oben genannten Standards
 <1>  An das Gerät angeschlossene Geräte und spezielle Verbindungskabel
  •  Der Käufer/Anwender sollte nur Geräte verwenden, die von uns als Zusatzgeräte für den Anschluss an das Gerät 

empfohlen wurden.
  • Der Käufer/Anwender sollte nur die unten aufgeführten Verbindungskabel verwenden.
 <2> Für den Anschluss abgeschirmte Kabel verwenden, die dem Gerätezweck entsprechen.
  •  Videokabel 

Für SDI (Serial Digital Interface) doppelt abgeschirmte 75-Ohm HF-Koaxialkabel verwenden. 
Für analoge Videosignale werden 75-Ohm HF-Koaxialkabel empfohlen.

  •  Audiokabel 
Verwenden Sie Kabel für AES/EBU, wenn Ihr Gerät serielle digitale AES/EBU-Audiosignale unterstützt. 
Verwenden Sie für analoge Audiosignale abgeschirmte Kabel für hochwertige HFÜbertragungen.

  •  Weitere Kabel (LAN, RS-422) 
Verwenden Sie abgeschirmte Kabel für hochwertige HF-Anwendungen.

  •  Für die Verbindung zum DVI-Signalanschluss muss ein Kabel mit Ferritkern verwendet werden.
  •  Wird Ihr Gerät mit Ferritkernen geliefert, müssen diese an den Kabeln befestigt werden, siehe Angaben in dieser 

Anleitung.

2. Leistungsniveau
  Das Leistungsniveau des Geräts entspricht oder übersteigt das von diesen Standards verlangte Leistungsniveau. 

Das Gerät kann aber durch Nutzung in einer EMV-Umgebung, wie Bereichen mit starken elektromagnetischen Feldern 
(durch Sendemasten, Mobiltelefone etc.) störend beeinflusst werden. Um in diesen Situationen die störenden Einflüsse 
auf das Gerät zu minimieren wird empfohlen, folgende Schritte für betroffene Geräte und Betriebsumgebungen 
durchzuführen:

  1.  Positionieren Sie das Gerät von der Störquelle entfernt.
  2.  Ändern Sie die Geräterichtung.
  3.  Ändern Sie die Anschlussmethode des Geräts.
  4.  Schließen Sie das Gerät an eine andere Stromverbindung, die mit keinen weiteren Geräten geteilt wird.
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 wÜbersicht
Dieses Gerät ist ein digitaler 1-ME-Videomischer, der eine Vielzahl von 3G- und HD-Formaten unterstützt.
Trotz der kompakten Abmessungen bietet es vier SDI-Eingänge, zwei HDMI-Eingänge, zwei SDI-Ausgänge, einen HDMI-
Ausgang, vier IP-Eingänge, zwei IP-Ausgänge und einen analogen 2-Kanal-Ein-/Ausgang.
Der Kompakte Live Mischer AV-HSW10 ist mit IP-E/A-Systemen wie NDI*1/SRT/RTMP sowie 3G-SDI kompatibel und bietet 
Grundfunktionen, die sonst größeren Mid-Range-Geräten vorbehalten sind, sodass mit dem Gerät HD-Videos produziert 
werden können.
Dank seiner hervorragenden Tragbarkeit kann das All-in-One-Hauptgerät problemlos zu Live-Einsätzen bei Musik-, Sport- und 
Unterhaltungsevents transportiert werden.
Dank seiner Unterstützung für 3G/HD-Multiformat verfügt es außerdem über eine Vielzahl von IP-Ein- und IP-Ausgängen und ist 
UVC-kompatibel. Daher eignet es sich für den Einsatz bei Veranstaltungen mit mehreren Kameras*2 ebenso wie für die direkte 
Videoübertragung auf vielerlei Weise aus der Ferne.
Um eine Vielzahl von Programmproduktionstechniken zu ermöglichen, stehen Keyer zur Verfügung, darunter zwei Kanäle für 
PinP und ein Kanal für Chroma-Key.
Darüber hinaus können Sie selbst bei Szenen mit unterschiedlichen Formaten die Videoausgabe flexibel auswählen, um sie 
dem Einsatzzweck anzupassen. Unter anderem stehen Ihnen Funktionen wie Up-/Downkonverter und ein HDMI-Scaler zur 
Verfügung.
Unser Ziel war es, das Produkt für eine Vielzahl von mobilen Anwendungen nützlich zu machen, etwa für spezielle 
Veranstaltungsorte, Übertragungsfahrzeuge, Universitäts- und Firmenpräsentationen usw. – und natürlich auch für den Einsatz 
in Rundfunkanstalten. Bei der Vor-Ort-Produktion von Live-Bildern kommt die enorme Leistungsfähigkeit dieses kompakten 
Live-Mischers perfekt zur Geltung.

*1  NDI® steht für NDI® mit hoher Bandbreite, NDI®|HX für hocheffizientes NDI®|HX mit geringer Bandbreite.  
NDI® ist ein Protokoll für Abläufe in der Livebild-Produktion unter Nutzung von IP. Es wurde von NewTek, Inc. entwickelt.

*2  4K/HD-Remote-Kameras und der Speicherkarten-Camcorder AG-CX350 von Panasonic. 
Eine Aufstellung von 4K/HD-Remote-Kameras, die mit NDI® und NDI®|HX kompatibel sind, finden Sie auf der folgenden 
Panasonic-Website:  
https://pro-av.panasonic.net/en/

 wBezüglich des Typenschilds
Name, Modellnummer und Nennleistung des Geräts sind auf der Seite angegeben.

 wHaftungsausschluss
Panasonic Connect Co., Ltd. IST UNTER ANDEREM IN KEINEM DER UNTEN AUFGEFÜHRTEN FÄLLE GEGENÜBER 
JURISTISCHEN PERSONEN ODER PERSONEN HAFTBAR, ES SEI DENN ES HANDELT SICH UM DEN ERSATZ ODER DIE 
ZUMUTBARE WARTUNG DES PRODUKTS:

1  SCHADENSANSPRÜCHE JEGLICHER ART, EINSCHLIESSLICH UND OHNE EINSCHRÄNKUNGEN 
UNMITTELBARER, MITTELBARER, ZUSÄTZLICHER, FOLGE- ODER ÜBER DEN VERURSACHTEN SCHADEN 
HINAUSGEHENDER SCHADENSANSPRÜCHE;

2  KÖRPERVERLETZUNGEN ODER SONSTIGE SCHÄDEN, DIE AUF DEN UNSACHGEMÄSSEN GEBRAUCH ODER 
DEN FAHRLÄSSIGEN BETRIEB DURCH DEN BENUTZER ZURÜCKZUFÜHREN SIND;

3  UNZULÄSSIGES ZERLEGEN, REPARIEREN ODER VERÄNDERN DES PRODUKTS DURCH DEN BENUTZER;
4  UNANNEHMLICHKEITEN ODER VERLUSTE, WENN BILDER AUS IRGENDWELCHEN GRÜNDEN ODER URSACHEN 

NICHT ANGEZEIGT WERDEN, EINSCHLIESSLICH EINES AUSFALLS ODER PROBLEMS DES GERÄTS;
5  JEGLICHE STÖRUNGEN, MITTELBARE UNANNEHMLICHKEITEN, ODER VERLUSTE ODER SCHÄDEN, DIE SICH 

AUS DEM ZUSAMMENSCHALTEN DES SYSTEMS MIT GERÄTEN VON FREMDHERSTELLERN ERGEBEN;
6  JEGLICHE UNANNEHMLICHKEITEN, BESCHÄDIGUNGEN ODER VERLUSTE DURCH UNFÄLLE, DIE AUF 

UNANGEMESSENE INSTALLATIONSMETHODEN ODER ANDERE FAKTOREN ALS EINEN DEFEKT DES PRODUKTS 
ZURÜCKZUFÜHREN SIND;

7  VERLUST AUFGEZEICHNETER DATEN AUFGRUND EINES AUSFALLS;
8  BESCHÄDIGUNGEN ODER SCHÄDEN, DIE AUF VERLUST ODER SCHWUND VON BILDDATEN ODER 

EINSTELLUNGSDATEN ZURÜCKZUFÜHREN SIND, WELCHE AUF DIESEM GERÄT, EINEM USB-SPEICHERGERÄT 
ODER EINEM COMPUTER GESPEICHERT WURDEN.

Vor dem Gebrauch
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 wNetzwerksicherheit
Das Gerät besitzt auch Funktionen, die bei Anschluss an ein Netzwerk verwendet werden. Die Benutzung des Gerätes mit 
Netzwerkanschluss kann möglicherweise folgende Probleme aufwerfen.

1 Durchsickern von Informationen über das Gerät
2  Böswilliger Gebrauch des Geräts für rechtswidrige Zwecke
3  Störung bzw. Sperrung des Geräts durch Personen in böswilliger Absicht

Der Benutzer ist dafür verantwortlich, sich durch die im Folgenden beschriebenen Maßnahmen gegen netzwerkbedingte 
Sicherheitsrisiken zu schützen.

 p Verwenden Sie dieses Gerät in einem Netzwerk, das durch eine Firewall usw. gesichert ist.
 p Soll dieses Gerät an ein Netzwerk angeschlossen werden, das Computer enthält, vergewissern Sie sich (mithilfe eines 
regelmäßig aktualisierten Antivirus-Programms, Anti-Spyware-Programms usw.), dass das System nicht mit Computerviren 
oder anderen bösartigen Objekten infiziert ist.

Die folgenden Punkte sollten ebenfalls berücksichtigt werden.
 p Die Benutzung mit demselben Segment wird für Equipment empfohlen, das mit diesem Gerät verbunden wird. 
Wird das Gerät mit Equipment verbunden, dessen Segmente unterschiedlich sind, können beispielsweise Ereignisse 
auftreten, die von den Einstellungen der Netzwerkausrüstung abhängig sind. Überprüfen Sie daher die Anschlüsse an das 
Equipment, mit dem das Gerät verbunden wird, bevor Sie mit dem Betrieb beginnen.

 pWählen Sie keinen Aufstellungsort, an dem das Gerät, Kabel und andere Teile leicht beschädigt werden können.
 p In bestimmten Netzwerkumgebungen kann die NDI-Kommunikation gestört werden (instabile Übertragung). 
Ermitteln Sie die voraussichtlich benötigte NDI-Bandbreite, indem Sie die zu übertragende NDI-Datenkommunikation 
überschlagen. Stellen Sie sicher, dass die verfügbare Geschwindigkeit für die Übertragung ausreicht. 
Wenn eine NDI-Quelle mehrfach angesprochen wird, wächst die NDI-Signalmenge auf Übertragungsseite entsprechend der 
Anzahl der Verbindungen an. 
Falls der Systemaufbau es möglicherweise erfordert, sollten Sie den Einsatz von Multicasting untersuchen.

Vor dem Gebrauch
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 Vorsichtig handhaben
  Das Produkt nicht fallen lassen oder starken Stößen oder 

Erschütterungen aussetzen.  
Das Produkt keinesfalls am Überblendhebel tragen oder 
bewegen. Dies ist wichtig, um Störungen oder Unfälle zu 
verhüten.

  Betriebstemperaturbereich von 0 °C bis 
40 °C

  Vermeiden Sie eine Verwendung dieses Produkts an 
einem sehr kalten (unter 0 °C) oder sehr warmen (über 
40 °C) Ort, da extrem niedrige oder hohe Temperaturen 
die internen Teile negativ beeinflussen.

  Stromversorgung ausschalten, bevor 
Kabel angeschlossen oder abgetrennt 
werden

  Vor dem Anstecken oder Abziehen der Kabel, unbedingt 
die Stromversorgung ausschalten.

  Feuchtigkeit und Staub vermeiden
  Vermeiden Sie die Verwendung dieses Produkts an einem 

feuchten oder staubigen Ort, da übermäßige Feuchtigkeit 
oder Staub zu einer Beschädigung der internen Teile 
führen kann.

  Pflege
  Schalten Sie die Stromversorgung des Gerätes aus, und 

wischen Sie das Produkt mit einem trockenen Tuch ab. 
Um hartnäckigen Schmutz zu entfernen, tauchen Sie 
ein Tuch in verdünnte Haushaltsreinigerlösung (neutral), 
wringen Sie es gut aus, und wischen Sie dann das Produkt 
sachte ab. Nachdem Sie das Produkt mit einem feuchten 
Tuch abgewischt haben, wischen Sie mit einem trockenen 
Tuch nach.

•  Vermeiden Sie Benzin, Lackverdünner und andere 
flüchtige Flüssigkeiten.

•  Wenn Sie ein chemisches Reinigungstuch verwenden 
wollen, lesen Sie die Gebrauchsanleitung sorgfältig 
durch.

Vorsicht

  Während der Produktion zu beachtende 
Vorsichtsmaßnahmen

  Die Bildumschalt- und Bildeffektfunktionen dieses Produkts 
können verwendet werden, um Bilder zu erzeugen, die 
stark flimmern oder sich schnell ändern.

  Wenn Sie diese Funktionen bei der Produktion benutzen, 
sollten Sie jedoch bedenken, dass derartige Bilder einen 
negativen Einfluss auf das Wohlbefinden des Betrachters 
haben können.

  Wenn das Produkt ausrangiert werden 
soll

  Wenn das Produkt am Ende seiner Lebensdauer 
ausrangiert werden soll, beauftragen Sie einen 
Fachbetrieb mit seiner sachgerechten Entsorgung, um die 
Umwelt zu schützen.

 Bezüglich der Verbrauchsteile
Ventilator:
  Dies ist ein Verbrauchsteil. 
  In der Regel sollte die Einheit etwa alle 5 Jahre 

ausgetauscht werden (wenn die Einheit 15 Stunden 
täglich in Betrieb war).

Netzadapter:
  Dies ist ein Verbrauchsteil. 
  In der Regel sollte die Einheit etwa alle 5 Jahre 

ausgetauscht werden (wenn die Einheit 15 Stunden 
täglich in Betrieb war).

Der Zeitraum, nach dem die Verbrauchsteile 
ausgetauscht werden müssen, hängt von den jeweiligen 
Betriebsbedingungen ab.
Wenn der Zeitpunkt zum Austauschen eines dieser 
Teile gekommen ist, lassen Sie diese Arbeit unbedingt 
von Ihrem Händler durchführen.

Vorsichtsmaßnahmen zum Gebrauch



12

 qBeachten Sie neben den unter “Bitte lesen Sie zuerst diesen Hinweis!” aufgeführten 
Punkten auch die folgenden Vorsichtsmaßnahmen.

Lassen Sie das Gerät nur von dem Händler, bei dem Sie es gekauft haben, installieren und anschließen.

Anschließen der Stromversorgung
 p Verwenden Sie nur das mit dem 
Gerät gelieferte Netzkabel und den 
mitgelieferten Netzadapter.

 p Schließen Sie die Erdklemme (SIGNAL 
GND) an der Rückwand des Gerätes 
unbedingt an die Systemmasse an.

 p Schieben Sie den Netzadapter vollständig hinein.
 p Soll das Gerät längere Zeit nicht benutzt werden, schalten 
Sie es aus, und ziehen Sie den Netzstecker von der 
Netzsteckdose ab.

Sorgfältig behandeln!
 p Fallenlassen des Gerätes oder Einwirkung starker 
Erschütterungen oder Vibrationen können Schäden und/
oder Funktionsstörungen verursachen.

Verhüten Sie das Eindringen von Fremdkörpern in 
das Gerät!

 p Das Eindringen von Wasser, Metallteilen, Essenresten oder 
anderen Fremdkörpern in das Gerät kann einen Brand und/
oder elektrische Schläge verursachen.

Wahl des optimalen Installationsorts
 p Dieses Gerät ist nur für den Inneneinsatz ausgelegt.
 p Installieren Sie das Gerät für den Gebrauch auf einer 
ausreichend festen, stabilen und ebenen Oberfläche.

 p Halten Sie einen Abstand von mindestens 100 mm um die 
Lüftungsöffnungen des Gerätes ein, um eine Behinderung 
der Lüftung zu vermeiden.  
Halten Sie insbesondere ausreichenden Abstand zwischen 
den Lüftungsöffnungen und den Kabeln ein, wenn das 
Gerät in eine Tafel oder einen Tisch eingebaut wird.

 p Installieren Sie das Gerät nicht auf eine Weise, dass seine 
Kabel und anderes Zubehör leicht beschädigt werden 
können.

 p Installieren Sie das Gerät nicht an einem Ort, an dem die 
Temperatur unter 0 °C fällt oder über 40 °C steigt.

 p Vermeiden Sie die Installation des Gerätes an Orten, wo es 
direktem Sonnenlicht oder der warmen Abluft von anderen 
Produkten ausgesetzt ist.

 p Die Installation des Gerätes an einem sehr feuchten, 
staubigen oder vibrationsanfälligen Ort kann Störungen zur 
Folge haben.

Lufteinlass

LuftauslassLufteinlass

Installationshinweise



13

Kompaktes Design, zahlreiche Ein- und Ausgänge
 p  Trotz der kompakten Abmessungen bietet das Gerät vier 
SDI-Eingänge, zwei HDMI-Eingänge, zwei SDI-Ausgänge 
und einen HDMI-Ausgang.  
Außerdem unterstützt es eine Vielzahl von Szenarien 
bei der Live-Abmischung und verfügt dafür über IP-Ein- 
und IP-Ausgänge, einen Referenzeingang, einen 
durchgeschliffenen Ausgang, einen analogen 2-Kanal-
Audioeingang und -ausgang sowie einen UVC-Ausgang.

 p Neben den Hintergrundübergängen mit Schnitten, Mixes 
und Wischübergängen verfügt das Gerät auch über zwei 
Keyer, darunter einen Kanal für Chroma-Keys und zwei 
PinP-Kanäle.

 p Mit der Multi-View-Anzeigefunktion kann ein einzelner 
Monitor so aufgeteilt werden, dass bis zu 16 Videos 
dargestellt werden können.

 p Die Ein- und Ausgänge unterstützen 3G/HD-SDI, und 
jeder Eingang ist mit einem Frame-Synchronizer (FS) 
ausgestattet.

 p Es werden viele IP-Ein- und IP-Ausgabesysteme 
unterstützt, darunter NDI, NDI|HX, SRT und RTMP.

 p Mit den analogen 2-Kanal-Audioeingängen kann über 
einen beliebigen Ausgangsbus ein Audiosignal eingebettet 
werden.  
Außerdem können Sie Eingangspegel und 
Audioverzögerung anpassen.

Unterstützung verschiedener Formate
 p Die folgenden Signalformate werden unterstützt:

2K-Formate:
1080 × 59,94p, 1080 × 50p, 1080 × 29,97p, 1080 × 25p, 
1080 × 24p, 1080 × 23,98p, 1080 × 59,94i, 1080 × 50i

HD-Formate:
720×59,94p, 720×50p

 p Es werden verschiedene 2K/HD-Formate unterstützt.
 p Es wird eine große Vielfalt von Schnittstellen unterstützt, 
beispielsweise 3G-SDI, 1.5G-SDI, HDMI und IP.

 p Es können maximal vier SDI-, zwei HDMI- und vier 
IP-Eingänge genutzt werden.

 p Es können maximal zwei SDI-, ein HDMI- und zwei 
IP-Ausgänge genutzt werden.

 p Zwei Keyer ermöglichen eine Fülle von Videoeffekten.
 p Funktionen wie Up-/Downkonverter stehen zur Verfügung.
 p Die Ausstattung umfasst zwei AUX BUS. Es gibt eine MIX-
Übergangsfunktion.

 p Eine Netzwerkkamera-Steuerungsfunktion ermöglicht 
die Tally-Steuerung von bis zu neun Panasonic-4K/
HD-Remote-Kameras.

 p Chroma-Key wird unterstützt.
 p Der Videospeicher (zwei für Standbilder) erlaubt das 
Aufnehmen und Abrufen mit angeschlossenen Key-
Signalen.

 p Die Ausstattung umfasst eine Shot-Speicher-Funktion.
 p Das Gerät ist mit USB-Speichergeräten kompatibel.

Funktionen
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Prüfen Sie nach, ob die folgenden Zubehörteile vollzählig vorhanden sind.
 p Nachdem Sie das Produkt aus seinem Behälter genommen haben, entsorgen Sie die Netzkabelkappe (falls enthalten) und 
das Verpackungsmaterial auf angemessene Weise.

 p Zum Lieferumfang gehört Kabelsicherung (Kabelklemme), die das versehentliche Lösen des Netzadapters aus dem Gerät 
verhindert.

Netzadapter ................................1
Kabelklemme ..............................1

Netzkabel für AV-HSW10E .........3
 p Für Vereinigtes Königreich 
und Saudi-Arabien

 p Für Kontinentaleuropa usw.  p Nur für Indien

 p Dieses Gerät wird mit Netzkabeln in drei verschiedenen Ausführungen geliefert. 
Bitte achten Sie unbedingt darauf, das für das jeweilige Bestimmungsgebiet vorgesehene Netzkabel zu verwenden, da die 
andere Ausführung nicht für Ihr Land geeignet ist.

Zubehör
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Kabelsicherung anbringen

DC IN 16V

Kabelsicherung lösen

1 Drücken Sie die Sicherung zwischen den mit 1 
markierten Stellen zusammen, und ziehen Sie 
die Sicherung in Richtung 2 aus dem Gerät.

DC IN 16V







Netzadapter fixieren

1 Öffnen Sie die Kabelsicherung.

DC IN 16V

2 Verbinden Sie den Netzadapter mit dem Gerät.

DC IN 16V

3 Legen Sie das Kabel des Netzadapters in die 
Sicherung, und verriegeln Sie die Sicherung.

DC IN 16V

Zubehör
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Teile und ihre Funktionen
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1 POWER-Anzeige [POWER]
Diese Anzeige leuchtet, wenn der Netzschalter 
POWER (F) an der Rückseite auf ON gestellt wird, 
während die Netzeingangsbuchse DC IN (U) mit Strom 
versorgt wird.

2 ALARM-Anzeige [ALARM]
Diese Anzeige leuchtet, wenn der Ventilator (T) nicht 
mehr läuft, wenn ein Problem mit der Stromversorgung 
vorliegt (Spannungsabfall) oder wenn die Temperatur im 
Gerät ungewöhnlich hoch ist.
In diesem Fall wird eine Alarmmeldung im OSD-Menü 
angezeigt, wenn dieses auf einem externen Monitor 
aufgerufen wird (Status OSD ON).
Die Alarmmeldung kann über den Geräteanschluss TALLY/
GPI (N) an ein externes Gerät ausgegeben werden.
 Siehe “Alarmmeldung”.
Wenn ein Alarm aufgetreten ist, unterbrechen Sie 
sofort die Benutzung des Gerätes, und kontaktieren Sie 
unbedingt Ihren Händler. 
Eine Weiterbenutzung des Gerätes nach dem Auftreten 
eines Alarms kann zu einer Beschädigung des Gerätes 
führen. 

3 STREAM-Taste [STREAM]
Übertragungen können mit SRT/RTMP direkt an diesem 
Gerät gestartet, beendet und in den Bereitschaftsmodus 
geschaltet werden. Die Farbe der LED zeigt den 
Übertragungsstatus an. (AUS: Aus (*1), Standby: Grün, 
aktive Übertragung: Rot)
Das Gerät verfügt über zwei Übertragungskanäle (CH1 
und CH2). Halten Sie die Taste [SHIFT] (6) gedrückt, um 
mit CH2 zu arbeiten.

Tasten-  
betätigung

Übertragungs-  
kanal: LED

Drücken Gedrückt halten

OFF: Aus (*1) Aktive 
Übertragung: Rot

Standby: Grün

Standby: Grün Aktive 
Übertragung: Rot

OFF: Aus (*1)

Aktive Übertragung: 
Rot

Standby: Grün OFF: Aus (*1)

*1   Farbeinstellung für Anzeigen unter “Color Group” in [12] 
“Config > Button Illumination > Color Group Other > 
STREAM”.

4 USER-Tasten [USER 1, USER 2, USER 3]
Sie können den Tasten [USER 1], [USER 2] und [USER 3] 
sechs beliebige Menüfunktionen zuweisen.
Die in [USER 1] und [USER 4] abgelegten Funktionen 
werden der Taste [USER 1] zugewiesen, die in [USER 2] 
und [USER 5] abgelegten Funktionen der Taste [USER 2] 
und die in [USER 3] und [USER 6] abgelegten Funktionen 
der Taste [USER 3].
Halten Sie die Taste SHIFT (6) gedrückt, um auf die in 
[USER 4], [USER 5] oder [USER 6] abgelegten Funktionen 
zuzugreifen.
Leuchtet Die den [USER]-Tasten zugewiesenen 

Funktionen sind aktiviert.
Erloschen Die den [USER]-Tasten zugewiesenen 

Funktionen sind deaktiviert.
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5 Shot-Speicher-Taste [SHOT MEM]
Mit dieser Taste können Sie Shot-Speicher belegen, 
abrufen und löschen.
 Siehe “Shot-Speicher”.

6 SHIFT-Taste [SHIFT]
Mit dieser Taste können Sie die Funktionen für [USER 4], 
[USER 5] und [USER 6], die den Tasten [USER 1], 
[USER 2] und [USER 3] zugewiesen wurden, abrufen. Sie 
können damit außerdem die Materialien XPT7 bis XPT12 
aufrufen, die den Kreuzpunkttasten [1] bis [6] zugewiesen 
wurden, und Shot-Speicher-Funktionen verwenden.
Leuchtet Die Taste [SHIFT] ist aktiviert.
Erloschen Die Taste [SHIFT] ist deaktiviert.

(Die mit der [SHIFT]-Taste ausgeführten Funktionen sind 
nur aktiv, während die Taste gedrückt gehalten wird.)

7 OSD/TIME-Knopf 
Mit diesem Knopf werden die folgenden Operationen 
ausgeführt.

 p Bei Anzeige des Hauptmenüs:
Drehen Sie den OSD/TIME-Knopf, um ein Untermenü 
auszuwählen. Drücken Sie den Knopf, um das markierte 
Untermenü aufzurufen.
 p Bei Anzeige eines Untermenüs:
Drehen Sie den OSD/TIME-Knopf, um ein Untermenü 
auszuwählen. Drücken Sie den Knopf, um das markierte 
Untermenü aufzurufen.
Einstellwerte ändern: Drücken Sie den Knopf, um den 
Bearbeitungsmodus zu aktivieren. Drehen Sie den 
Knopf, um den Wert zu ändern. Erneutes Drücken 
übernimmt den neuen Wert.
Halten Sie den Knopf längere Zeit gedrückt, um einen 
Wert auf die Voreinstellung zurückzusetzen.
 pWenn Sie den gedrückt gehaltenen Knopf drehen, 
während gleichzeitig eine der Tasten [KEY1 ON], [KEY2 
ON], [FTB ON] oder [AUTO] gedrückt wird, können Sie 
die jeweilige Übergangsdauer anpassen.

8 EXIT-Taste [EXIT]
Mit dieser Taste kehren Sie im OSD-Menü eine 
Menüebene nach oben zurück.

9 MENU-Taste [MENU]
Mit dieser Taste legen Sie fest, ob das OSD-Menü ein- 
oder ausgeblendet wird.
Mit jedem Halten der [MENU]-Taste wird das Menü ein- 
bzw. ausgeblendet.
Orangefarbenes Leuchten OSD-Menü eingeblendet
Aus OSD-Menü ausgeblendet

Wenn Sie die [MENU]-Taste bei aktivem OSD-Menü 
drücken, schaltet die Anzeige zwischen dem Hauptmenü 
und der Statusanzeige um.
Sie können die folgenden Statusinformationen einsehen:

 p Einstellungen für das Wischmuster
 p Einstellungen für die Übergangsdauer
 p Einstellungen für die [USER]-Tasten
 p Einstellungen für die Kreuzpunktzuweisung

: FTB ON-Taste [FTB ON]
Drücken Sie diese Taste, um das Programmbild über die 
eingestellte Übergangsdauer auf Schwarz abzublenden.
Ein erneutes Drücken der Taste blendet das Programmbild 
von Schwarz auf.

Drücken Sie die Taste. Blinkt

Abblenden

Aufblenden

Leuchtet

Die Tastenanzeige 
erlischt.
Programmbild

Leuchtet
Abblenden 
abgeschlossen

Drücken Sie die 
Taste.

Sie können auch ein Bild anstelle des schwarzen 
Hintergrundes für das Abblenden festlegen.
 Siehe “FTB (Abblenden zu Schwarz)”.
Wenn Sie den OSD/TIME-Knopf (7) drehen, während 
die Taste [FTB ON] nach dem Gedrückthalten weiterhin 
gedrückt gehalten wird, können Sie die Übergangsdauer 
ändern.

; KEY 1 ON-Taste, KEY 2 ON-Taste 
 [KEY 1 ON, KEY 2 ON]

Diese Tasten dienen dazu, Key-Materialien für die 
eingestellte Übergangsdauer zu kombinieren.

Drücken Sie die Taste.
Blinkt

Bildkombination läuft

Bildkombination deaktiviert

Leuchtet

Die Tastenanzeige 
erlischt.
Bildkombination nicht 
mehr möglich

Leuchtet
Bildkombination 
abgeschlossen

Drücken Sie die Taste.

Wenn Sie den OSD/TIME-Knopf (7) drehen, während 
die Taste [KEY 1 ON] oder [KEY 2 ON] nach dem 
Gedrückthalten weiterhin gedrückt gehalten wird, können 
Sie die Übergangsdauer ändern.

< CUT-Taste [BKGD CUT]
Diese Taste leitet einen Übergang für die aktuell gewählte 
Operation ein.
Leuchtet Der Übergang wird ausgeführt.
Erloschen Der Übergang ist abgeschlossen.

Teile und ihre Funktionen
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= AUTO-Taste [BKGD AUTO]
Mit dieser Taste wird automatisch der Übergang für die 
festgelegte Dauer eingeleitet (automatischer Übergang).
Leuchtet Der automatische Übergang wird ausgeführt.
Erloschen Der automatische Übergang ist abgeschlossen.

Wird die Taste [AUTO] während des automatischen 
Übergangs gedrückt, wird der Übergang abgebrochen.
Wird die Taste nach Abbruch des Übergangs erneut 
gedrückt, wird der restliche Übergang ausgeführt.
Wenn die Taste [AUTO] gedrückt wird, während sich der 
Überblendhebel (>) in einer Zwischenstellung befindet, 
wird der Übergang in der ab der Zwischenstellung 
verbleibenden Zeit ausgeführt.
Wenn Sie den OSD/TIME-Knopf (7) drehen, während die 
Taste [AUTO] nach dem Gedrückthalten weiterhin gedrückt 
gehalten wird, können Sie die Übergangsdauer ändern.

> Überblendhebel
Dieser Hebel wird verwendet, um Übergänge manuell 
auszuführen.
Wenn der Überblendhebel bis ans Ende bewegt wird, ist 
der Übergang abgeschlossen.
Wird der Überblendhebel während eines automatischen 
Übergangs betätigt, schaltet das Gerät auf manuelle 
Überblendung, sobald der Hebel über die Position des 
laufenden Übergangs hinweg bewegt wird.
Sie können einen Hintergrund oder Key mithilfe eines 
Menüs für Materialien für Übergänge auswählen.

? MIX/WIPE-Umschalttaste [MIX, WIPE]
Diese Taste legt die Übergangsmethode fest.
Mit jedem Tastendruck wird zwischen MIX und WIPE 
umgeschaltet.
MIX In diesem Modus erfolgt der Übergang (MIX-

Übergang) durch Überlappen der Bilder von 
A- und B-Bus (oder Bilder von PGM- und PST-
Bus).
Während des Übergangs beträgt die Summe 
von A- und B-Bus (bzw. PGM- und PST-Bus) 
stets 100 %.
Die [MIX]-Anzeige links leuchtet orangefarben, 
wenn MIX ausgewählt ist.

WIPE Für den Übergang wird das ausgewählte 
Wischmuster verwendet.
Die [WIPE]-Anzeige links leuchtet orangefarben, 
wenn WIPE ausgewählt ist.

@ Bus-Tally-Anzeigen [A, B]
Die Anzeige für den Bus, dessen Programm (PGM)-
Materialien ausgegeben werden, leuchtet.

A AUX-Bus-Wahltasten
 [AUX BUS DELEGATION]

Wählen Sie den zu benutzenden Bus mit den AUX-Bus-
Kreuzpunkttasten (B) aus. 
Die gewählte Taste leuchtet auf.

[KEY 1], [KEY 2]:
Diese Taste dient zum Umschalten des Modus der 
AUX-Bus-Kreuzpunkttasten (B) in den Modus für 
Quellen-Wahltasten für die Key-Fill-Busse oder die Key-
Quellenbusse.
Bei jedem Drücken der Taste wird die Wahltastenfunktion 
zwischen Key-Fill-Bussen und Key-Quellenbussen 
umgeschaltet.
Orangefarbenes Leuchten Key-Fill-Busse
Grünes Leuchten Key-Quellenbusse

[AUX 1], [AUX 2]:
Diese Tasten dienen zum Umschalten des Modus der 
AUX-Bus-Kreuzpunkttasten (B) in den Modus für Quellen-
Wahltasten für die AUX-Busse.

B AUX-Bus-Kreuzpunkttasten
Diese Tasten dienen zur Wahl der Quelle des Busses, der 
mit der AUX-Bus-Wahltaste (A) gewählt wurde.
Die Tasten 1 bis 12 können mit der Taste [SHIFT] (6) 
gewählt werden. Wenn die Kreuzpunkttasten (B, D, E) 
gedrückt gehalten werden, werden im OSD der Name des 
Eingangsmaterials und die Nummer der Kreuzpunkttaste 
angezeigt.

C  Kreuzpunkttasten ausschließlich für den AUX-
Bus [AUX SOURCE]
Wenn die AUX-Buswahltasten [AUX 1], [AUX 2] (A) 
leuchten, werden hiermit AUX-Busquellen ausgewählt.
Die gedrückten Tasten werden bernsteinfarben.

[MV]:
Wählt ein beliebiges der Multi-View-Display-Signale für 
den AUX-Bus aus.

[PGM/PVW]:
Wählt das PGM-Signal oder das PVW-Signal für den AUX-
Bus aus.
Das Umschalten zwischen PGM-Signal und PVW-Signal 
erfolgt mit der [SHIFT]-Taste (6).

D PGM-Bus-Kreuzpunkttasten [1 bis 6]
Diese Tasten dienen der Wahl der PGM/A-Bus-
Videosignale. Die Tasten 1 bis 12 können mit der Taste 
[SHIFT] (6) gewählt werden.
Für den Busmodus können im Menü “Config” die Optionen 
“A/B”, “PGM-A/PST-B” bzw. “PGM-B/PST-A” eingestellt 
werden.
 Siehe “Hintergrundübergang”.
Wenn die Kreuzpunkttasten (B, D, E) gedrückt gehalten 
werden, werden im OSD der Name des Eingangsmaterials 
und die Nummer der Kreuzpunkttaste angezeigt.

E PST-Bus-Kreuzpunkttasten [1 bis 6]
Diese Tasten dienen der Wahl der PGM/B-Bus-
Videosignale. Die Tasten 1 bis 12 können mit der Taste 
[SHIFT] (6) gewählt werden.
Für den Busmodus können im Menü “Config” die Optionen 
“A/B”, “PGM-A/PST-B” bzw. “PGM-B/PST-A” eingestellt 
werden.
 Siehe “Hintergrundübergang”.
Wenn die Kreuzpunkttasten (B, D, E) gedrückt gehalten 
werden, werden im OSD der Name des Eingangsmaterials 
und die Nummer der Kreuzpunkttaste angezeigt.

Teile und ihre Funktionen
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F Netzschalter [POWER]
Wird der Netzschalter [POWER] eingeschaltet, leuchtet 
die Anzeige [POWER] (1) auf, um anzuzeigen, dass das 
Gerät betriebsbereit ist.

G SDI-Eingänge [SDI IN 1 bis 4]
Dies sind die Eingangsbuchsen für HD-SDI-Signale.

 p SDI IN 1 und HDMI IN 1 können nicht gleichzeitig 
genutzt werden. Sie müssen sich im Menü “Input” für 
eine Option entscheiden.
 p Für SDI IN 3 und 4 stehen erweiterte Up-/Down-
Konverter-Einstellungen zur Verfügung.

H SDI-Ausgänge [SDI OUT 1, 2]
Dies sind die Ausgangsbuchsen für HD-SDI-Signale. Die 
folgenden Signale können den Anschlüssen über das 
Menü zugewiesen werden:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Über SDI OUT 1 wird kein OSD-Menü ausgegeben.

I HDMI-Eingänge [HDMI IN 1, 2]
Dies sind die Eingangsbuchsen für HDMI-Signale. 
HDMI 1.4b wird unterstützt. HDCP wird nicht unterstützt.
Eingangssignale mit den folgenden Auflösungen können 
über das Menü konfiguriert werden.
Auflösung (vertikale Frequenz: 60 Hz):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024), 
WXGA (1280 × 768), XGA (1024 × 768)
Auflösung:
1920 × 1080/59,94p, 1920 × 1080/50p, 
1920 × 1080/29,97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23,98p, 1920 × 1080/59,94i, 1920 × 1080/50i, 
1280 × 720/59,94p, 1280 × 720/50p

 p Der HDMI-Eingang unterstützt den Scaler.

J HDMI-Ausgang [HDMI OUT]
Dies ist die Ausgangsbuchse für das HDMI-Signal. Die 
folgenden Signale können den Anschlüssen über das 
Menü zugewiesen werden:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Für die Ausgabe kann die Auflösung verwendet werden, 
die als Systemformat des Geräts dient.

Ausgangssignale mit den folgenden Auflösungen können 
über das Menü konfiguriert werden.
Die Ausgabeauflösung kann fest auf 1080/720 eingestellt 
werden.
Auflösung (vertikale Frequenz: 60 Hz):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024),  
WXGA (1280 × 768), XGA (1024 × 768)
Auflösung:
1920 × 1080/59,94p, 1920 × 1080/50p, 
1920 × 1080/29,97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23,98p, 1920 × 1080/59,94i, 1920 × 1080/50i, 
1280 × 720/59,94p, 1280 × 720/50p

K Referenzeingang [REF]
Durchschleifausgang im externen Sync-Modus.
Wenn der Durchschleifausgang nicht benutzt wird, ist eine 
75-Ohm-Terminierung zu verwenden.

L Audioeingang [AUDIO IN]
Diese Eingangsbuchsen werden für externe Audiosignale 
verwendet (Mikrofon/Line).
Es werden zwei Kanäle (links und rechts) unterstützt.

M USB-Anschluss (*1) (Typ-C-Anschluss) 
 [USB STREAM OUT]

Sie können Video- und Audioausgaben von diesem Gerät 
durch Anschließen eines USB-Video-Class(UVC)-Geräts 
auf einen Computer laden.
Die folgenden Signale können den Anschlüssen über das 
Menü zugewiesen werden:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

*1   USB 3.2 Gen1 DEVICE, keine USB-Stromversorgung

Rückwandbereich

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

Q F

R P O N M J

L K H G

I

Teile und ihre Funktionen
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N TALLY/GPI-Anschluss  
  [TALLY/GPI] (D-sub 15-polig, Buchse, 

Zollgewinde)
Das Gerät verfügt über 5 Kontakteingänge zur 
Ansteuerung mit externen Geräten und über 8 offene 
Sammelausgänge zum Ausgeben von Tally-Informationen 
und Alarmmeldungen.

O LAN-Buchse [LAN] (RJ-45) (1000Base-T)
Über diese LAN-Buchse (RJ-45) können externe Geräte 
angeschlossen werden, die mittels IP kontrolliert werden 
sollen.
Außerdem können über diese Buchse IP-Signale gesendet 
und empfangen werden.
Verwenden Sie ein LAN-Kabel (*1) für den Anschluss.

*1   Category 5e oder besser, STP (Shielded Twisted Pair), 
max. 100 m

P SERVICE-Schalter [BOOT SV/NM]
Dieser Schalter ist Wartungszwecken vorbehalten.
Für normalen Betrieb ist die Position [NM] zu wählen.

Q Erdungsanschluss [SIGNAL GND]
Mit der Erde des Systems verbinden.

R Diebstahlschutzverankerung
Hier können Sie ein Kensington-Kabelschloss anbringen.
Weitere Informationen finden Sie in der Anleitung des 
Kabels.
Die Diebstahlschutzverankerung schützt das Gerät in 
Verbindung mit dem Schloss vor Diebstahl. Panasonic 
haftet nicht für Schäden als Folge eines Diebstahls.

Rechte Seite

USB

S T

S USB-Anschluss (*2) (Typ-A-Anschluss) [USB]
Sie können Projektdateien auf ein hier angeschlossenes 
USB-Speichergerät speichern bzw. davon laden.
Außerdem können Sie Standbilddaten laden und 
speichern, Protokolldateien speichern und Firmware laden.

*2  USB2.0 DEVICE, mit USB-Stromversorgung

T Ventilator
Blockieren Sie die Luftauslässe nicht. Andernfalls kann es 
zu Funktionsstörungen kommen.
Halten Sie einen ausreichend großen Bereich vor den 
Auslässen frei.

Teile und ihre Funktionen
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Front

LEVEL

W X

W  Kopfhörerbuchse [  ]  
(Φ3,5-mm-Stereo-Miniklinke)
Sie können Kopfhörer anschließen, um die Audioausgabe 
zu überwachen.
In den Einstellungsmenüs des Geräts können Sie PGM, 
PVW, AUX1, AUX2 oder CLN auswählen.

X Monitoring-Lautstärkeregler [LEVEL]
Mit diesem Knopf können Sie die Lautstärke für das 
Monitoring einstellen.

Teile und ihre Funktionen

Linke Seite

DC IN 16V

V U

U  DC-Eingang [DC IN 16 V ]  
(DC 16 V, 3,0 A)
Hier wird der mitgelieferte Netzadapter angeschlossen.

V Montageöffnung für die Kabelsicherung
Hier können Sie die mitgelieferte Kabelsicherung 
anbringen, mit der das Kabel des Netzadapters fixiert 
werden kann. (Seite 15)
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Vorbereitungen

Ein- und Ausschalten des Gerätes

Einschalten

1 Stellen Sie den [POWER]-Schalter in die 
Position ON.
Wenn das Gerät mit Strom versorgt wird, leuchtet die 
Anzeige [POWER] auf.

Beim Hochfahren des Geräts leuchten die PGM-Bus-
Kreuzpunkttasten und die PST-Bus-Kreuzpunkttasten 
nacheinander blau auf. Sobald alle Tastenanzeigen 
erlöschen, ist das Hochfahren beendet.

Ausschalten

1 Stellen Sie den [POWER]-Schalter in die 
Position OFF.
Die Stromversorgung des Gerätes wird ausgeschaltet, 
und die Anzeige [POWER] erlischt.

Videoausgabe kontrollieren

Diese Anleitung beschreibt, wie Sie das OSD-Gerätemenü auf einem externen Monitor einblenden können, um die 
Videoausgabe des Geräts zu prüfen.

OSD-Menüs auf einem HDMI-Monitor 
einblenden

1 Verbinden Sie den HDMI-Monitor mit dem 
Anschluss HDMI OUT des Gerätes.

2 Schalten Sie den HDMI-Monitor ein.

3 Schalten Sie das Gerät ein.

4 Halten Sie die Taste [MENU] gedrückt.
Die Anzeige in der Taste [MENU] leuchtet auf, und die 
OSD-Menüs sind auf dem HDMI-Monitor sichtbar.
Falls keine OSD-Menüs auf dem Monitor angezeigt 
werden, lesen Sie unter “Anzeige der OSD-Menüs 
erzwingen” weiter.

Falls das OSD-Menü auch nach Ausführung der 
oben genannten Schritte nicht auf dem HDMI-Monitor 
angezeigt wird, unterstützt der HDMI-Monitor das HDMI-
Ausgabeformat möglicherweise nicht. 
Prüfen Sie die technischen Angaben für den HDMI-
Monitor.

Hinweis

OSD-Menüs auf einem SDI-Monitor 
einblenden

1 Verbinden Sie den SDI-Monitor mit dem 
Anschluss SDI OUT 2 des Gerätes.

2 Schalten Sie den SDI-Monitor ein.

3 Schalten Sie das Gerät ein.

4 Halten Sie die Taste [MENU] gedrückt.
Die Anzeige in der Taste [MENU] leuchtet auf, und die 
OSD-Menüs sind auf dem SDI-Monitor sichtbar.
Falls keine OSD-Menüs auf dem Monitor angezeigt 
werden, lesen Sie unter “Anzeige der OSD-Menüs 
erzwingen” weiter.

 p Über SDI OUT 1 werden keine OSD-Menüs 
ausgegeben.

 p Falls das OSD-Menü auch nach Ausführung der oben 
genannten Schritte nicht auf dem SDI-Monitor angezeigt 
wird, ist möglicherweise nicht das benötigte Videoformat 
am Gerät eingestellt. 
Befolgen Sie die Schritte im nächsten Abschnitt, um das 
Videoformat am Gerät zu ändern. 
 Siehe “Videoformat ändern”.

Hinweise
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Videoformat ändern

Sie können im ausgeschalteten Zustand ein Videoformat festlegen und das System anschließend hochfahren.
Falls auch bei an das Gerät angeschlossenem SDI-Monitor keine OSD-Menüs angezeigt werden, muss das Videoformat 
geändert werden. 
Befolgen Sie die Schritte unten, um das Videoformat zu ändern.
Falls die OSD-Menüs auf einem PC-Monitor angezeigt werden, ändern Sie das Videoformat wie unter “Einstellen des 
Systemformats” beschrieben.

1 Schalten Sie das Gerät aus.

2   Schalten Sie das Gerät ein, während Sie eine der folgenden Tasten halten, um das für den 
angeschlossenen SDI-Monitor benötigte Videoformat auszuwählen.

Gleichzeitig zu drückende Tasten Videoformat
[MENU] + A-Bus-Kreuzpunkt [1] 1080/59,94p

[MENU] + A-Bus-Kreuzpunkt [2] 1080/50p

[MENU] + A-Bus-Kreuzpunkt [3] 1080/59,94i

[MENU] + A-Bus-Kreuzpunkt [4] 1080/50i

[MENU] + A-Bus-Kreuzpunkt [5] 1080/29,97p

[MENU] + A-Bus-Kreuzpunkt [6] 1080/25p

[MENU] + B-Bus-Kreuzpunkt [1] 1080/24p

[MENU] + B-Bus-Kreuzpunkt [2] 1080/23,98p

[MENU] + B-Bus-Kreuzpunkt [3] 720/59,94p

[MENU] + B-Bus-Kreuzpunkt [4] 720/50p

 p Halten Sie die Tasten gedrückt, bis das Gerät vollständig hochgefahren ist.

3   Halten Sie die Taste [MENU] gedrückt.
Die Anzeige in der Taste [MENU] leuchtet auf, und die OSD-Menüs sind auf dem SDI-Monitor sichtbar.

Falls das OSD-Menü auch nach Ausführung der oben genannten Schritte nicht auf dem SDI-Monitor angezeigt wird, 
unterstützt der SDI-Monitor das SDI-Ausgabeformat möglicherweise nicht. 
Prüfen Sie die technischen Angaben für den SDI-Monitor.

Hinweis

Vorbereitungen
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On-Screen-Display(OSD)-Menübedienung

Die Geräteeinstellungen werden über die OSD-Menüs, die auf dem externen Monitor sichtbar sind, vorgenommen.
In diesem Abschnitt wird die Bedienung der OSD-Menüs erklärt.

OSD-Menüs aufrufen und ausblenden

Grundlegende Bedienung

Halten Sie die Taste [MENU] gedrückt; die Anzeige in der Taste [MENU] leuchtet auf, und die OSD-Menüs werden auf dem 
externen Monitor angezeigt.
Halten Sie die Taste [MENU] gedrückt, während ein OSD-Menü eingeblendet wird; die Anzeige in der Taste [MENU] erlischt, 
und das OSD-Menü wird ausgeblendet.

Anschluss für die Ausgabe der OSD-Menüs auswählen

Sie können festlegen, über welchen Ausgang das OSD-Menü ausgegeben wird: “Operate > Menu Out” im Menü “[12] Config”.

SDI OUT2 Die Menüs werden über SDI OUT 2 ausgegeben.

HDMI OUT Die Menüs werden über HDMI OUT ausgegeben.

SDI2+HDMI Die Menüs werden über SDI OUT 2 und HDMI OUT ausgegeben.

Über die Einstellungen unter “OUT6 (UVC OUT) > Menu Out” im Menü “[11] Output” können Sie die Menüausgabeeinstellungen 
über den USB-Anschluss (USB STREAM OUT, Typ C) ändern.

On Die OSD-Menüs werden über den USB-Anschluss (Typ C) ausgegeben.

Off Die OSD-Menüs werden nicht über den USB-Anschluss (Typ C) ausgegeben.

Über SDI OUT 1 werden keine OSD-Menüs ausgegeben.
Hinweis

Anzeige der OSD-Menüs erzwingen

Wenn Sie bei eingeschaltetem Gerät gleichzeitig die Tasten [MENU] und [SHIFT] drücken, werden automatisch die folgenden 
Einstellungen verwendet:

 p Die OSD-Menüs werden über SDI OUT 2 und HDMI OUT ausgegeben. Außerdem wird die Ausgabe über den USB-
Anschluss (Typ C) aktiviert.

 p Die Größe der OSD-Menüausgabe über HDMI OUT wird auf “Auto” gesetzt.

Vorbereitungen
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Menükonfiguration und Menünavigation

Menükonfiguration des Geräts

Die OSD-Menüs umfassen ein Hauptmenü und Untermenüs mit mehreren Ebenen.

Hauptmenü:
Das Hauptmenü enthält eine Liste der Untermenüs.

Untermenü:
Ein Untermenü enthält eventuell weitere Ebenen.
Untermenüs enthalten Einstellungen und Optionen. 
Die Einstellungen können in diesem Bildschirm geändert werden.

Zwischen Hauptmenü und Untermenüs wechseln

Untermenü aus dem Hauptmenü aufrufen
So markieren Sie einen Untermenüeintrag:

Drehen Sie den OSD/TIME-Knopf, um einen Eintrag zu markieren.
Markierte Einstellungen im Untermenü aufrufen:

Drücken Sie den OSD/TIME-Knopf, um eine Einstelloption zu öffnen.

Aus einem Untermenü zum übergeordneten Untermenü oder zum Hauptmenü zurückkehren
Drücken Sie die Taste [EXIT], um in die nächsthöhere Menüebene (Untermenü oder Hauptmenü) zu gelangen.

  Drehen Sie den OSD/TIME-Knopf, und 
markieren Sie den Untermenüeintrag.

  Drücken Sie den OSD/TIME-Knopf, um die 
markierte Einstelloption zu öffnen.

  Drücken Sie die Taste 
[EXIT].

Hauptmenü

Untermenü

“>” rechts neben Einträgen gibt an, dass 
diese Untermenüs enthalten.

“>” rechts neben Einträgen gibt an, dass diese 
weitere Untermenüs enthalten.

Einstellungen
“▼” rechts neben Einträgen gibt an, dass diese 
veränderbare Werte enthalten.

Untermenüeinträge

Mehrere Seiten lange Menüs ansehen

Wenn ein Menü viele Einträge enthält, werden diese auf mehrere Seiten aufgeteilt.
In dieser Anleitung wird auch dann nur eine Menüseite angezeigt, wenn das Menü mehrere Seiten umfasst.

Vorbereitungen
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Menüfunktionen

1 Markieren Sie die Zeile mit der gewünschten Einstellung.
Die Markierung wird beim Drehen des OSD/TIME-Knopfes nach oben oder unten bewegt.
Sobald die gewünschte Einstellung markiert ist, müssen Sie den OSD/TIME-Knopf drücken, um den Einstellwert zu öffnen.
Einträge, die ein weiteres Untermenü öffnen, sind am Zeichen “>” zu erkennen.
Markieren Sie einen solchen Eintrag, und drücken Sie den OSD/TIME-Knopf, um das Untermenü aufzurufen.

Drehen Sie den OSD/TIME-Knopf, 
und markieren Sie den Eintrag.

Drücken Sie den OSD/
TIME-Knopf, um den 
Eintrag zu öffnen.

Jetzt können Sie den Wert ändern.

2  Ändern Sie die Einstellung.
Es gibt zwei Möglichkeiten zum Ändern von Einstellwerten:

 p Auswahlmenü
Wenn die gewünschte Einstellung markiert ist, können Sie durch Drücken des OSD/TIME-Knopfes ein Auswahlmenü mit 
den verfügbaren Einstellwerten öffnen.
Markieren Sie einen der Werte durch Drehen des OSD/TIME-Knopfes, und drücken Sie anschließend den Knopf, um den 
Wert zu übernehmen.

 p Zifferneingabe
Wenn Sie einen Einstellwert markiert haben, können Sie den OSD/TIME-Knopf drücken, um den Wert zu ändern.
Drehen Sie den OSD/TIME-Knopf, um den aktuellen Wert zu ändern.
Je schneller Sie drehen, desto schneller wird der Wert geändert.

Drehen Sie den OSD/TIME-Knopf, um die 
blinkende Einstellung zu ändern.

[Einstellung zurücksetzen]
Wenn Sie den OSD/TIME-Knopf gedrückt halten, wird der Wert auf den Standardwert (Werkseinstellung) zurückgesetzt.

Wenn Werte der normalen Einstellungen geändert werden, werden diese Änderungen sofort übernommen. Bei bestimmten 
Einstellungen (zum Beispiel beim Format) werden die Änderungen jedoch erst übernommen, wenn der OSD/TIME-Knopf 
nach der Änderung erneut gedrückt wird.
Bei solchen Einträgen blinkt der Cursor.

Hinweis

Vorbereitungen
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Zeichenfolgen eingeben

Für einige Einträge müssen Sie Textfolgen eingeben.

Wenn Sie einen Einstellwert markiert haben, können Sie den OSD/TIME-Knopf drücken, um die Zeichenfolge zu ändern.
Eine Bildschirmtastatur wird angezeigt. Das ausgewählte Zeichen ist gelb umrahmt.
Drehen Sie den OSD/TIME-Knopf, um ein Zeichen auszuwählen. Drücken Sie den Knopf, um das Zeichen einzugeben.
Die Tastatur enthält die folgenden Funktionen:

[A-a] Zwischen Groß- und Kleinbuchstaben umschalten

[BS] Zeichen vor dem Cursor löschen

[123#+=] Tastatur für Ziffern und Symbole aktivieren

[!?~] Tastatur für Symbole aktivieren

[  ] Leerzeichen

[  ] Cursor nach links bewegen

[  ] Cursor nach rechts bewegen

[Enter] Eingabe übernehmen und Tastatur schließen

[Load TEXT] Bildschirm zum Laden von Zeichenfolgen von einem USB-Speichergerät 
öffnen

Hinweise zu [Load TEXT]

Mit [Load TEXT] können Sie eine Textdatei (Endung .txt) laden, die im Ordner “HS\HSW10\TEXT” auf einem mit diesem Gerät 
formatierten USB-Speichergerät liegt. Der Inhalt der Textdatei wird als Zeichenfolge übernommen.
[Load TEXT] kann nur ausgewählt werden, wenn ein USB-Speichergerät angeschlossen ist.

[Load TEXT] kann ausgewählt werden, wenn ein USB-Speichergerät angeschlossen ist.

Vorbereitungen
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Nachdem Sie [Load TEXT] ausgewählt haben, müssen Sie die gewünschte Textdatei im angezeigten Dialogfeld auswählen.

Es gelten die folgenden Einschränkungen für die Textdatei:
 pWenn die Textdatei Multi-Byte-Zeichen enthält, die zum Beispiel für japanische Schriftzeichen genutzt werden, schlägt das 
Laden der Datei fehl.

 p Es können nur Texte geladen werden, deren Länge die vorgesehene Länge der Einstellung nicht überschreitet.
 p Zeilenvorschubzeichen werden automatisch gelöscht.

In dieser Bedienungsanleitung verwendete Darstellung

Das Ändern einer Einstellung wird im folgenden Beispiel verdeutlicht.
Beispiel:  Ändern des Eintrags “[1] WIPE > BKGD Transition > Direction”.

[1] WIPE >   
 BKGD Transition > Direction 

Untermenü  
Einstellungsposten

Vorbereitungen
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Menüdelegationsfunktion

Wenn die folgenden Tasten zweimal gedrückt werden, wird das zugehörige Menü aufgerufen.
(Die Menüdelegationsfunktion)
Der Vorgang, welcher der gedrückten Taste entspricht, wird ebenfalls ausgeführt.

<Liste der Menüdelegationsfunktionen>
Taste Ausgewähltes Menü

AUTO

[5] TIME
FTB
KEY 1 ON
KEY 2 ON
MIX/WIPE [1] WIPE

KEY 1 F/S • Wenn PinP aktiviert ist
[3] Key > PinP
• Wenn PinP deaktiviert und “Chroma” als Key-Typ ausgewählt ist
[4] ChromaKey
• Wenn PinP deaktiviert und ein anderer Key-Typ als “Chroma” ausgewählt ist
[3] Key

KEY 2 F/S • Wenn PinP aktiviert ist
[3] Key > PinP
• Wenn PinP deaktiviert und ein anderer Key-Typ als “Chroma” ausgewählt ist
[3] Key

USER 1

[12] Config > User Button

USER 2
USER 3
USER 4 (SHIFT + USER 1)

USER 5 (SHIFT + USER 2)

USER 6 (SHIFT + USER 3)

Busstatusanzeigen

Wenn Sie die [MENU]-Taste bei aktivem OSD-Menü erneut drücken, wird die Statusanzeige aufgerufen.
Wenn Sie die A-Bus-, B-Bus- oder AUX-Bus-Kreuzpunkttasten gedrückt halten, wird die Statusanzeige im OSD-Menü 
angezeigt.

AMB:F
GRN:S

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Vorbereitungen
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Grundlegende Bedienung

Hintergrundübergang

Auswählen des Busses

Drücken Sie eine der Kreuzpunkttasten, um das für den 
Hintergrundübergang zu benutzende Material auszuwählen. 
Je nach dem Betriebsstatus leuchtet die gedrückte Taste in 
einer von zwei Farben.

Aufleuchten 
in Rot

Wenn die ausgewählten Eingangssignale an 
PGM ausgegeben werden.
(Während FTB-Vorgängen leuchtet die Lampe 
jedoch in Gelb.)

Aufleuchten 
in Grün

Wenn die ausgewählten Eingangssignale nicht 
an PGM ausgegeben werden.

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

   Aufleuchten in Rot
   Aufleuchten in Grün

 pWenn die Kreuzpunkttasten gedrückt gehalten werden, 
erscheinen die Tastennummern und die Namen der den 
Tasten zugewiesenen Eingangssignale in Listenform auf 
dem eingebauten Display, solange die Kreuzpunkttasten 
gedrückt gehalten werden.

Auswählen des Busses mit der Funktion 
SHIFT

Die SHIFT-Funktion gestattet die Zuweisung von zwei 
Materialien — Frontmaterial und Rückmaterial — zu einer 
Taste, und die Auswahl der Materialien mit der Taste [SHIFT].
Insgesamt 12 Materialien – Frontmaterial (1 bis 6) und 
Rückmaterial (7 bis 12) – können den drei Gruppen von 
12 Kreuzpunkttasten zugewiesen werden, egal, ob es sich 
um die PGM/A-Bus-Kreuzpunkttasten, die PST/B-Bus-
Kreuzpunkttasten oder die AUX-Bus-Kreuzpunkttasten 
handelt.

“All SHIFT” wird verwendet, um alle Materialien der PGM/A-
Bus-Kreuzpunkttasten, PST/B-Bus-Kreuzpunkttasten oder 
AUX-Bus-Kreuzpunkttasten von den Frontmaterialien mit den 
Rückmaterialien zu vertauschen oder umgekehrt.

Rückmaterialien werden nur ausgewählt, wenn die Taste 
[SHIFT] gedrückt wird.

 pWenn die Rückmaterialien (7 bis 12) gewählt worden sind, 
leuchtet die LED [SHIFT] gelb.

Auswählen des Busmodus

Wählen Sie den A/B-Busmodus oder ein Flip-Flop-System 
(PGM/PST-System, in dieser Anleitung auch Kippschaltung 
genannt) im Einstellungsmenü aus.

Wählen Sie den Busmodus über folgenden Menüvorgang:

[12] Config >
 Operate > Bus Mode

A/B Wenn der Überblendhebel auf der Seite A steht, 
werden die vom A-Bus gewählten Signale durch 
PGM-Material ersetzt.
Wenn der Überblendhebel auf der Seite B steht, 
werden die vom B-Bus gewählten Signale durch 
PGM-Material ersetzt.

PGM-A/
PST-B

Unter Verwendung einer Kippschaltung werden 
die vom A-Bus gewählten Signale immer durch 
PGM-Material ersetzt, und die vom B-Bus 
gewählten Signale werden immer durch PST-
Material ersetzt.

PGM-B/
PST-A

Unter Verwendung einer Kippschaltung werden 
die vom B-Bus gewählten Signale immer durch 
PGM-Material ersetzt, und die vom A-Bus 
gewählten Signale werden immer durch PST-
Material ersetzt.

Auswählen des Übergangsmodus

Wählen Sie den Übergangsmodus mit den Tasten [MIX] und 
[WIPE] aus.

Wählen Sie den Hintergrundübergangsmodus mit der 
Umschalttaste [MIX/WIPE] aus.
Die LED für den ausgewählten Modus leuchtet.
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Manueller Übergang

Betätigen Sie den Überblendhebel, um Übergänge manuell 
auszuführen.
Ist der Überblendhebel während eines automatischen 
Übergangs betätigt worden, wird der automatische Übergang 
auf manuellen Betrieb umgeschaltet, sobald die Faderposition 
den Betrag des in Ausführung befindlichen Übergangs 
überholt.
Die Bus-Tally-LEDs links vom Überblendhebel zeigen den 
Ausgabezustand des Programmbusses an.

Nur LED A leuchtet PGM/A-Bus-Ausgabe
LEDs A und B 
leuchten

Während des Übergangs

Nur LED B leuchtet PST/B-Bus-Ausgabe

Wählen Sie das Übergangsziel über folgenden Menüvorgang:

[12] Config >
 Operate > Fader

Jedes der folgenden Ziele, für das der Übergang ausgeführt 
werden soll, kann durch Betätigen des Überblendhebels 
festgelegt werden.

BKGD Hintergrundübergang
KEY1 Key-Übergang
BKGD+KEY1 Hintergrundübergang und Key-Übergang 

werden gleichzeitig ausgeführt.
NoAssign Übergänge werden auch dann nicht ausgeführt, 

wenn der Überblendhebel betätigt wird.

Automatischer Übergang

 pWenn die Taste [AUTO] gedrückt wird, wird der Übergang 
unter Verwendung der eingestellten Übergangszeit 
automatisch ausgeführt.

 p Der Übergang wird in der verbleibenden Zeit ausgeführt, 
wenn die Taste [AUTO] gedrückt wird, während der 
Überblendhebel betätigt wird.

Die Dauer des automatischen Übergangs wird mit folgendem 
Menüvorgang eingestellt:

[5] Time >
 BKGD

Wählen Sie die Anzeigeeinheit über folgenden Menüvorgang:

[12] Config >
 Operate > Time Unit

Sec Die Zeit wird als Sekundenzahl angezeigt.
Frame Die Zeit wird als Vollbilderzahl angezeigt.

Eine beliebige Zeit von 0 bis 999f kann eingestellt werden. 
Wenn Sekunden als Anzeigeeinheit verwendet werden, hängt 
die einstellbare Zeit vom Systemformat ab.

59.94i max. 33s09f 29.97p max. 33s09f
50i max. 39s24f 25p max. 39s24f
59.94p max. 16s39f 24p max. 41s15f
50p max. 19s49f 23.98p max. 41s15f

 p Selbst wenn “KEY1”, “BKGD+KEY1” oder “NoAssign” für 
die Funktion des Überblendhebels ausgewählt wurde, 
dient der Hintergrund stets als Ziel für die Ausführung 
automatischer Übergänge.

Schnittübergang

Wenn die Taste [CUT] gedrückt wird, wird der Übergang 
augenblicklich ausgeführt.

 p Selbst wenn “KEY1”, “BKGD+KEY1” oder “NoAssign” für 
die Funktion des Überblendhebels ausgewählt wurde, 
dient der Hintergrund stets als Ziel für die Ausführung 
automatischer Schnittübergänge.

Grundlegende Bedienung
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Wischen

Auswählen des Wischmusters

Wählen Sie das Wischmuster über folgenden Menüvorgang:

[1] WIPE >
 BKGD Pattern

<Tabelle der Wipe-Muster>
Wischmuster und Nummern

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

Auswählen der Wipe-Richtung

Wählen Sie die Wischrichtung für Hintergrundübergänge über 
folgenden Menüvorgang:

[1] WIPE >
 BKGD Transition > Direction

(Die Key-Übergänge werden durch das Menü eingestellt. Die 
hier eingestellte Richtung wird nicht reflektiert.)
 Siehe “Key-Übergänge”.

A

N

B

B

A

B

A

B

A

B

R

A

A B

A

N/R

B

A B

Wenn [Normal] ausgewählt ist:
  Der Wipe-Effekt erfolgt in normaler Richtung.
Wenn [Reverse] ausgewählt ist:
 Der Wipe-Effekt erfolgt in umgekehrter Richtung.
Wenn [N/R] ausgewählt ist:
  Es erfolgt eine Umschaltung von der normalen auf 

die umgekehrte Richtung (oder umgekehrt), wenn der 
Übergang abgeschlossen ist. 

Wipe-Verzierungen (Rand-, Soft-Effekt)

Ein Rand-Effekt oder Soft-Effekt kann dem Wipe-Effekt von 
Hintergrundübergängen hinzugefügt werden.

Einstellen des Rand- und Soft-Effekts

1 Schalten Sie den Rand über folgenden Menüvorgang ein 
bzw. aus:

[1] WIPE >
 BKGD Transition > Border > Border

2 Legen Sie die Randbreite über folgenden Menüvorgang 
fest:

[1] WIPE >
 BKGD Transition > Border > Width

3 Legen Sie den Betrag des Soft-Effekts über folgenden 
Menüvorgang fest:

[1] WIPE >
 BKGD Transition > Border > Soft

Wenn “On” als Einstellung des Postens “Border” gewählt 
worden ist, wird das Verhältnis des Soft-Effekts zur 
Randbreite als Betrag des Soft-Effekts angezeigt. 
Wenn nur der Soft-Effekt dem Wipe hinzugefügt werden soll, 
wählen Sie “Off” als Einstellung des Postens “Border”.

Einstellen der Randfarbe

Passen Sie Farbton, Sättigung und Luminanz der Randfarbe 
über folgenden Menüvorgang an:

[1] WIPE >
 BKGD Transition > Border Color > Hue

[1] WIPE >
 BKGD Transition > Border Color > Sat

[1] WIPE >
 BKGD Transition > Border Color > Lum
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 Aufrufen der Vorwahlfarbe
Wählen Sie die Vorwahlfarbe über den folgenden 
Menüvorgang aus, und drücken Sie den OSD/TIME-Knopf:

[1] WIPE >
 BKGD Transition > Border Color > Load

 pWenn der OSD/TIME-Knopf gedrückt wird, werden die 
bislang vorgenommenen Einstellungen aufgehoben und 
durch die Werte der Vorwahlfarbe ersetzt.

 p Angaben zum Speichern der Werte, die vor dem Aufrufen 
der Vorwahlfarbe eingestellt wurden, finden Sie unter “Shot-
Speicher”.

Einstellen der Wipe-Startposition

Der Wipe-Start kann auf jede gewünschte Position gesetzt 
werden.

Zielmuster:
9, 10, 11, 12, 13

1 Legen Sie die Startposition für den Wischeffekt über 
folgenden Menüvorgang fest:

[1] WIPE > 
 BKGD Transition > Position > X-Position

[1] WIPE > 
 BKGD Transition > Position > Y-Position

[1] WIPE > 
 Key1 Transition > Position > X-Position

[1] WIPE > 
 Key1 Transition > Position > Y-Position

Diese Einstellung ist nur möglich, wenn das Zielmuster für 
das Hintergrund- oder Key-Muster gewählt worden ist.

2 Betätigen Sie entweder den Überblendhebel, oder 
drücken Sie die Taste [AUTO], um den Wipe-Vorgang zu 
überprüfen.  
(Wenn beispielsweise ‒50 für “X-Position” und ‒50 für 
“Y-Position” eingestellt worden ist, erscheint das folgende 
Bild (oder der Key) von unten links, und der Wipe-
Vorgang erfolgt, während das Bild (oder der Key) zur 
Bildschirmmitte wandert.)

<Einstellbereich von X- und Y-Position>

Y-Position

X-Position

   Innerhalb des Bildschirmbereichs
   Außerhalb des Bildschirmbereichs

Grundlegende Bedienung
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Key
Dieser Vorgang kombiniert das Hintergrundbild mit einem 
anderen Bild. 
Die Key-Definition kann eingestellt werden, und ein Rand 
kann dem kombinierten Bild hinzugefügt werden.

Key1 und Key2 sind als Material zum Erstellen der 
Hintergrundbilder verfügbar.
Die nachstehende Abbildung zeigt die Standardeinstellungen 
für die Priorität (Bildpositionierung).

<Standardeinstellungen für Priorität>

Key1

Key2

Hintergrundbild

Sie können die Priorisierung von Key1 und Key2 ändern.
 Siehe “Einstellen der Priorität”.

Die nachstehende Abbildung zeigt, wie Key-Kombinationen 
funktionieren.

<Funktionsweise der Key-Komposition>

HSW10

HSW10

Hintergrund

Key-
Quellensignal

Key Fill-Signal

Ausgabebild 
Umkehrung

Auswählen des Key-Typs
1 Wählen Sie den Ziel-Key (Key1/Key2) über folgenden 

Menüvorgang:

[3] Key >
 Key Select

2 Wählen Sie den Key-Typ über folgenden Menüvorgang:

[3] Key >
 Key Type

Lum(ChromaOff)
(Luminanz-Key · 
Chroma-Aus/
Eigen-Key)

Dieser Posten dient zur Erzeugung 
der Key-Signale von der Luminanz-
Komponente des Key-Quellensignals. 

Lum(ChromaOn)
(Luminanz-Key · 
Chroma-Aus/
Eigen-Key)

Dieser Posten dient zur Erzeugung der 
Key-Signale anhand der Luminanz-
Komponente bzw. Chroma-Komponente 
des Key-Füllungssignals.

Linear
(Linear-Key/EXT-
Key)

Dieser Posten dient zur Erzeugung 
der Key-Signale von der Luminanz-
Komponente des Key-Quellensignals. 
Er wird verwendet, wenn das Key-
Quellensignal und das Key-Füllungssignal 
verschieden sind.

Chroma
(Chroma-Key/
Eigen-Key)

Dieser Posten dient zur Erzeugung 
der Key-Signale unter Verwendung 
eines bestimmten Farbtons des Key-
Füllungssignals als Referenz.

Full
(Voll-Key/Eigen-
Key)

Dieser Posten dient zur Erzeugung der 
Key-Signale mithilfe der Bilder auf dem 
Vollbildschirm als Key-Quellensignale.

Da Luminanz- und Chroma-Key als Eigen-Key betätigt 
werden, werden die Key-Füllungssignale als Key-
Quellensignale verwendet. Für den Voll-Key werden die 
Bilder auf dem Vollbildschirm als Key-Quellensignale 
verwendet. 
Wenn der Luminanz-Key, der Chroma-Key oder der Voll-
Key als Key-Typ gewählt worden ist, bleiben die Key-
Signale unverändert, selbst wenn die Key-Quellensignale 
umgeschaltet werden.
Verwenden Sie bei Benutzung des Linear-Keys Material 
mit schwarzem Hintergrund und weißen Schriftzeichen 
oder Formen zur Kombination durch den Key als Key-
Quellensignal. 
Material, das nicht schwarz und weiß ist, wird eventuell 
nicht eindeutig kombiniert.
Material mit weißem Hintergrund und schwarzen 
Schriftzeichen usw. kann zum Gebrauch mithilfe der Key-
Umkehrfunktion umgekehrt werden.
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3 Wenn der Luminanz-Key gewählt worden ist, kann die 

Chroma-Komponente bei der Erzeugung der Key-Signale 
hinsichtlich der Eigen-Key-Anwendung einbezogen 
werden. (Dies gilt nicht für den Linear-Key.) 
Wählen Sie “Lum (Chroma On)” oder “Lum (Chroma Off)” 
als Key-Typ.

Chroma On Zusätzlich zu der Luminanz-Komponente 
wird auch die Chroma-Komponente bei der 
Erzeugung der Key-Signale mit berücksichtigt.
Dies ist die Einstellung zur Verwendung einer 
Farbe mit niedriger Luminanz-Komponente für 
die Key-Signale (z. B. bei der Definierung von 
blauen Schriftzeichen).

Chroma Off Die Key-Signale werden nur von der Luminanz-
Komponente erzeugt.

4 Wählen Sie den Füllungstyp über folgenden Menüvorgang:

[3] Key >
 Fill

Bus Das Bussignal wird als Key-Füllungssignal 
verwendet.

Matte Die interne Füllungsmatte wird als Key-
Füllungssignal verwendet.

Auswählen des Key-Materials

Auswählen der Key-Füllungs- und Key-Quellensignale

Drücken Sie die Taste [KEY] im AUX-Bus-Wahlbereich, und 
wechseln Sie die Auswahl des Key-Füllungssignals (Lampe 
leuchtet in Gelb auf) und des Key-Quellensignals (Lampe 
leuchtet in Grün auf).

<Auswählen des Key-Füllungssignals>
Während die Lampe der Taste [KEY] in Gelb leuchtet, 
drücken Sie eine der AUX-Bus-Kreuzpunkttasten 1 bis 6, um 
das Key-Füllungssignal auszuwählen.
Die Lampe der gewählten AUX-Bus-Kreuzpunkttaste leuchtet 
in Gelb. (Sie leuchtet in Rot, falls das ausgewählte Signal 
über die Buchse “PGM” ausgegeben wird.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

   Aufleuchten in Gelb

<Auswählen des Key-Quellensignals>
Während die Lampe der Taste [KEY] in Grün leuchtet, 
drücken Sie eine der AUX-Bus-Kreuzpunkttasten 1 bis 6, um 
das Key-Quellensignal auszuwählen.
Die Lampe der gewählten AUX-Bus-Kreuzpunkttaste leuchtet 
in Grün. (Sie leuchtet in Rot, falls das ausgewählte Signal 
über die Buchse “PGM” ausgegeben wird.)
Da Luminanz- und Chroma-Key als Eigen-Key betätigt 
werden, werden die Key-Füllungssignale als Key-
Quellensignale verwendet. Wenn der Luminanz-Key oder 
der Chroma-Key als Key-Typ gewählt worden ist, bleiben die 
Key-Signale unverändert, selbst wenn die Key-Quellensignale 
umgeschaltet werden.

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

   Aufleuchten in Grün
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Verbinden der Wahl von Key-Füllungssignal und Key-
Quellensignal

1 Wählen Sie den Ziel-Key (Key1/Key2) über folgenden 
Menüvorgang:

[3] Key >
 Key Select

2 Legen Sie die Key-Signalkopplung über folgenden 
Menüvorgang fest:

[3] Key >
 Key Signal Coupling

3 Legen Sie Füllung/Quelle über folgenden Menüvorgang 
fest:

[12] Config >
  Key Source Signal Coupling > Fill/Source

 pWenn “Füllung/Quelle” auf “Fill zu Quelle” eingestellt ist, 
wählen Sie die Quelle für die Füllung aus.
 pWenn die Einstellung Quelle zu Fill lautet, wählen Sie 
die Füllung für die ausgewählte Quelle aus.

<Key-Signalkopplung>
Wenn die Taste [KEY] gelb leuchtet, kann das Key-
Füllungssignal gewählt werden, und wenn sie grün leuchtet, 
kann das Key-Quellensignal gewählt werden.

Key Signal Coupling

Independent Bei Fill zu Quelle können Sie eine unabhängige 
Quelle festlegen, die mit dem Fill verknüpft und 
von anderen KEYs getrennt ist.
Bei Quelle zu Fill können Sie eine unabhängige 
Fill festlegen, die mit dem Quelle verknüpft und 
von anderen KEYs getrennt ist.

Coupling Verwenden Sie für die Key-
Quellensignalkopplung die Einstellungen der 
Posten (mit Ausnahme von “Füllung/Quelle”).

<Fill zu Quelle>
Wenn das Key-Füllungssignal gewählt wird, wechselt das 
Key-Quellensignal ebenfalls automatisch.

<Quelle zu Fill>
Wenn das Key-Quellensignal gewählt wird, wird das Key-
Füllungssignal automatisch umgeschaltet.

Einstellen der Füllungsmattenfarbe

Passen Sie Farbton, Sättigung und Luminanz der Fill-Matte 
über folgenden Menüvorgang an:

[3] Key >
 Fill Matte > Hue

[3] Key >
 Fill Matte > Sat

[3] Key >
 Fill Matte > Lum

■ Aufrufen der Vorwahlfarbe
Wählen Sie die Vorwahlfarbe über den folgenden 
Menüvorgang aus, und drücken Sie den OSD/TIME-Knopf:

[3] Key >
 Fill Matte > Load

 pWenn der OSD/TIME-Knopf gedrückt wird, werden die 
bislang vorgenommenen Einstellungen aufgehoben und 
durch die Werte der Vorwahlfarbe ersetzt.

 p Angaben zum Speichern der Werte, die vor dem Aufrufen 
der Vorwahlfarbe eingestellt wurden, finden Sie unter “Shot-
Speicher”.

Grundlegende Bedienung
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Key-Übergänge
1 Wählen Sie den Übergangsmodus über folgenden 

Menüvorgang:

[12] Config >
 Operate > Fader

Folgende Übergangsziele beim Betätigen des 
Überblendhebels können gewählt werden:

BKGD Hintergrundübergang
KEY1 Key-Übergang
BKGD+KEY1 Hintergrundübergang und Key-Übergang 

zugleich
NoAssign Kein Übergang beim Betätigen des 

Überblendhebels

2 Wählen Sie den Übergangstyp (MIX/WIPE) über folgenden 
Menüvorgang:

[3] WIPE > 
 Key1 Transition > Type

Bei Wahl von WIPE müssen Sie das Wischmuster über 
folgenden Menüvorgang auswählen:

[1] WIPE >
 Key1 Pattern

<Tabelle der Wischmuster>
Wischmuster und Nummern

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

3 Wählen Sie die Übergangsdauer über folgenden 
Menüvorgang:

[5] Time >
 Key1

[5] Time >
 Key2

Legen Sie die Übergangsdauer auf denselben Wert wie für 
den Hintergrundübergang fest.

4 Legen Sie die Wischrichtung über folgenden Menüvorgang 
fest:

[3] WIPE >
 Key1 Transition > Keyout Pattern

Normal Das Key-Out-Muster bewegt sich in die gleiche 
Richtung wie das Key-In-Muster.

Reverse Das Key-Out-Muster bewegt sich in die 
entgegengesetzte Richtung des Key-In-Musters.

<Musterbeispiele>

Musterbeispiel 1 Musterbeispiel 2
Wischmuster 9 bis 16

Key-in

Key-out 
(Normal)

Key-out 
(Umgekehrt)

: Dies kennzeichnet die Bereiche, in denen Keys 
kombiniert werden.

 pWischmuster 9 bis 16 funktionieren wie Musterbeispiel 2.

5 Führen Sie den Übergang aus. 
Betätigen Sie den Überblendhebel, um den Übergang 
manuell auszuführen.

Automatischer Key-Übergang

Wenn die Taste [KEY ON] im Übergangsbereich gedrückt 
wird, wird der Übergang automatisch mit der eingestellten 
Übergangszeit ausgeführt.
Während des Key-in-Vorgangs blinkt die Lampe der Taste 
[KEY ON] in Rot, und sie leuchtet in Rot, wenn der Übergang 
(Einblendung) abgeschlossen ist.
Wird die Taste [KEY ON] bei vollständig eingeblendetem Bild 
gedrückt, wird der Key-Bildübergang (Key-out) ausgeführt.
Während des Key-out-Vorgangs leuchtet die Lampe der 
Taste [KEY ON] in Rot, und sie erlischt, wenn der Übergang 
abgeschlossen ist. 
Wird die Taste [KEY ON] während des Übergangs gedrückt, 
wird die Übergangsrichtung umgekehrt.

Grundlegende Bedienung
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Key-Vorschau

Die Key-Vorschaubilder können zum Vorschau-Ausgang 
ausgegeben werden, und die Keys können eingestellt und 
überprüft werden.

Legen Sie die Vorschau über folgenden Menüvorgang fest:

[3] Key >
 PVW

Verknüpfung von Menüs

PVW-Bilder
Wenn PVW auf OFF eingestellt ist:

Der PGM-Status wird in der PVW angezeigt.
Dies wirkt sich jedoch nicht auf den Übergangsstatus aus.

Wenn PVW auf ON eingestellt ist:
Wenn PVW auf “On” eingestellt ist, werden die PGM-Bilder 
nach der PVW angezeigt.

Hintergrund der PVW
Die BKGD-Bilder für PVW sind ungeachtet der Einstellungen 
stets PST.

Wenn Sie die Benutzertaste für Ein/Aus drücken, wird 
zwischen “Ein” (Taste leuchtet) und “Aus” (Taste leuchtet 
nicht) umgeschaltet.
(Die relevanten Benutzertasten-Elemente sind KEY1_PVW/
KEY2_PVW.)

Menü Benutzertaste Drücken der Benutzertaste
On Leuchtet Off: erloschen

Off Erloschen On: leuchtet

Einstellen des Luminanz-Keys und Linear-
Keys

Diese Schritte werden ausgeführt, um die Luminanz- und 
Linear-Key-Definition einzustellen.

1 Passen Sie die Key-Definition über folgenden 
Menüvorgang an:

[3] Key >
 Key Adjust > Clip

[3] Key >
 Key Adjust > Gain

[3] Key >
 Key Adjust > Density

2 Legen Sie die Key-Umkehrung über folgenden 
Menüvorgang fest:

[3] Key >
 Key Adjust > Invert

Wenn “On” gewählt wird, werden die intern zu 
erzeugenden Key-Signale umgekehrt.

Parameter Beschreibung der 
Einstellung Einstellbereich

Clip Referenzpegel zur Erzeugung 
von Key-Signalen

0.0 bis 108.0

Gain Key-Amplitude 0.0 bis 200.0

Dichte Key-Dichte 0.0 bis 100.0

Umkehrung Key-Signal-Umkehrung Ein, aus

Grundlegende Bedienung



39

Grundlegende Bedienung

Einstellen des Chroma-Keys

Die Art der Definition des Chroma-Keys kann angepasst 
werden.

Wählen Sie über den folgenden Menüposten “Chroma” als 
Key-Typ, bevor Sie weitere Einstellungen vornehmen.

[3] Key >
 Key Type

Als Chroma-Key wird ein Key-Signal mit einem bestimmten 
Farbton als Referenz erzeugt. 
Beispiel: Das Key-Signal wird durch Erkennung der Farbe 
des Hintergrunds eines Bildes mit einer Person, die vor einer 
bestimmten Hintergrundfarbe steht, erzeugt, und ein weiterer 
Hintergrund wird kombiniert.

Dieses Gerät nutzt ein Bereichssystem, bei dem der 
Bereich mithilfe eines rechteckigen Rahmens markiert 
wird. Der Mittelwert der Pixelfarben in diesem Bereich wird 
als Referenzfarbe für den Chroma-Key (Key-Referenz) 
verwendet. Die maximale Abweichung vom Mittelwert wird als 
Radius für das Chroma-Key-Oval verwendet.
Es können Chroma-Keys erzeugt werden, die dem Chroma-
Raummuster treu sind (Bereich   in der Abbildung).



Y

Ovaler Chroma-Key

Chroma Farbtonradius
Sättigungsradius

Farbton

Automatische Ausführung der Abtastung

Indem Sie den Bereich angeben, in den der Hintergrund 
eingefügt werden soll, werden die Chroma-Komponenten 
abgetastet.

■ Marker

[4] ChromaKey >
 Marker

Dieser Posten dient zum Einblenden der Abtastmarkierung im 
PVW-Bild.

■ Marker Pos

[4] ChromaKey >
 Marker Position

Dieser Posten dient zum Anpassen von X- und Y-Koordinate 
sowie Größe der Abtastmarkierung.

■ Sample

[4] ChromaKey >
 Sample

Drücken Sie den OSD/TIME-Knopf, um die 
Farbtonkomponenten des mit der Abtastmarkierung 
ausgewählten Bereichs zu ermitteln.

 p Nach der Abtastung wird das durch Kombination von 
Chroma-Key und PVW-Bild entstandene Bild ausgegeben. 
(Schalten Sie die PVW-Funktion des Keys EIN.)
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Weitere Chroma-Key-Einstellungen

■ Marker Aspect

[4] ChromaKey >
 Marker Aspect

Dieser Posten dient Ändern des Seitenverhältnisses der 
Abtastmarkierung.

■ Ref Adjust

[4] ChromaKey >
 Ref Adjust

Dieser Posten erlaubt das Ändern der Farbe, die als Chroma-
Key-Referenz aus der abgetasteten Farbe verwendet werden 
soll.

Hue (Farbton) Referenz-Farbton
Sat (Sättigung) Referenz-Farbsättigung
Lum (Luminanz) Referenz-Luminanz

 p Nach der automatischen Abtastung werden die 
ermittelten Werte angezeigt.

■ Y-Influence

[4] ChromaKey >
 Y-Influence

Dieser Posten dient zum Einstellen des Einflussgrads, den 
die Y-Komponenten (Luminanz) aufweist. 
Je höher der eingestellte Wert, desto größer der Einfluss. Mit 
dem Wert “0” hat die Luminanzkomponente keinerlei Einfluss.

■ Radius

[4] ChromaKey >
 Radius

Dieser Posten dient zum Einstellen des Farbbereichs, der 
definiert werden soll.

Hue (Farbton-Radius) Ausdehnung des Farbtonbereichs, 
der definiert werden soll

Sat (Sättigungsradius) Ausdehnung des 
Farbsättigungsbereichs, der 
definiert werden soll

 p Nach der automatischen Abtastung werden die 
ermittelten Werte angezeigt.

■ Soft

[4] ChromaKey >
 Soft

Dieser Posten dient zum Einstellen des Betrags des Soft-
Effekts auf den Rand der Farbe, die definiert werden soll.

■ Cancel

[4] ChromaKey >
 Cancel

Dieser Posten dient zum Einstellen des Betrags der 
Farbdämpfung.
Die Farbdämpfung wird angepasst, wenn die 
Hintergrundfarbe dem Füllbild überlagert wird.

Tipp zum Einstellen des Chroma-Keys
Die folgenden Schritte erleichtern das Einstellen des 
Chroma-Keys.

1   Starten Sie die automatische Abtastung, und 
entscheiden Sie sich für die zu definierende Farbe.

2   Verwenden Sie den Posten “Radius”, und passen 
Sie ihn so an, dass die Hintergrundfarbe vollständig 
definiert ist.

3  Verwenden Sie den Posten “Soft”, um den Rand des 
Key-Signals feinabzustimmen.

Hinweis
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Key-Verzierungen

Ein Rand, ein Schatten oder eine andere Kante kann dem 
Key hinzugefügt werden.

Einstellen der Key-Kante

1 Wählen Sie den Kantentyp über folgenden Menüvorgang:

[3] Key >
 Edge > Type

Aus Es wird keine Kante hinzugefügt.
Border Ein Rand wird um den gesamten Kantenumfang 

hinzugefügt.
Drop Ein diagonaler Rand wird hinzugefügt.
Shadow Ein Schatten wird hinzugefügt.
Outline Ein Umriss (nur ein Rand ohne Füllung) wird 

hinzugefügt.

Border Drop

OutlineShadow

2 Wählen Sie die Kantenbreite über folgenden 
Menüvorgang:

[3] Key >
 Edge > Width

3 Wählen Sie die Richtung (in 45°-Schritten) für das 
Hinzufügen der Effekte “Drop” und “Shadow” über 
folgenden Menüvorgang:

[3] Key >
 Edge > Direction

(Oben)

(Unten)

(Rechts)(Links)

225180 270

135 315

4590 0

4 Wählen Sie die Kantendichte über folgenden 
Menüvorgang:

[3] Key >
 Edge > Density

Auswählen der Edge-Fill-Einstellungen

Das als Rand einzufügende Material kann festgelegt werden.

Wählen Sie das Kantenmaterial über folgenden 
Menüvorgang:

[3] Key >
 Edge > Fill

Color Die mit “Edge Color” festgelegte Farbe wird 
verwendet.

CBGD1
Der Farbhintergrund wird verwendet.CBGD2

Still1 Der Standbild-Videospeicher (Still1) wird 
verwendet.

Still2 Der Standbild-Videospeicher (Still2) wird 
verwendet.

Einstellen der Kantenfarbe

Passen Sie Farbton, Sättigung und Luminanz der 
Kantenfarbe über folgenden Menüvorgang an:

[3] Key >
  Edge > Color > Hue

[3] Key >
  Edge > Color > Sat

[3] Key >
  Edge > Color > Lum

■ Aufrufen der Vorwahlfarbe
Wählen Sie die Vorwahlfarbe über den folgenden 
Menüvorgang aus, und drücken Sie den OSD/TIME-Knopf:

[3] Key >
  Edge > Color > Load

 pWenn der OSD/TIME-Knopf gedrückt wird, werden die 
bislang vorgenommenen Einstellungen aufgehoben und 
durch die Werte der Vorwahlfarbe ersetzt.

 p Angaben zum Speichern der Werte, die vor dem Aufrufen 
der Vorwahlfarbe eingestellt wurden, finden Sie unter “Shot-
Speicher”.
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Maskieren der Key-Signale

Diese Schritte werden ausgeführt, um die Key-Signale unter 
Verwendung des Maskensignals des Kastenmusters zu 
maskieren.

1 Legen Sie den Maskenmodus über folgenden 
Menüvorgang fest:

[3] Key >
 Mask > Size

Aus Die Key-Signale werden nicht maskiert.
Manual Der Bereich, der mit dem Untermenü “Mask 

Adjust” festgelegt wurde, wird maskiert.
4:3 Die Signale werden im Seitenverhältnis 4:3 

maskiert.

2 Geben Sie über folgenden Menüvorgang an, ob das 
Maskensignal invertiert werden soll:

[3] Key >
 Mask > Invert

On Das Maskensignal wird umgekehrt.
Off Das Maskensignal wird nicht umgekehrt.

3 Legen Sie den Maskenbereich über folgenden 
Menüvorgang fest:

[3] Key >
 Mask > Position > Left

[3] Key >
 Mask > Position > Top

[3] Key >
 Mask > Position > Bottom

[3] Key >
 Mask > Position > Right

Parameter Beschreibung der 
Einstellung

Einstellbereich/
Ausgangswert

Left Key-Position links −50.00 bis 50.00/
−25.00

Top Key-Position oben −50,00 bis 50.00/
25.00

Bottom Key-Position unten −50.00 bis 50.00/
−25.00

Right Key-Position rechts −50.00 bis 50.00/
25.00

Die Einstellung für “Left” kann diejenige für “Right” 
(und umgekehrt) nicht überschreiten, und ebenso kann 
die Einstellung für “Top” diejenige für “Bottom” (und 
umgekehrt) nicht überschreiten.

<Key-Masken-Einstellung> (die Abbildung zeigt die 
Vorgaben)

0 

50 

-50 
500-50

TOP (25) 

BOTTOM (-25)

(25)
RIGHT

(-25)
LEFT  

Maskierter Bereich

Bereich, in dem das Key-Signal 
effektiv ist

Videosignalbereich

Einstellen der Priorität

Die relativen Positionen der Bilder können bei der 
Überlagerung von Key1- und Key2-Bildern eingestellt werden.

Legen Sie die relativen Positionen des 2. und 1. Elements 
über den folgenden Menüvorgang fest:

[3] Key >
 Key Priority > Key*

*  Nur das unter “[3] Key > Key Select” ausgewählte Menü 
wird angezeigt.

1st Legen Sie das obere Bild fest.

2nd Legen Sie das untere Bild fest.

2nd:
 Key1

1st:
 Key2
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PinP (Bild in Bild)
Ein anderes Bild kann mit dem Hintergrundbild kombiniert 
werden.
Dieses Gerät unterstützt PinP für 2 Kanäle, Key1 und Key2.

Aktivieren (On) oder deaktivieren (Off) Sie PinP über 
folgenden Menüvorgang:

[3] Key >
 PinP > PinP

Auswählen des PinP-Kanals und des 
Materials

Drücken Sie die [Key1]- oder [Key2]-Taste auf dem AUX-
Buswahltastenfeld.

Die gedrückte Taste leuchtet.
Der Zustand, in dem das PinP-Material gewählt werden kann, 
ist nun für die AUX-Bus-Kreuzpunkttasten hergestellt.

Die gewählte AUX-Bus-Kreuzpunkttaste leuchtet in Gelb. 
(Sie leuchtet in Rot, falls es sich bei dem ausgewählten 
Signal um ein PGM-Ausgangssignal handelt.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Auswählen der Form

Als Form für die Kombination von PinP-Bildern kann Quadrat, 
Kreis, Herz, Blume oder Stern ausgewählt werden.

 p Diese Einstellung ist nur aktiviert, wenn [Full Key] auf [ON] 
eingestellt ist.

1 Wählen Sie die Form für das Kombinieren von Bildern über 
folgenden Menüvorgang:

[3] Key >
 PinP > Shape

2 Wählen Sie die Durchlässigkeit (Dunkelheit) für das 
Kombinieren von Bildern über folgenden Menüvorgang:

[3] Key >
 PinP > Density

Full Key Ein/Aus

Aktivieren (On) oder deaktivieren (Off) Sie Voll-Key über 
folgenden Menüvorgang:

[3] Key >
 PinP > Full Key

On Unabhängig von den für “[3] Key > Key Type” 
festgelegten Werten werden PinP-Bilder mit Voll-
Key erstellt.

Off PinP-Bilder werden gemäß den unter “[3] Key > 
Key Type” festgelegten Werten erstellt.

PinP-Einstellungen

Einstellen der PinP-Position und -Größe

Legen Sie die X- und Y-Koordinaten sowie die Größe über 
folgenden Menüvorgang fest:

[3] Key >
 PinP > Position > X-Position

[3] Key >
 PinP > Position > Y-Position

[3] Key >
 PinP > Position > Size
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Verbinden von Key1 PinP und Key2 PinP

Die Bilder Key1 PinP und Key2 PinP führen einen 
symmetrischen Vorgang für die Achse aus, deren 
Koordinaten eingestellt worden sind. 
Das als Referenz dienende Bild ist das PinP-Bild des 
verwendeten Menüs.

Verbinden von Key1 PinP und Key2 PinP

Wählen Sie die Referenzposition über folgenden 
Menüvorgang:

[3] Key >
 PinP > Sync > Symmetry

Das als Referenz dienende Bild ist das PinP-Bild des 
verwendeten Menüs.

Wenn “X” als Einstellung von “Symmetry” gewählt 
wurde

Die Koordinaten werden symmetrisch zur X-Achse 
gemacht.

Wenn “Y” als Einstellung von “Symmetry” gewählt 
wurde

Die Koordinaten werden symmetrisch zur Y-Achse 
gemacht.

Wenn “Center” als Einstellung von “Symmetry” 
gewählt wurde

Die Koordinaten werden symmetrisch zur Mitte gemacht.

Wenn “Same” als Einstellung von “Symmetry” 
gewählt wurde
Die Koordinaten sind identisch.

Kopieren der Einstellungen

Einstellwerte können über folgenden Menüvorgang kopiert 
werden:

[3] Key >
 PinP > Sync > Copy to Key

Die Einstellungen für “Key1 PinP” können zu “Key2 PinP” 
kopiert werden und umgekehrt.

 p Quellnamen, die unter “[3] Key > Key Select” nicht gewählt 
wurden, werden angezeigt.

Der Einstellwert für “Key1 PinP” (oder “Key2 PinP”) wird 
kopiert und als Wert für “Key2 PinP” (oder “Key1 PinP”) 
übernommen, wenn der OSD/TIME-Knopf mit folgendem 
Menüvorgang gedrückt wird:

Die folgenden Einstellungen werden nicht kopiert.
 p [3] Key > PinP > PinP
 p [3] Key > PinP > Shape
 p [3] Key > PinP > Density
 p [3] Key > PinP > Full Key
 p [3] Key > PinP > Trim > Trim
 p [3] Key > PinP > Trim > Pair
 p [3] Key > PinP > Trim > Preset

Hinweis
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PinP-Verzierungen

Ein Rand- oder Soft-Effekt kann zu PinP hinzugefügt werden.

1 Schalten Sie den Rand über folgenden Menüvorgang ein 
bzw. aus:

[3] Key >
 PinP > Border > Border

2 Legen Sie die Randbreite über folgenden Menüvorgang 
fest:

[3] Key >
 PinP > Border > Width

3 Legen Sie den Betrag des Soft-Effekts über folgenden 
Menüvorgang fest: 
Bei Einstellung auf “0.0” ist der Soft-Effekt deaktiviert.

[3] Key >
 PinP > Border > Soft

Wenn “On” als Einstellung des Postens “Border” gewählt 
worden ist, wird das Verhältnis des Soft-Effekts zur 
Randbreite als Betrag des Soft-Effekts angezeigt. 
Wenn nur der Soft-Effekt zu PinP hinzugefügt werden soll, 
wählen Sie “Off” als Einstellung des Postens “Border”.

4 Legen Sie die Randbreitenschwankung über folgenden 
Menüvorgang fest:

[3] Key >
 PinP > Border > Mode

Fix Die Randbreite wird konstant gehalten.

Variable Die Randbreite wird an die PinP-Größe 
angepasst.

Einstellen der Randfarbe

Passen Sie Farbton, Sättigung und Luminanz der Randfarbe 
über folgenden Menüvorgang an:

[3] Key >
 PinP > Border > Color > Hue

[3] Key >
 PinP > Border > Color > Sat

[3] Key >
 PinP > Border > Color > Lum

■ Aufrufen der Vorwahlfarbe
Wählen Sie die Vorwahlfarbe über den folgenden 
Menüvorgang aus, und drücken Sie den OSD/TIME-Knopf:

[3] Key >
 PinP > Border > Color > Load

 pWenn der OSD/TIME-Knopf gedrückt wird, werden die 
bislang vorgenommenen Einstellungen aufgehoben und 
durch die Werte der Vorwahlfarbe ersetzt.

 p Angaben zum Speichern der Werte, die vor dem Aufrufen 
der Vorwahlfarbe eingestellt wurden, finden Sie unter “Shot-
Speicher”.

Beschnitteinstellungen
1 Schalten Sie den Beschnitt über folgenden Menüvorgang 

ein bzw. aus:

[3] Key >
 PinP > Trim > Trim

On Ein Beschnitt wird durchgeführt.
Off Kein Beschnitt

2 Legen Sie den Beschnitttyp über folgenden Menüvorgang 
fest:

[3] Key >
 PinP > Trim > Preset

16:9 Automatischer Beschnitt auf das 
Seitenverhältnis 16:9

12:9 Automatischer Beschnitt auf das 
Seitenverhältnis 12:9

9:9 Automatischer Beschnitt auf das 
Seitenverhältnis 9:9

7:9 Automatischer Beschnitt auf das 
Seitenverhältnis 7:9

6:9 Automatischer Beschnitt auf das 
Seitenverhältnis 6:9

Manual Beschnitt unter Verwendung des im Untermenü 
“Trim” eingestellten Werts.

3 Schalten Sie den paarweisen Beschnitt über folgenden 
Menüvorgang ein bzw. aus:

[3] Key >
 PinP > Trim > Pair

On Die Einstellungen werden so geändert, dass die 
Beschnittbeträge für “Left” und “Right” sowie für 
“Top” und “Bottom” gleich sind. 
(Dadurch ergibt sich eine Oben-Unten und 
Links-Rechts-Symmetrie.)

Off Kein Koppeln der Einstellungen.
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Key1 und Key2 können verknüpft werden.

Die Taste [KEY1 ON] und die Taste [KEY2 ON] Ein/aus (Taste 
leuchtet/erlischt) können verknüpft werden.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Verwenden Sie den folgenden Menüvorgang zum Ein-/
Ausschalten der Verknüpfung der einzelnen Tasten:

[3] Config >
 Key1/2 Link

 pWenn “Off” ausgewählt ist, erfolgt keine Verknüpfung.

Key-Verknüpfung

4 Legen Sie die Beschnittwerte über folgenden 
Menüvorgang fest:

[3] Key >
 PinP > Trim > Adjust > Left

[3] Key >
 PinP > Trim > Adjust > Top

[3] Key >
 PinP > Trim > Adjust > Bottom

[3] Key >
 PinP > Trim > Adjust > Right

Parameter Beschreibung der 
Einstellung

Einstellbereich/
Ausgangswert

Left Beschnittwert links −50.00 bis 50.00/
−50.00

Top Beschnittwert oben −50.00 bis 50.00/
50.00

Bottom Beschnittwert unten −50.00 bis 50.00/
−50.00

Right Beschnittwert rechts −50.00 bis 50.00/
50.00

<Beschnitteinstellungen> (die Abbildung zeigt die 
Vorgaben)

0

60

-60
600-60

TOP (50)

BOTTOM (-50)

(-50)
LEFT

(50)
RIGHT

Beschnittbereich

Bereich, in dem PinP effektiv ist

Originalgröße von PinP
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FTB (Abblenden zu Schwarz)
Der Benutzer kann von einem Programmbild zu einem 
Schwarzbild/Weißbild/Standbild/Farbhintergrundbild 
ausblenden oder von einem Schwarzbild/Weißbild/Standbild/
Farbhintergrundbild zu einem Programmbild einblenden.

1 Stellen Sie die Dauer des Übergangs ein. 
Legen Sie die Übergangsdauer mit dem folgenden 
Menüvorgang auf denselben Wert wie für jeden 
Hintergrundübergang fest:

[5] Time >
 FTB > Trans Time

 Siehe “Automatischer Übergang”.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

2 Der Bildschirm wird in der eingestellten Übergangszeit 
zum Einstellbildschirm ausgeblendet, wenn Sie im 
Übergangsbereich die Taste [FTB ON] drücken.
Während der Abblende blinkt die Lampe der Taste [FTB 
ON] in Rot; sie leuchtet in Rot, wenn der Übergang 
(Abblendung) abgeschlossen ist und der schwarze 
Bildschirm angezeigt wird.* 
Wird die Taste [FTB ON] bei schwarzem Bildschirm 
gedrückt, wird die Einblendung zum Programmbild 
eingeleitet. 
Während der Einblendung leuchtet die Lampe der Taste 
[FTB ON] in Rot, und sie erlischt, wenn der Übergang 
(Einblendung) abgeschlossen ist. 
Falls die Taste [FTB ON] an irgendeinem Punkt während 
eines Übergangs gedrückt wird, wird die Richtung des 
Übergangs umgekehrt.

*:  Im FTB-Status leuchtet die Kreuzpunkttaste, die 
normalerweise in Rot leuchtet, in Gelb.

Auswählen des Bilds

Das für die Ausblendung zu verwendende Bild kann 
ausgewählt werden.

Wählen Sie das Bild für das Abblenden über folgenden 
Menüvorgang:

[5] Time >
 FTB > Source

Still1 Der Standbild-Videospeicher (Still1) wird 
verwendet.

Still2 Der Standbild-Videospeicher (Still2) wird 
verwendet.

CBGD1
Der Farbhintergrund wird verwendet.CBGD2

White Weißer Hintergrund
Black Schwarzer Hintergrund

Audio-Stummschaltung

Sie können angeben, ob Audio- und Bild-Abblendung 
synchronisiert werden.

Geben Sie über folgenden Menüvorgang an, ob der Ton 
ebenfalls abgeblendet werden soll:

[5] Time >
 FTB > Mute

Off Das Tonsignal wird während der Bild-
Abblendung nicht abgeschwächt.

On Das Tonsignal wird während der Bild-
Abblendung abgeschwächt.
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Interne Farbsignale

Dieses Gerät unterstützt zwei Sätze interner Farbsignale.

Einstellen des Farbhintergrunds

Der vom Bus zu verwendende Farbhintergrund kann 
eingestellt werden.
Zwei Methoden sind verfügbar: Bei der einen Methode 
werden die Posten “Hue” (Farbton), “Sat” (Farbsättigung) und 
“Lum” (Luminanz) eingestellt, und bei der anderen werden 
die 8 Vorwahlfarben (Weiß, Gelb, Zyan, Grün, Magenta, Rot, 
Blau und Schwarz) aufgerufen. 
Die Posten “Hue”, “Sat” und “Lum” der aufgerufenen Farben 
können ebenfalls eingestellt werden.

Einstellen der Farben

1 Wählen Sie den Ziel-Farbhintergrund (CBGD1/CBGD2) 
über folgenden Menüvorgang:

[2] CBGD >
 CBGD Select

2 Passen Sie die Farbe (Farbton, Sättigung, Luminanz) über 
folgenden Menüvorgang an:

[2] CBGD >
 CBGD Main > Hue

[2] CBGD >
 CBGD Main > Sat

[2] CBGD >
 CBGD Main > Lum

■ Aufrufen der Vorwahlfarbe
Wählen Sie die Vorwahlfarbe über den folgenden 
Menüvorgang aus, und drücken Sie den OSD/TIME-Knopf:

[2] CBGD >
 CBGD Main > Load

 pWenn der OSD/TIME-Knopf gedrückt wird, werden die 
bislang vorgenommenen Einstellungen aufgehoben und 
durch die Werte der Vorwahlfarbe ersetzt.

 p Angaben zum Speichern der Werte, die vor dem Aufrufen 
der Vorwahlfarbe eingestellt wurden, finden Sie unter “Shot-
Speicher”.

Einstellen des Wascheffekts

Der Abstufungseffekt für Farbhintergründe kann festgelegt 
werden.

Auswählen des Wascheffekts und Festlegen der 
Farben

1 Legen Sie den Wascheffekt (Abstufung) über folgenden 
Menüvorgang fest:

[2] CBGD >
 CBGD Wash > Wash

On Der Abstufungseffekt wird hinzugefügt.
Off Der Abstufungseffekt wird nicht hinzugefügt.

2 Legen Sie die Farbe für den Wascheffekt (Abstufung) über 
folgenden Menüvorgang fest:

[2] CBGD >
 CBGD Wash > Color

Dual Ein Zweifarben-Abstufungseffekt wird 
hinzugefügt. 
(Dies führt zu einer Abstufung von zwei Farben, 
und zwar der Farbe “CBGD1 Main” und der 
Farbe “CBGD1 Sub”.)

Rainbow Der Regenbogen-Farbabstufungseffekt wird 
hinzugefügt.

3 Bei Wahl von “Dual” müssen Sie die Farbe (Farbton, 
Sättigung, Luminanz) der Teilfarbe über folgenden 
Menüvorgang anpassen:

[2] CBGD >
 CBGD Sub > Hue

[2] CBGD >
 CBGD Sub > Sat

[2] CBGD >
 CBGD Sub > Lum
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Einstellen der Wash-Wellenformen

1 Wählen Sie die Wellenform der Abstufung über folgenden 
Menüvorgang:

[2] CBGD >
 CBGD Wave > Pattern

Sine Sinuswellen werden gewählt.
Saw Sägezahnwellen werden gewählt.

2 Wählen Sie den Zyklus der Abstufung über folgenden 
Menüvorgang:

[2] CBGD >
 CBGD Wave > Cycle

3 Wählen Sie die Phase der Abstufung über folgenden 
Menüvorgang:

[2] CBGD >
 CBGD Wave > Phase

4 Wählen Sie den Winkel der Abstufung über folgenden 
Menüvorgang:

[2] CBGD >
 CBGD Wave > Angle

Einstellen des Waschbewegungen

1 Legen Sie die Bewegung der Abstufung über folgenden 
Menüvorgang fest:

[2] CBGD >
 CBGD Move > Move

Off Es erfolgt keine Bewegung.
Roll Die Abstufungen werden gerollt.
Rotation Die Abstufungen werden gedreht.

2 Legen Sie die Geschwindigkeit der Bewegung über 
folgenden Menüvorgang fest:

[2] CBGD >
 CBGD Move > Speed
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Internes Farbbalkensignal

Das Gerät unterstützt 1 internes Farbbalkensignal.

Auswählen des internen Farbbalkensignals

Sie können über die folgenden Menüeinstellungen zwischen 
den Typen 1 bis 3 für den integrierten Farbbalkentyp wählen:

[12]Config >
 CBAR > Type

Type1

Type2

Type3

 p Die Farbbalken dienen zum Anpassen der Farbphase. 
Die Breite und Lage der Balken kann sich von der 
Darstellung bei anderen Modellen unterscheiden.

Testton-Einstellungen

Hier können die Einstellungen für die Testtonsignale (1 kHz) 
vorgenommen werden, die mit den Farbbalkensignalen 
ausgegeben werden.

Legen Sie die Testtonfunktion über folgenden Menüvorgang 
fest:

[12] Config >
 CBAR > Test Tone

Normal Testtöne werden mit normaler Lautstärke 
(–12 dB) ausgegeben.

Low Testtöne werden mit verringerter Lautstärke 
(–20 dB) ausgegeben.

Off Es werden keine Testtöne ausgegeben.
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Integriertes Testbild
Sie können mit diesem Gerät ein Signal für ein Testbild 
ausgeben.
Das ist nützlich, um beispielsweise das Seitenverhältnis auf 
angeschlossenen Geräten zu kontrollieren.
Es wird ein Testbild mit einem Bildwinkel gewählt, der dem an 
diesem Gerät eingestellten Systemformat entspricht.
Das Signal wird im Videospeicher in Still1 oder Still2 geladen 
und kann als interne Quelle verwendet werden.

<Testbild für den Systemmodus 1080>

<Testbild für den Systemmodus 720>

1 Wählen Sie das Gerät, zu dem das Testmustersignal 
ausgegeben wird, die folgt aus:

[6] Still >
 Still Select

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) 
im folgenden Menü, um es in den ausgewählten 
Videospeicher zu laden:

[6] Still >
 Test Pattern > Load
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Umschalten des AUX-Ausgangs

Auswählen des AUX-Ausgabematerials

Die Ausgangssignale der AUX-Busse (AUX1, AUX2) können 
gewählt werden.

1 Drücken Sie eine der Tasten [AUX1], [AUX2] unter den 
AUX-Bus-Wahltasten. 
Die ausgewählte Taste leuchtet in Gelb.

2 Drücken Sie eine der AUX-Bus-Kreuzpunkttasten. 
Das ausgewählte Signal wird an die gedrückte Taste 
[AUX1], [AUX2] ausgegeben.
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Die Taste mit den von AUX1 gewählten Signalen leuchtet in 
Gelb.

<Mit dem AUX-Bus wählbare Signale>
Name des Signals Beschreibung des Signals

IN1 SDI/HDMI-Eingangssignal 1

IN2 SDI-Eingangssignal 2

IN3 SDI-Eingangssignal 3

IN4 SDI-Eingangssignal 4

IN5 HDMI-Eingangssignal 2

IN6 IP-Eingangssignal 1

IN7 IP-Eingangssignal 2

IN8 IP-Eingangssignal 3

IN9 IP-Eingangssignal 4

PGM Programm-Videosignal

PVW Vorschau-Videosignal

CLN Reinsignal

MV Mehrfeldanzeige-Ausgangssignal

KeyOut Key-Ausgangssignal

Black Schwarzsignal

CBGD1, CBGD2 Farbhintergrund 1, 2

CBAR Farbbalken

Still1, Still2 Videospeicher (Standbilder) 1, 2

 pWenn der AUX-Bus, für den “MV” gewählt wurde, auf 
dem Unterbildschirm der Mehrfeldanzeige angezeigt 
wird, werden die Bilder vervielfältigt, als ob zwei Spiegel 
einander gegenüber gestellt worden wären.

AUX1/2-Übergänge

Der MIX-Übergang wird ausgeführt, wenn das für AUX1/2 
eingestellte Ausgangssignal umgeschaltet wird.

1 Drücken Sie die [AUX1]- oder [AUX2]-Taste auf dem AUX-
Buswahltastenfeld. 
Die ausgewählte Taste und ihre entsprechende AUX-Bus-
Kreuzpunkttaste leuchten in Gelb.

2 Drücken Sie die AUX-Bus-Kreuzpunkttaste für das 
Ausgangssignal, auf das umgeschaltet werden soll. 
Der MIX-Übergang wird nun für die Länge der im Menü 
“Time” eingestellten Übergangszeit ausgelöst. 
Während der Übergang läuft, leuchtet die AUX-Taste 
der Übergangsquelle in Grün, und die AUX-Taste des 
Übergangsziels blinkt in Gelb. 
Sobald der Übergang beendet ist, erlischt die AUX-
Taste der Übergangsquelle, und die AUX-Taste des 
Übergangsziels leuchtet in Gelb. 
Wenn darüber hinaus ein anderes Signal an einem 
Zwischenpunkt während eines Übergangs gewählt wird, 
wird die Übergangsverarbeitung ab diesem Zwischenpunkt 
fortgesetzt.
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Blinkt in Gelb (während der Übergang läuft).
Leuchtet in Grün.

 p Der AUX-Busübergang beim Abrufen des Shot-Speichers 
ist mit der Überblendzeit des Shot-Speichers verknüpft.
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Einstellen der Aktivierung/Deaktivierung für 
den AUX1/2-Übergang

Die AUX1/2-Übergangszeit und die Aktivierung/Deaktivierung 
des Übergangs können eingestellt werden.

1 Wählen Sie die Übergangsdauer über folgenden 
Menüvorgang:

[5] Time >
 AUX1 Bus Trans > Trans Time

[5] Time >
 AUX2 Bus Trans > Trans Time

Eine beliebige Zeit von 0 bis 999f kann eingestellt werden. 
Wenn Sekunden als Anzeigeeinheit verwendet werden, 
hängt die einstellbare Zeit vom Systemformat ab.

59.94i max. 33s09f 29.97p max. 33s09f

50i max. 39s24f 25p max. 39s24f

59.94p max. 16s39f 24p max. 41s15f

50p max. 19s49f 23.98p max. 41s15f

2 Aktivieren oder deaktivieren Sie den Übergang über 
folgenden Menüvorgang:

[5] Time >
 AUX1 Bus Trans > Transition

[5] Time >
 AUX2 Bus Trans > Transition

On Aktivieren
Off Deaktivieren

Wenn der Übergang deaktiviert wurde, werden die 
Ausgangssignale ohne Übergang umgeschaltet, wenn die 
in AUX1/2 eingestellten Ausgangssignale umgeschaltet 
werden.
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Shot-Speicher

Das Hintergrundübergangsmuster, die PinP-Größe, die Randbreite und andere Videoeffekte können im Speicher registriert und 
wieder abgerufen werden. Der dafür verwendete Speicher wird Shot-Speicher genannt.
Durch die Einstellung der Effektauflösung ist es möglich, einen reibungslosen Wechsel der Umschaltung von den aktuellen 
Bildern auf die im Shot-Speicher registrierten Bilder oder Operationen zu gewährleisten.

Speicherelemente, die registriert und abgerufen werden können

Posten Materialwahl Übergang Muster Menü
BKGD  PGM/A-Bus

 PST/B-Bus
 Faderbetrag 
 Wischrichtung

  BKGD-Muster  
(MIX, WIPE)

 [1] WIPE

Key1  Key1-Fill-Bus
 Key1-Quell-Bus

 Key1 ein/aus
 Faderbetrag 
 Wischrichtung

  KEY-Muster  
(MIX, WIPE)

 [1] WIPE
 [3] Key
 [4] ChromaKey

Key2  Key2-Fill-Bus
 Key2-Quell-Bus

 Key2 ein/aus  [3] Key

AUX1  AUX1-Bus

AUX2  AUX2-Bus

CBGD  [2] CBGD

Ablegen der Einstellungen im Speicher 
(Speichern)

Zu registrierende Bilder und Operationen können festgelegt 
und dann in den Speichern registriert werden.

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1 Legen Sie mithilfe der Einheit die im Speicher zu 
bewahrenden Bilder oder Operationen fest.

2 Wählen Sie das im Speicher zu registrierende Element 
über die folgenden Menüs aus:

[7] Shot Memory >
 Target Select > BKGD

[7] Shot Memory >
 Target Select > Key1

[7] Shot Memory >
 Target Select > Key2

[7] Shot Memory >
 Target Select > AUX1

[7] Shot Memory >
 Target Select > AUX2

[7] Shot Memory >
 Target Select > CBGD

  Siehe “Speicherelemente, die registriert und abgerufen 
werden können”.

3 Drücken Sie die [SHOT MEM]-Taste. 
Die [SHOT MEM]-Taste wird bernsteinfarben.

4 Halten Sie die AUX-BUS-Wahltaste (1 bis 12) des 
Speicherplatzes gedrückt, um das Element zu registrieren. 
(Ca. 1 Sekunde)
Die AUX-BUS-Wahltaste des Speicherplatzes leuchtet 
grün, wenn die Registrierung abgeschlossen ist.

 p Die AUX-BUS-Wahltasten 1 bis 6 werden bei gedrückt 
gehaltener [SHIFT]-Taste zu den Wahltasten 7 bis 12.

 p AUX-BUS-Wahltasten, die grün oder gelb leuchten, 
enthalten Speicherinhalte.

5 Wiederholen Sie die obigen Schritte, um weitere 
Einstellungen in den Speichern zu registrieren.
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Abrufen der gespeicherten Operationen 
(Abrufen)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1 Wählen Sie das aus dem Speicher abzurufende Ziel über 
die folgenden Menüs aus:

[7] Shot Memory >
 Target Select > BKGD

[7] Shot Memory >
 Target Select > Key1

[7] Shot Memory >
 Target Select > Key2

[7] Shot Memory >
 Target Select > AUX1

[7] Shot Memory >
 Target Select > AUX2

[7] Shot Memory >
 Target Select > CBGD

  Siehe “Auswählen von Zielen für Registrierung und 
Wiedergabe”.

2 Aktivieren Sie das folgende Menü, um die 
Kreuzpunkttasten am Pult für die Materialwahl zu 
verwenden, anstatt das im Posten “Material selection” 
registrierte Material zu verwenden.

[7] Shot Memory >
 XPT Disable

  Siehe “Auswählen von Zielen für Registrierung und 
Wiedergabe”.

3 Drücken Sie die  [SHOT MEM]-Taste. 
Die [SHOT MEM]-Taste wird bernsteinfarben.

4 Drücken Sie die AUX-BUS-Wahltaste (1 bis 12) des 
Speicherplatzes, um den Inhalt abzurufen.

 p Die AUX-BUS-Wahltasten 1 bis 6 werden bei gedrückt 
gehaltener [SHIFT]-Taste zu den Wahltasten 7 bis 12.
 p Im Falle eines Shot-Speichers werden die Videoeffekte 
abgerufen, und die Wiedergabe beginnt. 
Während der Wiedergabe leuchtet die AUX-BUS-
Wahltaste des Speicherplatzes gelb.

Informationen zum Abrufen von Speichervorgängen 
aus Benutzertasten finden Sie unter “Einstellen der 
Benutzertasten”.

Löschen der gespeicherten Operationen 
(Löschen)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1 Halten Sie die Taste [SHOT MEM] gedrückt.
Die [SHOT MEM]-Taste blinkt gelb.
Die AUX-BUS-Wahltasten, die Speicherinhalte enthalten, 
blinken ebenfalls grün oder gelb.

2 Halten Sie die AUX-BUS-Wahltaste (1 bis 12) des zu 
löschenden Speicherplatzes etwa eine Sekunde lang 
gedrückt.
Die gedrückte AUX-BUS-Wahltaste erlischt.

 p Die AUX-BUS-Wahltasten 1 bis 6 werden bei gedrückt 
gehaltener [SHIFT]-Taste zu den Wahltasten 7 bis 12.
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Auswählen von Zielen für Registrierung und 
Wiedergabe

Auswählen des Ziels und des Postens “Material 
selection” beim Registrieren von Speichern

Beim Erstellen eines Shot-Speichers wählen Sie die zu 
speichernden Elemente aus.

Aktivieren Sie das Speichern von Elementen über folgenden 
Menüvorgang:

[7] Shot Memory >
 Target Select > BKGD > Target

[7] Shot Memory >
 Target Select > Key1 > Target

[7] Shot Memory >
 Target Select > Key2 > Target

On Die Zieleinstellung wird im Speicher registriert.
Off Die Zieleinstellung wird nicht im Speicher 

registriert.

[7] Shot Memory >
 Target Select > BKGD > XPT

[7] Shot Memory >
 Target Select > Key1 > XPT

[7] Shot Memory >
 Target Select > Key2 > XPT

On Die Materialwahl wird im Speicher registriert.
Off Die Materialwahl wird nicht im Speicher 

registriert.

[7] Shot Memory >
 Target Select > AUX1

[7] Shot Memory >
 Target Select > AUX2

[7] Shot Memory >
 Target Select > CBGD

On Die Zieleinstellung wird im Speicher registriert.
Off Die Zieleinstellung wird nicht im Speicher 

registriert.

Auswählen des Ziels und des Postens “Material 
selection” beim Wiedergeben eines Speichers

Bei der Wiedergabe eines Shot-Speichers wählen Sie das 
Element und die Materialwahl für die Wiedergabe aus.

Aktivieren Sie die Wiedergabe des Elements über folgenden 
Menüvorgang:

[7] Shot Memory >
 Target Select > BKGD > Target

[7] Shot Memory >
 Target Select > Key1 > Target

[7] Shot Memory >
 Target Select > Key2 > Target

On Das Ziel wird wiedergegeben.
Wenn das Element nicht im Speicher 
registriert ist, erfolgt keine Wiedergabe.

Off Das Ziel wird nicht wiedergegeben.

[7] Shot Memory >
 Target Select > BKGD > XPT

[7] Shot Memory >
 Target Select > Key1 > XPT

[7] Shot Memory >
 Target Select > Key2 > XPT

On Die Materialwahl wird wiedergegeben.
Wenn das Element nicht im Speicher 
registriert ist, erfolgt keine Wiedergabe.

Off Die Materialwahl wird nicht wiedergegeben.

[7] Shot Memory >
 Target Select > AUX1

[7] Shot Memory >
 Target Select > AUX2

[7] Shot Memory >
 Target Select > CBGD

On Das Ziel wird wiedergegeben.
Wenn das Element nicht im Speicher 
registriert ist, erfolgt keine Wiedergabe.

Off Das Ziel wird nicht wiedergegeben.

[7] Shot Memory >
 XPT Disable

On Die Materialwahl für BKGD, Key1 und Key2 wird 
nicht wiedergegeben.

Off Die Materialwahl für BKGD, Key1 und Key2 wird 
wiedergegeben.
Wenn das Element nicht im Speicher 
registriert ist, erfolgt keine Wiedergabe.
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Speicher)

Die Umschaltung vom aktuellen Bild zu dem (der) im Shot-
Speicher enthaltenen Bild oder Operation kann reibungslos 
durchgeführt werden.

1 Legen Sie den Effekt bei der Bildumschaltung über 
folgenden Menüvorgang fest:

[7] Shot Memory >
 Effect

Cut Die Bilder werden unter Verwendung des 
Schnitteffekts gewechselt.

Dissolve Die Bilder werden unter Verwendung des 
Auflösungseffekts gewechselt.

 p Legen Sie die Dauer für den Auflösungseffekt über 
folgenden Menüvorgang fest:

[5] Time >
 Effect Dissolve

2 Legen Sie den Effekt beim Farbwechsel über folgenden 
Menüvorgang fest:

[7] Shot Memory >
 Hue Path

Die folgenden Farben sind von “Hue” betroffen.
 p Farben des Farbhintergrunds
 p Farben der Ränder
 p Farben der Kanten
 p Farben der Fill-Matte

Short Die Farben werden in Richtung schwächerer 
Farbton auf dem Vektorskop geändert.

Long Die Farben werden in Richtung stärkerer 
Farbton auf dem Vektorskop geändert.

CW Der Farbton wird im Uhrzeigersinn auf dem 
Vektorskop geändert.

CCW Der Farbton wird entgegen dem Uhrzeigersinn 
auf dem Vektorskop geändert.

 p Die gedrückte AUX-BUS-Wahltaste leuchtet beim 
Umschalten des Vorgangs gelb.

 pWenn der Posten “Effect” von “Dissolve” auf “Cut” geändert 
wird, während die Operation gewechselt wird, wird der 
Auflösungseffekt aufgehoben, und die Bilder werden 
augenblicklich zu den Bildern des gewählten Shot-
Speichers gewechselt.

 pWährend der Operationsumschaltung wird die Operation 
des Überblendhebels aufgehoben.

 p Andere Speichervorgänge können während einer 
Umschaltung nicht abgerufen werden.

Grundlegende Bedienung
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Videospeicher
Dieses Gerät kann Standbilder in zwei Kanälen speichern.

 p Bilder mit Key-Signalen können in den Videospeichern 
(Standbilder und Bewegtbilder) gespeichert werden.

 p Die Videospeicherdaten können auf USB-Speichergeräten 
gespeichert und von dort ausgelesen werden.

 p Bei einem Wechsel des Systemformats dieses Geräts 
zwischen 1080 und 720 werden die gespeicherten 
Videospeicher gelöscht. 
Speichern Sie daher die Videospeicher vor einem Wechsel 
des Systemformats auf einem USB-Speichergerät oder in 
einer Projektdatei.

■ Videospeicher-Eingabe/Ausgabe
Das Bildeingangsmaterial kann von den Ausgangssignalen 
der AUX-Busse (AUX1, AUX2) ausgewählt werden.

<Bildsysteme der Videospeicher>

Still2

Still1

AUX1, AUX2:
  Auswahl über 

Menü

AUX1, AUX2:
  Auswahl über 

Menü

Vídeo

Key

Vídeo

Key

Aufnehmen von Standbildern (Still)
1 Wählen Sie “Still1” oder “Still2” über folgenden 

Menüvorgang:

[6] Still >
 Still Select

2 Bestimmen Sie die im Videospeicher abzulegenden Bilder 
über den folgenden Menüvorgang:

[6] Still >
  Capture Setting > Video

AUX1, AUX2 Die Ausgangssignale der AUX-Busse (AUX1, 
AUX2) werden als Material aufgezeichnet.

3 Legen Sie die Prüfansicht (Rückschau) über folgenden 
Menüvorgang fest:

[6] Still >
  Capture Setting > Review

On Nachdem die Bilder aufgenommen worden 
sind, werden die im AUX-Bus aufgenommenen 
Bilder des Videospeichers angezeigt (etwa 2 
Sekunden lang).

Off Die Rückschauanzeige erscheint nicht.

4 Das Standbild wird beim Drücken des OSD/TIME-Knopfes 
(Ausführen) im folgenden Menü gespeichert.

[6] Still >
  Capture
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USB-Speichergerät
Sie können die Videospeicherdaten und Einrichtungsdaten dieses Geräts als Projektdatei auf einem USB-Speichergerät 
speichern.
Außerdem können diese Daten von einem USB-Speichergerät in das Gerät geladen werden.
Sie können darüber auch die Software des Gerätes aktualisieren.

 p Es kann eine Weile dauern, um eine Standbilddatei mit hoher Bildqualität auf das USB-Speichergerät zu übertragen.

Videospeicher (Standbilddaten: Still1, Still2):
<Unterstützte Dateiformate>

Bitmap (bmp), JPEG (jpg), TARGA (tga), TIFF (tif), GIF (gif), PNG (png)

 p Dieses Gerät unterstützt unkomprimierte 24-Bit- bzw. unkomprimierte 32-Bit-TARGA-Dateien. 
Werden andere TARGA-Dateitypen in das Gerät geladen, so werden schwarze Bilder als Miniaturbilder angezeigt, und das 
Gerät kann die Dateien nicht erkennen.
 p Beachten Sie, dass das Speichern von Videospeicher-Standbildern auf der Speicherkarte im GIF-Format zu einer 
Verschlechterung der Bildqualität führt.

<Zutreffende Größen> 
HD/1080i: 1920×1080
HD/1080p: 1920×1080

HD/720p: 1280×720

 p Die Größe von Bildern wird automatisch angepasst, falls sie nicht mit einer der “zutreffenden Größen” übereinstimmt.
 p Bilder, die zu keiner “zutreffenden Größe” passen, werden zentriert, ohne die Größe selbst zu ändern. Bei zu großen 
Bildern werden also die Randbereiche abgeschnitten. Bei zu kleinen Bildern wird ein schwarzer Rand angezeigt.

Projektdateidaten (Projekt):
Der Begriff “Projektdateidaten” bezieht sich auf alle im Gerät gespeicherten Daten mit Ausnahme der folgenden Daten.
Projektdateien können gespeichert werden.

Datum, Uhrzeit, Netzwerkeinstellungen

Software-Aktualisierung (Update):
Die Software für die Aktualisierung wird geladen. 
Diese Software ist von “Service and Support” auf der Homepage mit der nachstehenden Adresse erhältlich:

 https://pro-av.panasonic.net/en/
Für das Update müssen Sie die mit der Download-Datei mitgelieferte Anleitung befolgen.

Logdatei (Log):
Im Gerät gespeicherte Logdateien können gesichert werden.

 q Informationen zu USB-Speichergeräten
USB-Speichergeräte, die mit diesem Gerät verwendet werden, müssen dem Standard USB 2.0 entsprechen.
Formatieren Sie USB-Speichergeräte unbedingt mit dem Gerät.
Verwenden Sie mit dem FAT- oder exFAT-Dateisystem formatierte Speicherkarten. 
(USB-Speichergeräte mit NTFS-Formatierung können nicht erkannt werden.)

Die folgenden USB-Speichergeräte wurden in Verbindung mit diesem Gerät getestet:
 p KIOXIA TransMemory U301 (32GB, 64GB, 128GB)
 p SanDisk Cruzer Glide CZ600 (32GB, 64GB, 128GB)

Um die neusten Informationen zu erhalten, die nicht in der Bedienungsanleitung enthalten sind, besuchen Sie die folgenden 
Websites.
https://pro-av.panasonic.net/en/

 p Speicherkarten dürfen nicht in Bereichen gelagert werden, in denen:
 • sie hohen Temperaturen und hoher Luftfeuchtigkeit ausgesetzt sind;
 • sie mit Wasser in Berührung kommen könnten; oder
 • in denen eine elektrische Ladung auf sie einwirkt.
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Die Daten werden in den folgenden Ordnern auf dem USB-Speichergerät gespeichert.
Wenn Daten geladen werden sollen, speichern Sie die Daten zuerst in den entsprechenden Ordnern, bevor Sie die Dateien 
laden.

<Datenordner-Konfiguration>
Datentyp Speichertyp Speicherungsordner Erweiterung

Projektdatei (Projekt) Project (*1) “HS\COMM\PROJECT” 001, 002, … (*3)

Videospeicher (Standbilddatei) Still1, Still2 (*2) “HS\COMM\IMAGE” bmp, tga, png, jpg(jpeg), tif(tiff), gif

Update-Datei – “HS\HSW10\UPDATE” 10d

Logdatei Log “HS\HSW10\LOG” log

Textdatei zum Einlesen (Seite 27) “HS\HSW10\TEXT” txt (*4)

*1  Die Projektdatei enthält Einrichtungsdaten, Shot-Speicher-Daten und Standbilddaten, die über folgenden Menüvorgang gewählt wurden:

[18] USB Memory >
  Save > Setup

[18] USB Memory >
  Save > Shot

[18] USB Memory >
  Save > Still

*2  Wenn die Standbilddaten mit angehängten Key-Signalen im Videospeicher gespeichert werden sollen, wählen Sie “tga” oder “png” als 
Dateiformat. 
Die Standbilddaten eines anderen Dateiformats können nicht mit angehängten Key-Signalen gespeichert werden.

*3  Das Speichern der Projektdatei erfolgt in einem Ordner, der als Dateiname Ordner im Ordner HS\COMM\PROJECT erstellt wird.   
Wenn die gespeicherte Projektdatei groß ist, wird die Datei geteilt und den einzelnen Dateien wird eine fortlaufende Nummerierung (001, 
002 usw.) angefügt.

*4  Mit [Load TEXT] können Sie eine Textdatei (Endung .txt) laden, die im Ordner “HS\HSW10\TEXT” auf einem mit diesem Gerät formatierten 
USB-Speichergerät liegt. Der Inhalt der Textdatei wird als Zeichenfolge übernommen. [Load TEXT] kann nur ausgewählt werden, wenn ein 
USB-Speichergerät angeschlossen ist.

Vorsichtsmaßnahmen bei der Handhabung von USB-Speichergeräten
 pWerfen Sie USB-Speichergeräte vor dem Trennen vom Gerät aus.  
Wird ein USB-Speichergerät ohne Auswerfen vom Gerät getrennt, kann die Übertragung angehalten werden oder auf dem 
USB-Speichergerät vorhandener Inhalt verloren gehen.

 p Die auf dem USB-Speichergerät gespeicherten Daten können verloren gehen, wenn das USB-Speichergerät 
beispielsweise verlegt wird oder fehlerhafte Operationen durchgeführt werden. Es wird daher empfohlen, wertvolle Daten 
auf einem Computer oder einem anderen Gerät zu speichern.

Hinweise zum Dateisystem exFAT
 p Der bei Verwendung von exFAT angezeigte Zeitstempel kann sich von der Zeitangabe auf einem Computer unterscheiden.  
Dieses Gerät nutzt die Zeitzone UTC. Bei einem Computer, an dem beispielsweise die japanische Zeitzone (UTC+9) 
eingestellt ist, differieren die Zeitangaben von Zeitstempel und Computer um 9 Stunden.



61

Grundlegende Bedienung

Formatieren von USB-Speichergeräten

Vor der Verwendung eines USB-Speichergeräts muss das 
USB-Speichergerät zuerst mit diesem Gerät formatiert 
werden. Beim Formatieren wird ein spezielles Verzeichnis 
auf dem USB-Speichergerät angelegt, nachdem es formatiert 
wurde. (Alle Dateien auf dem USB-Speichergerät werden 
gelöscht.)

1 Verbinden Sie das USB-Speichergerät mit dem USB-
Anschluss (Typ A) des Geräts.

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um die Formatierung zu starten.

[18] USB Memory >
 Format

Wenn kein USB-Speichergerät angeschlossen ist, ist der 
Menüpunkt ausgegraut.

 p Bestätigen Sie die Formatierung, indem Sie “YES” (JA) 
auswählen.
 pWählen Sie zum Abbrechen “NO” (NEIN) aus.

Formatieren Sie das USB-Speichergerät für die Verwendung 
mit diesem Gerät.

Speichern von Daten auf einem USB-
Speichergerät
1 Verbinden Sie ein mit diesem Gerät formatiertes USB-

Speichergerät mit dem USB-Anschluss (Typ A).

2 Wählen Sie die auf dem USB-Speichergerät zu 
speichernde Daten über den folgenden Menüvorgang:

[18] USB Memory >
 Save > Save Type

Beim Speichern von Standbildern:
Wählen Sie das Dateiformat für das Speichern von 
Standbildern über folgenden Menüvorgang:

[18] USB Memory >
 Save > File Format

Beim Speichern von Projektdateien:
Aktivieren Sie die Elemente, die als Teil der 
Projektdatei gespeichert werden sollen, über folgenden 
Menüvorgang:

[18] USB Memory >
 Save > Setup

[18] USB Memory >
 Save > Shot

[18] USB Memory >
 Save > Still

3 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um den Bildschirm zur Dateiauswahl 
anzuzeigen.

[18] USB Memory >
 Save > Save

 Angaben zu den Zielordnern, in denen die Daten 
gespeichert werden, finden Sie unter <Datenordner-
Konfiguration>.

 p Beachten Sie, dass das Speichern von Videospeicher-
Standbildern auf dem USB-Speichergerät im GIF-Format 
zu einer Verschlechterung der Bildqualität führt.

 p Für Dateinamen können alphanumerische Zeichen und 
Symbole verwendet werden.  
Dateien mit anderen Zeichen können auf diesem Gerät 
nicht angezeigt werden.
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Laden von Daten von einem USB-
Speichergerät

1 Verbinden Sie das USB-Speichergerät mit dem USB-
Anschluss (Typ A). 
Laden Sie die Datei, nachdem ihre Daten im jeweiligen 
Ordner gespeichert worden sind.  
Daten, die in anderen Ordnern gespeichert sind, werden 
nicht vom Gerät erkannt.
Angaben zu den Zielordnern, in denen die Daten 
gespeichert werden, finden Sie unter <Datenordner-
Konfiguration>.

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um den Bildschirm zur Dateiauswahl 
anzuzeigen.

[18] USB Memory >
 Load > Load

<Beispiel der Anzeige auf dem Dateiauswahl-Bildschirm>

3 Wählen Sie den zu ladenden Dateityp über folgenden 
Menüvorgang:

[18] USB Memory >
 Load > Load Type

4 Drehen Sie den OSD/TIME-Knopf, und markieren Sie den 
Namen der zu ladenden Datei.
Wenn der geladene Dateiname mehr als 11 Zeichen 
enthält, wird er eventuell verkürzt angezeigt. 
Falls der Name der zu ladenden Datei mehr als 
33 Zeichen umfasst, wird er im Dateiauswahlbildschirm 
nicht angezeigt.

 p Für Dateinamen können alphanumerische Zeichen und 
Symbole verwendet werden.  
Dateien mit anderen Zeichen können auf diesem Gerät 
nicht angezeigt werden.

5 Drücken Sie den OSD/TIME-Knopf, um die Datei zu laden.

Anzeigen von Informationen zum USB-
Speichergerät

1 Verbinden Sie das USB-Speichergerät mit dem USB-
Anschluss (Typ A).

2 Die folgenden Menüs sind verfügbar:

[18] USB Memory >
 Free

[18] USB Memory >
 Total

Free Der auf dem USB-Speichergerät verbleibende 
freie Speicherplatz wird angezeigt.

Total Die Kapazität der Speicherkarte wird angezeigt.
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Interner Speicher

Die Einrichtungsdaten dieses Geräts können als Projektdatei im internen Speicher gespeichert werden.
Es ist auch möglich, Einrichtungsdaten aus dem internen Speicher in das Gerät zu laden.

 p Es kann eine Weile dauern, um Standbilddateien mit hoher Bildqualität in den internen Speicher zu übertragen.
 p Die folgenden Daten können ausgewählt und als Projektdatei gespeichert oder geladen werden.
Einrichtungsdaten, Shot-Speicher-Daten, Standbild-Videospeicher

 p Datum, Uhrzeit und Netzwerkeinstellungen können nicht gespeichert werden.

Projektdatei-Verwaltungsbildschirm

Die folgenden Menüs sind verfügbar:

[14] Project

 p Über diesen Menübildschirm können Sie Projektdateien im 
internen Speicher speichern, von dort laden und löschen 
sowie umbenennen.  
Sie können auch Informationen über die zuletzt geladene 
Projektdatei anzeigen.

Projektdateien im internen Speicher 
speichern
1 Wählen Sie die zu speichernde Datei mit den folgenden 

Menüs:

[14] Project >
  Project File > Project 1

[14] Project >
  Project File > Project 2

[14] Project >
  Project File > Project 3

 p Sie können eine bereits gespeicherte Projektdatei 
überschreiben.
 p Schreibgeschützte Dateien (“Protect” ist “On”) können 
nicht überschrieben werden.

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
Posten “Save”, um die Projektdatei im internen Speicher 
abzulegen.

Projektdateien aus dem internen Speicher 
laden
1 Wählen Sie die zu ladende Datei mit den folgenden 

Menüs:

[14] Project >
  Project File > Project 1

[14] Project >
  Project File > Project 2

[14] Project >
  Project File > Project 3

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im Posten 
“Load”, um die Projektdatei aus dem internen Speicher zu 
laden.

3 Sie können die Zieldatei schützen, indem Sie den Posten 
“Protect” aktivieren.

 p Auf diese Weise geschützte Projektdateien können nicht 
überschrieben, gelöscht oder umbenannt werden.

Projektdateien aus dem internen Speicher 
löschen
1 Wählen Sie die zu löschende Datei mit den folgenden 

Menüs:

[14] Project >
  Project File > Project 1

[14] Project >
  Project File > Project 2

[14] Project >
  Project File > Project 3

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im Posten 
“Delete”, um die Projektdatei aus dem internen Speicher 
zu löschen.

 p Schreibgeschützte Dateien (“Protect” ist “On”) können 
nicht gelöscht werden.

3 Sie können die Zieldatei schützen, indem Sie den Posten 
“Protect” aktivieren.

 p Auf diese Weise geschützte Projektdateien können nicht 
überschrieben, gelöscht oder umbenannt werden.
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Projektdateien im internen Speicher 
umbenennen
1 Wählen Sie die umzubenennende Projektdatei mit den 

folgenden Menüs:

[14] Project >
  Project File > Project 1

[14] Project >
  Project File > Project 2

[14] Project >
  Project File > Project 3

2 Sie können den Namen der im internen Speicher 
abgelegten Projektdatei im Posten “Name” ändern.

 p Dateinamen können maximal 32 Zeichen lang sein.
<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3 Sie können die Zieldatei schützen, indem Sie den Posten 
“Protect” aktivieren.

 p Auf diese Weise geschützte Projektdateien können nicht 
überschrieben, gelöscht oder umbenannt werden.
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Eingangssignal-Einstellungen
Die folgenden Eingänge stehen zur Verfügung:

Logischer 
Name des 
Eingangs

Physischer Name 
des Eingangs Einschränkungen

IN1 SDI IN1/HDMI IN1 SDI/HDMI können nicht gleichzeitig verwendet werden; UC/
DC vereinfacht; mit Scaler

IN2 SDI IN2 UC/DC vereinfacht

IN3 SDI IN3 Mit UC/DC

IN4 SDI IN4 Mit UC/DC

IN5 HDMI IN2 Mit Scaler

IN6 LAN SRT/NDI|HX

IN7 LAN SRT/NDI|HX

IN8 LAN NDI, ausgestattet mit α-Kompatibilität, IN9 derzeit deaktiviert

IN9 LAN NDI

Bevor Sie die Eingangssignale einstellen, müssen Sie das einzustellende Eingangssignal in den folgenden Menüs auswählen:

[10] Input >
  IN1 > SDI/HDMI

[10] Input >
  INx > Streaming Mode



66

Ein-/Ausgangssignal-Einstellungen
<Liste der Einstellungen nach Eingangssignal>

Eingangsbuchse

Einstellmenü und Seite in dieser Bedienungsanleitung

Status FS Freeze Eingeschränkt Name Up-/Down-
Konverter C/C HDMI Status

P67 P68 P68 P69 P69 P69 P70 P72
SDI IN 1    –  –  –

SDI IN 2    –  –  –

SDI IN 3    –    –

SDI IN 4    –    –

HDMI IN 1 – –    –  

HDMI IN 2 – –    –  

IP IN1 – – – –  – – –

IP IN2 – – – –  – – –

IP IN3 – – – –  – – –

IP IN4 – – – –  – – –

Eingangsbuchse

Einstellmenü und Seite in dieser Bedienungsanleitung
HDMI-

Eingang Skalieren SRT Status SRT-Eingang NDI Status NDI-Eingang Kameraeinstellung

P71 P71 P73 P73 P75 P74 P102
SDI IN 1 – – – – – – 

SDI IN 2 – – – – – – 

SDI IN 3 – – – – – – 

SDI IN 4 – – – – – – 

HDMI IN 1   – – – – 

HDMI IN 2   – – – – 

IP IN1 – – *1 *1 *2 *2 

IP IN2 – – *1 *1 *2 *2 

IP IN3 – – – –   

IP IN4 – – – –   

: einstellbar
 —: nicht einstellbar

*1 Nur für SRT-Einstellungen
*2 Nur für NDI-/NDI|HX-Einstellungen
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Einstellungen für exklusive 
Eingangsanschlüsse

Sie können den exklusiven Eingang für die SDI-
Eingangsanschlüsse (SDI IN 1)/HDMI-Eingangsanschlüsse 
(HDMI IN 1) einstellen.

Legen Sie den Eingangssignaltyp über folgenden 
Menüvorgang fest:

[10] Input >
  IN1 > SDI/HDMI

SDI IN Stellt den SDI-Signaleingang für IN1 auf SDI 
IN 1 ein. Selbst wenn HDMI-Signale zugeführt 
werden, werden sie nicht dieser Einheit 
zugeführt.

HDMI IN Stellt den HDMI-Signaleingang für IN1 auf HDMI 
IN1 ein. Selbst wenn SDI-Signale zugeführt 
werden, werden sie nicht dieser Einheit 
zugeführt.

Überprüfen des Eingangssignal-Status

Sie können den Status der Eingangssignale überprüfen.

Für SDI-Eingangssignale

Die folgenden Menüs sind verfügbar:

[10] Input >
  INx > Status

Das Gerät ermittelt automatisch den Inhalt der 
Eingangssignale und zeigt die folgenden Informationen an.

Format Zeigt Informationen zum Bildformat des 
zugeführten SDI-Signals an.

Audio Zeigt Audioinformationen zum zugeführten SDI-
Signal an.

Für HDMI-Eingangssignale

Die folgenden Menüs sind verfügbar:

[10] Input >
  INx > Status

Das Gerät ermittelt automatisch den Inhalt der 
Eingangssignale und zeigt die folgenden Informationen an.

Size Zeigt die Auflösung des zugeführten HDMI-
Signals an.

Dot Clock Zeigt den Pixeltakt des zugeführten HDMI-
Signals an.

H-Frequency Zeigt die Horizontalfrequenz des zugeführten 
HDMI-Signals an.

V-Frequency Zeigt die Vertikalfrequenz des zugeführten 
HDMI-Signals an.

Für SRT-Eingangssignale

 Siehe “Anzeigen der SRT-Eingangssignalinformationen”.

Für NDI-Eingangssignale

 Siehe “Anzeigen der NDI-Eingangssignalinformationen”.
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Einstellen des Frame-Synchronizers

Der Frame-Synchronizer kann für jeden SDI-Eingang ein- 
oder ausgeschaltet werden.
Der Frame Synchronizer des HDMI-Eingang ist dauernd 
eingeschaltet. 
Er kann nicht von On auf Off oder umgekehrt eingestellt 
werden.

Stellen Sie den Frame-Synchronizer über folgenden 
Menüvorgang ein:

[10] Input >
 INx > FS Mode

Off Schaltet den Frame-Synchronizer aus. In diesem 
Fall ist die Zeilensynchronisierungsfunktion aktiv.
Die Zeilensynchronisierungsfunktion passt 
die Phasen der zugeführten Videosignale 
automatisch an die Phasen der horizontalen 
Synchronisierungssignale an.

Normal Aktiviert die Frame-Synchronizer-Funktion. 
Wenn ein vom Systemformat abweichendes 
Signal zugeführt wird, wird der Bildschirm 
schwarz.

Auto Aktiviert die Frame-Synchronizer-Funktion. Der 
Bildschirm wird auch dann nicht schwarz, wenn 
ein vom Systemformat abweichendes Signal 
zugeführt wird.
In diesem Fall kann es zu Störungen in der 
Videoausgabe kommen.

 pWird die Ausgangssignalphase auf [0H] eingestellt, kann 
“Off” nicht als Einstellung des Postens “FS” gewählt 
werden. 
Wenn der Menüpunkt FS auf “Off” eingestellt wird, 
wechselt diese Einstellung zu Normal.
 p Stellen Sie bei der Zuführung von 3G-SDI-Level-B-
Mapping-Signalen die Frame-Synchronizer-Einstellung 
auf “Auto”.

Einstellen des Verzögerungsbetrags

Die Eingangssignale können verzögert werden.
 p Diese Einstellung ist für Eingangssignale an SDI IN1 bis 4 
vorgesehen.

 p Sie wirkt sich nicht auf das integrierte Audio aus.

Set the delay amount with the following menu operation:

[10] Input >
 INx > FS Delay

Einfrieren der Eingangssignale

Die SDI-/HDMI-Eingangssignale können eingefroren und 
benutzt werden. 
Solange Signale eingefroren sind, werden die Tallysignale 
des entsprechenden Eingangs nicht ausgegeben.

Einstellen von Freeze

1 Wählen Sie das Verhalten von Freeze über folgenden 
Menüvorgang:

[10] Input >
  INx > Freeze Select

Frame Die Bilder werden im Vollbildmodus eingefroren.
Field Die Bilder werden im Halbbildmodus 

eingefroren.
Diese Option wird zum Einfrieren von 
Bewegtbildern verwendet.
Bei Interlace-Signalen erscheinen jedoch 
diagonale Linien und bewegte Teile gezackt.

 p “Frame” oder “Field” können auch gewählt werden, 
während ein Bild eingefroren ist.

2 Verwenden Sie folgenden Menüvorgang, um 
Eingangsbilder einzufrieren und freizugeben:

[10] Input >
  INx > Freeze

 p Bildsignale werden eingefroren, wenn Sie “Disable” in 
“Enable” ändern.

 p Bildsignale werden freigegeben, wenn Sie “Enable” in 
“Disable” ändern.  
Wenn Sie Signale, die für die Mehrfeldausgabe 
vorgesehen sind, einfrieren, wird vor dem Quellennamen 
das Zeichen “F” angezeigt.

 pWenn das Gerät mit deaktivierter Frame Synchronizer-
Funktion benutzt wird, können bei Ausführung der 
Einfrierfunktion Störungen in den Ausgangsbildern 
auftreten, die sich jedoch nicht negativ auf die 
Standbilder auswirken.

 p Falls “Enable” als Freeze-Einstellung eingestellt 
wird, wenn der Mischer bei ausgeschalteter Frame-
Synchronizer-Funktion benutzt wird, wird die Frame-
Synchronizer-Funktion automatisch eingeschaltet.
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Einschränkung

Sie können an diesem Gerät Einstellungen für den vollen 
bzw. eingeschränkten HDMI-Farbtonumfang der verbundenen 
Eingabegeräte, z. B. Kameras, vornehmen.

[10] Input >
 INx > Limited

Off Wählen Sie diese Einstellung, wenn der volle 
HDMI-Farbtonumfang zugeführt wird.

On Wählen Sie diese Einstellung, wenn der 
eingeschränkte HDMI-Farbtonumfang zugeführt 
wird.

 p Voller Umfang: HDMI-Eingang unterstützt RGB 0 bis 255
 p Eingeschränkter Umfang: HDMI-Eingang unterstützt 
RGB 16 bis 235; wird auch als Videoumfang bezeichnet

Einstellen der Materialnamen

Materialnamen können den Eingangssignalen zugewiesen 
werden.
Diese Namen können von den Standardeinstellungen oder 
Benutzereinstellungen ausgewählt werden.

Wählen Sie den Materialnamenstyp über folgenden 
Menüvorgang:

[10] Input > 
 INx > Name Type

Default
(Standard-
einstellungen)

Die folgenden Materialnamen werden 
automatisch ausgewählt:
IN1 bis 9

User
(Benutzer-
einstellungen)

Die Materialnamen können bis zu 
32 Zeichen lang sein.

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Einstellen des Aufwärtskonverters

Hier können Sie die Einstellungen für SDI IN3, SDI IN4 
auswählen (in die folgende optionale Einheit integriert):

1 Legen Sie die Empfindlichkeit der 
Bildbewegungserkennung über folgenden Menüvorgang 
fest:

[10] Input > 
 INx > Up/Down Converter > Move Detect

1 In Richtung Standbilder

3 Standard

5 In Richtung Bewegtbilder

2 Legen Sie den Schärfegrad der Bildkanten über folgenden 
Menüvorgang fest:

[10] Input > 
 INx > Up/Down Converter > Sharp

1 Keine scharfen Kanten

3 Standard

5 Sehr scharfe Kanten

Ein-/Ausgangssignal-Einstellungen
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Farbkorrektur

Nehmen Sie Einstellungen für die in SDI/HDMI integrierte 
Farbkorrektur vor.

Farbkorrektur-Einstellungen

Aktivieren (On) oder deaktivieren (Off) Sie die Farbkorrektur 
über folgenden Menüvorgang:

[10] Input > 
 INx > Color Correct > C/C

Bearbeitungssteuerung

1 Legen Sie die Verstärkung (Gain) des Y-Signals über 
folgenden Menüvorgang fest:

[10] Input > 
 INx > Color Correct > C/C Process > Y-Gain

2 Legen Sie den Schwarzwert über folgenden Menüvorgang 
fest:

[10] Input > 
 INx > Color Correct > C/C Process > Pedestal

3 Legen Sie die Verstärkung der Sättigung über folgenden 
Menüvorgang fest:

[10] Input > 
 INx > Color Correct > C/C Process > C-Gain

4 Legen Sie den Änderungsbetrag des Farbtons über 
folgenden Menüvorgang fest:

[10] Input > 
 INx > Color Correct > C/C Process > Hue
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Einstellen der HDMI-Eingangssignale

Nehmen Sie Einstellungen für HDMI-Eingangssignale vor.
Signale mit den folgenden Auflösungen können eingegeben werden.

<Kompatibilitätstabelle für HDMI-Eingangssignale>

HDMI-Eingangssignale
Systemformat

1080/ 
59.94p

1080/ 
50p

1080/ 
29.97p

1080/ 
25p

1080/ 
24p

1080/ 
23.98p

1080/ 
59.94i

1080/ 
50i

720/ 
59.94p

720/ 
50p

1080/59.94p 
(1920 x 1080)/ 
59,94 Hz, 60 Hz

 – – – – –  –  –

1080/50p 
(1920 x 1080)/50 Hz –  – – – – –  – 

1080/29.97p 
(1920 x 1080)/ 
29,97 Hz

– –  – – – – – – –

1080/25p 
(1920 x 1080)/25 Hz – – –  – – – – – –

1080/24p 
(1920 x 1080)/24 Hz – – – –  – – – – –

1080/23.98p 
(1920 x 1080)/ 
23,98 Hz

– – – – –  – – – –

1080/59.94i 
(1920 x 1080)/ 
59,94 Hz, 60 Hz

 –  – – –  –  –

1080/50i 
(1920 x 1080)/50 Hz –  –  – – –  – 

720/59.94p 
(1280 x 720)/59,94 Hz, 60 Hz  – – – – –  –  –

720/50p 
(1280 x 720)/50 Hz –  – – – – –  – 

WSXGA+ 
(1680 x 1200)/60 Hz          

SXGA 
(1280 x 1024)/60 Hz          

WXGA 
(1280 x 768)/60 Hz          

XGA 
(1024 x 768)/60 Hz          

: einstellbar
—: nicht einstellbar

 p Falls Signale mit anderen Auflösungen oder Frequenzen eingegeben werden, können die Signale nicht korrekt importiert 
werden.  
Die Bilder, die in einem solchen Fall ausgegeben werden, können schwarz oder gestört aussehen.

 p Diese Geräte sind nicht mit HDCP (High Bandwidth Digital Content Protection) kompatibel.

Wählen Sie den Skalierungsmodus über folgenden Menüvorgang:

[10] Input >
 INx > Scale

Fit-V Das Seitenverhältnis der Eingangsbilder wird beibehalten, und die Größe der Bilder wird 
entsprechend der vertikalen Auflösung vergrößert oder verkleinert.

Fit-H Das Seitenverhältnis der Eingangsbilder wird beibehalten, und die Größe der Bilder wird 
entsprechend der horizontalen Auflösung vergrößert oder verkleinert.

Full Die Größe der Eingangsbilder wird in Übereinstimmung mit der Systemauflösung vergrößert 
oder verkleinert.
(Das Seitenverhältnis der Eingangsbilder bleibt nicht unverändert. Die Rate, mit der die 
Bildgröße in vertikaler und horizontaler Richtung vergrößert oder verkleinert wird, ändert sich.)
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Anzeigen der HDMI-Eingangssignalinformationen

Diese Posten dienen der Anzeige der Informationen bezüglich der HDMI-Eingangssignalbilder. 
Die Information kann nicht geändert werden.

Die folgenden Menüs sind verfügbar:

[10] Input >
 INx > Status

Size Dies zeigt die Pixelzahl der Bilder an.
Dot Clock Dies zeigt die Punkttaktfrequenz der Bilder an.
H-Frequency Dies zeigt die horizontale Frequenz der Bilder an.
V-Frequency Dies zeigt die vertikale Frequenz der Bilder an.

Die unterstützten Formate sind unten aufgelistet.

<Unterstützte HDMI-Formate>

HDMI-Eingangssignal Punkttaktfrequenz 
(MHz)

Frequenz
Horizontal 

(kHz)
Vertikal 

(Hz)
XGA 1024×768 Digital 65,0 48,36 60,00

WXGA 1280×768 Digital 79,5 47,78 59,87

SXGA 1280×1024 Digital 108,0 63,98 60,02

WSXGA+ 1680×1050 Digital 146,2 65,29 59,95

720/59.94p 1280×720 Digital 74,25/1,001 44,96 60,00/1,001

720/50p 1280×720 Digital 74,25 37,50 50,00

1080/59.94i 1920×1080 Digital 74,25/1,001 33,72 60,00/1,001

1080/50i 1920×1080 Digital 74,25 28,13 50,00

1080/23.98p 1920×1080 Digital 74,2 27,0 24,00/1,001

1080/24p 1920×1080 Digital 74,2 27,0 24,00

1080/25p 1920×1080 Digital 74,2 28,1 25,00

1080/29.97p 1920×1080 Digital 74,2 33,7 30,00

1080/59.94p 1920×1080 Digital 148,5/1,001 67,50/1,001 60,00/1,001

1080/50p 1920×1080 Digital 148,5 56,25 50,00

 p Falls das Format der Eingangssignale nicht unterstützt wird, ist es eventuell nicht möglich, die Signale korrekt zu importieren, 
und ein schwarzes oder gestörtes Bild kann erscheinen.
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SRT-Eingangssignal-Einstellungen

Dieses Gerät kann maximal 2 SRT-Signale eingeben.

Die SRT-Einstellungen für Eingänge, an denen SRT 
unterstützt wird, werden unter “Eingangssignal-Einstellungen” 
beschrieben.
Bevor Sie die SRT-Eingangssignale einstellen, müssen 
Sie das einzustellende Eingangssignal im folgenden Menü 
auswählen:

[10] Input > 
 INx > Streaming Mode

1 Legen Sie den Verbindungsmodus über folgenden 
Menüvorgang fest:

[10] Input >
 INx > Mode

Caller Diese Einstellung wird benötigt, wenn Sie 
die Server-URL und die Portnummer der 
Übertragungsquelle angeben, um den 
Übertragungsbeginn von diesem Gerät 
anzufordern.

Listener Diese Einstellung wird benötigt, wenn Sie 
den Bereitschaftsport für extern gestartete 
Übertragungen angeben.

2 Legen Sie die Server-URL und die Portnummer der 
Übertragungsquelle über folgenden Menüvorgang fest (nur 
für Caller):

[10] Input >
 INx > Server URL

[10] Input >
 INx > Server Port

3 Legen Sie die Bereitschafts-Portnummer dieses Geräts 
über folgenden Menüvorgang fest (nur für Listener):

[10] Input >
 INx > Port

 p Eine Meldung wird angezeigt, wenn Sie einen nicht 
verfügbaren Port auswählen.

4 Richten Sie die Stream-ID über folgenden Menüvorgang 
ein:

[10] Input >
 INx > Stream ID

5 Legen Sie den Verschlüsselungsmodus für übertragene 
Bilder über folgenden Menüvorgang fest:

[10] Input >
 INx > Encryption

Disable Empfangene Bilder werden nicht decodiert. 
Unverschlüsselte Bilder können verarbeitet 
werden.

Enable Empfangene Bilder werden decodiert.

6 Geben Sie die Phrase zum Decodieren der empfangenen 
Bilder über folgenden Menüvorgang an:

[10] Input >
 INx > Passphrase

Anzeigen der SRT-
Eingangssignalinformationen

Sie können den Status des SRT-Signals überprüfen, das von 
dieser Einheit empfangen wird.
Die folgenden Menüs sind verfügbar:

[10] Input > 
 INx > Status

Diese Einheit ermittelt automatisch den Inhalt des SRT-
Eingangssignals und zeigt die folgenden Informationen an.

Format Zeigt Informationen zum Bildformat des 
zugeführten SRT-Signals an.

Sampling 
Rate

Zeigt Informationen zur Sampling-Rate des 
zugeführten SRT-Signals an.

Audio 
Channel

Zeigt Surround-Informationen des zugeführten 
SRT-Signals an.

Compress Zeigt Informationen zum Komprimierungsformat 
des zugeführten SRT-Signals an.

Einstellen von Materialnamen (SRT-
Eingangssignal)

Materialnamen können den Eingangssignalen zugewiesen 
werden.
Diese Namen können von den Standardeinstellungen oder 
Benutzereinstellungen ausgewählt werden.

Wählen Sie den Materialnamenstyp über folgenden 
Menüvorgang:

[10] Input >
 INx > Name Type

Default
(Standard-
einstellungen)

Wählen Sie die Materialnamen aus den 
folgenden Optionen aus: 
IN1 bis 9

User
(Benutzer-
einstellungen)

Die Materialnamen können bis zu 
32 Zeichen lang sein.

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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NDI/NDI|HX

Dieses Gerät kann 2 HB-Signale und 2 HX-Signale, 
insgesamt also maximal 4 NDI/NDI|HX-Signale eingeben.

NDI|HX

Das Gerät unterstützt sowohl NDI|HX-Version 1 als auch 
NDI|HX-Version 2.
Beide Formate (NDI|HX Version 1 und NDI|HX Version 2) 
unterstützen den Standard H.264 zur Bildkomprimierung. 
NDI|HX-Version 2 unterstützt zusätzlich noch H.265.

NDI-Eingangssignal-Einstellungen

Die NDI-Einstellungen für Eingänge, an denen NDI 
unterstützt wird, werden unter “Eingangssignal-Einstellungen” 
beschrieben.
Bevor Sie die NDI-Eingangssignale einstellen, müssen 
Sie das einzustellende Eingangssignal im folgenden Menü 
auswählen:

[10] Input >
 INx > Streaming Mode

1 Wählen Sie den Modus für die Suche nach NDI-
Eingangssignalen im Netzwerk über den folgenden 
Menüvorgang:

[10] Input >
 INx > Scan Mode

HB/HX v2 Sucht nach Eingangsquellen in den Formaten 
NDI oder NDI|HX Version 2

HX v1 Sucht nach Eingangsquellen im Format NDI|HX 
Version 1

2 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um nach Geräten zu suchen:

[10] Input >
 INx > Scan

 p Die Suchergebnisse werden als Liste in der Form 
MASCHINENNAME(QUELLENNAME) angezeigt.
 p Die Suche nach Maschinen im Netzwerk kann eine 
Weile dauern.

3 Wählen Sie die Gerätekombination, die als Eingangsquelle 
und NDI-Bildquelle genutzt werden soll, und bestätigen Sie 
die Wahl mit dem OSD/TIME-Knopf.

 p Mit “None” (Keine) heben Sie die Auswahl auf.

Einstellungen für das Empfangsprotokoll

Sie können das Protokoll für die Kommunikation mit dem 
NDI-Sender festlegen.

1 Legen Sie das Protokoll für den NDI-Sender über 
folgenden Menüvorgang fest:

[10] Input >
 INx > Protocol

TCP TCP wird als Protokoll für den NDI-Sender 
verwendet. (Vorgabe) 
Die Kommunikation über sTCP ist möglich.

UDP UDP wird als Protokoll für den NDI-Sender 
verwendet. 
Die Kommunikation über UDP und sTCP ist 
möglich.

 p Das zu bevorzugende Protokoll wird durch 
Verhandlungen mit den Protokolleinstellungen auf der 
NDI-Sender-Seite ausgewählt.

 p sTCP (Single-TCP): Eine verbindungsorientierte 
Kommunikationsmethode, die akkurate 
Lieferung von Daten garantiert, aber die 
Kommunikationsgeschwindigkeit ist langsamer im 
Vergleich zu UDP.

 p UDP: Eine verbindungsfreie Kommunikationsmethode, 
die Datenübertragung mit hoher Geschwindigkeit 
ermöglicht, aber die Verlässlichkeit der Daten ist 
geringer als bei TCP.

 p Es ist notwendig, das Protokoll auf UDP festzulegen, 
wenn Multicast-Übertragungen durchgeführt werden.

Hinweise
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Anzeigen der NDI-
Eingangssignalinformationen

Sie können den Status des NDI-Signals überprüfen, das von 
dieser Einheit empfangen wird.
Die folgenden Menüs sind verfügbar:

[10] Input >
 INx > Status

Diese Einheit ermittelt automatisch den Inhalt des NDI-
Eingangssignals und zeigt die folgenden Informationen an.

Format Zeigt Informationen zum Bildformat des 
zugeführten NDI-Signals an.

Sampling 
Rate

Zeigt Informationen zur Sampling-Rate des 
zugeführten NDI-Signals an.

Audio 
Channel

Zeigt Surround-Informationen des zugeführten 
NDI-Signals an.

Frame Data Zeigt Farb-Informationen des zugeführten NDI-
Signals an.

Compress Zeigt Informationen zum Komprimierungsformat 
des zugeführten NDI-Signals an.

Streaming 
Mode

Zeigt Informationen zum Format des 
zugeführten NDI-Signals an.

Einstellen von Materialnamen (NDI-
Eingangssignal)

Materialnamen können den Eingangssignalen zugewiesen 
werden.
Diese Namen können von den Standardeinstellungen oder 
Benutzereinstellungen ausgewählt werden.

Wählen Sie den Materialnamenstyp über folgenden 
Menüvorgang:

[10] Input >
 INx > Name Type

Default
(Standard-
einstellungen)

Die folgenden Materialnamen werden 
automatisch ausgewählt:
IN1 bis 9

User
(Benutzer-
einstellungen)

Die Materialnamen können bis zu 
32 Zeichen lang sein.

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Eingangseinstellungen für Material mit 
α-Kanal

Dieses Gerät kann normale NDI-Signale sowie Signale mit 
α-Kanal eingeben und für die Materialnutzung dazwischen 
umschalten.
Sie können maximal 1 Satz NDI-Signale mit α-Kanal 
zuführen, wobei die in der folgenden Tabelle aufgeführten 
Einstellungen durch Umschalten des Eingabemodus möglich 
sind:

α-Kanaleinstellungen
Deaktiviert Aktiviert

IN8 Fill Fill
IN9 Fill Key

Aktivieren oder deaktivieren Sie den α-Kanal über folgenden 
Menüvorgang:

[10] Input >
 INx > Alpha Setting > Use alpha

Einrichten von Gruppen

Sie können NDI-Sender und -Empfänger in Gruppen 
unterteilen und später die Suche nach Maschinen auf eine 
Gruppe beschränken.
Trennen Sie mehrere Gruppen mit Kommata voneinander.
Diese Funktion steht für die NDI|HX-Version 1 nicht zur 
Verfügung.

1 Aktivieren oder deaktivieren Sie die Gruppensuche über 
folgenden Menüvorgang:

[10] Input >
 INx > Group > Group

Enable Die Gruppensuche ist aktiviert.
Disable Die Gruppensuche ist deaktiviert. (Vorgabe)

2 Geben Sie den Gruppennamen über folgenden 
Menüvorgang ein:

[10] Input >
 INx > Group > Group Name

 p Sie können bis zu 64 Zeichen eingeben.
<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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Einstellungen für den Erkennungsserver

Sie können die Funktion für die automatische Suche von NDI-
Quellen so einstellen, dass gefundene Quellen auf einem 
externen Server erfasst werden.
Diese Einstellung ist nützlich, wenn es sehr viele NDI-Quellen 
im Netzwerk gibt, und sie den Traffic möglichst nicht erhöhen 
möchten, oder wenn eine Multicast-Übertragung nicht 
möglich oder nicht wünschenswert ist.

1 Legen Sie fest über folgenden Menüvorgang fest, ob ein 
externer Server eingerichtet werden soll:

[10] Input >
 INx > Use Discovery server > 

Use Discovery server

Enable Einstellungen für externen Server sind aktiviert
Disable Einstellungen für externen Server sind 

deaktiviert (Vorgabe)

2 Geben Sie die IP-Adresse des externen Servers über 
folgenden Menüvorgang an:

[10] Input >
 INx > Use Discovery server >

Discovery server IP

Einstellungen für den RTSP-Port

Sie können Port und Anfrage-URL dieses Geräts passend zu 
den RTSP-Porteinstellungen der zu verbindenden Kamera 
einstellen.
Diese Funktion wird für die NDI|HX-Version 1 verwendet.

1 Legen Sie die RTSP-Portnummer, die zu den 
Kameraeinstellungen passt, über folgenden Menüvorgang 
fest:

[10] Input >
 INx > RTSP > Port

 p Die Ports 10668, 10669 und 10670 können nicht 
verwendet werden

2 Legen Sie die Anfrage-URL, die zu den 
Kameraeinstellungen passt, über folgenden Menüvorgang 
fest:

[10] Input >
 INx > RTSP > Request URL

 p Sie können bis zu 255 Zeichen eingeben.
<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3 Nachdem Sie Port und Anfrage-URL eingegeben haben, 
drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um die Änderungen zu übernehmen:

[10] Input >
 INx > RTSP > Connect

Eingangssignal-Einstellungen für 
Analogaudio

Analogaudio kann über zwei Eingangskanäle (linker und 
rechter Kanal) dieses Geräts zugeführt werden.

1 Aktivieren Sie die Analogaudioeingabe über folgenden 
Menüvorgang:

[15] Ancillary/Audio >
 Analog IN > Audio

Off Die Eingabe von Analogaudio ist deaktiviert.
On Die Eingabe von Analogaudio ist aktiviert.

2 Legen Sie den Pegel für die Analogaudioeingabe über 
folgenden Menüvorgang fest:

[15] Ancillary/Audio >
 Analog IN > Input Type

LINE Legen Sie den Line-Eingangspegel fest.
MIC Legen Sie den Mikrofon-Eingangspegel fest.

3 Legen Sie die Verstärkung über folgenden Menüvorgang 
fest:

[15] Ancillary/Audio >
 Analog IN > Gain

 p Sie können Werte zwischen –36 und 12 dB angeben.
4 Legen Sie den Verzögerungsbetrag über folgenden 

Menüvorgang fest:

[15] Ancillary/Audio >
 Analog IN > Delay (ms)

 p Sie können Werte zwischen 0 und 512 ms angeben.
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Ausgangssignal-Einstellungen
Die folgenden Ausgänge stehen zur Verfügung:

<Ausgang (gemeinsam)>
Logischer Name des 

Ausgangs
Physischer Name des 

Ausgangs Einschränkungen

OUT1 SDI OUT1

OUT2 SDI OUT2

OUT3 HDMI OUT

OUT4 LAN SRT/RTMP/NDI

OUT5 LAN SRT/RTMP/NDI

OUT6 USB STREAM OUT Feste UVC-Zuweisung

Bevor Sie sich anschicken, die Ausgangssignale einzustellen, wählen Sie zunächst die einzustellenden Ausgangssignale im 
Untermenü “Output” aus.

[11] Output > 
 OUT4 > Streaming Mode

[11] Output > 
 OUT5 > Streaming Mode

<Liste der Einstellungen nach Ausgangssignal>

Ausgangsbuchse

Einstellmenü und Seite in dieser Bedienungsanleitung

Assign SDI-
Ausgang

HDMI-
Ausgang

Down-
Konverter Skalieren SRT-

Ausgang
NDI-

Ausgang
RTMP-

Ausgang
UVC-

Ausgang
P78 – P78 – P78 P79 P80 P82 P82

SDI OUT 1   – – – – – – –

SDI OUT 2   – – – – – – –

HDMI OUT  –  –  – – – –

IP(OUT4)  – – – –    –

IP(OUT5)  – – – –    –

UVC OUT  – – – – – – – 

: einstellbar
 —: nicht einstellbar
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Zuweisen der Ausgangssignale

Weisen Sie den einzelnen Ausgängen die jeweiligen 
Ausgangssignale zu.

Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output >
 OUTx > Assign

PGM Ein mit dem Effekt “Wipe”, “Mix”, “Key”, 
“Downstream Key” oder einem anderen Effekt 
versehenes Bild wird am Hauptleitungsausgang 
des Bildmischpults ausgegeben.

PVW Dies ist der Vorschau-Ausgang, der eine 
Überprüfung der nächsten Operation ermöglicht, 
bevor sie ausgeführt wird.

CLN Das Reinsignal (das Bild, das resultiert, wenn 
der Effekt “Key”, “Downstream Key” oder ein 
anderer Effekt vom PGM-Signal entfernt worden 
ist) wird ausgegeben.

AUX1, AUX2 Die von den 2 Leitungen der AUX-Busse (AUX1, 
AUX2) gewählten Signale werden ausgegeben.

MV Die Mehrfeldanzeigesignale werden 
ausgegeben. 
Mehrere Ein- und Ausgangssignale werden 
verkleinert und zu einem Bildschirm 
ausgegeben.

KeyOut Das Key-Signal wird ausgegeben.

Einstellen der HDMI-Ausgangssignale

Nehmen Sie Einstellungen für HDMI-Ausgangssignale vor.

1 Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output >
 OUT3 > Assign

 Siehe “Zuweisen der Ausgangssignale”.
2 Wählen Sie die Auflösung des auszugebenden Videos 

über folgenden Menüvorgang:

[11] Output >
 OUT3 > Size

Auto Die Gerätedaten des Ausgabeziels werden 
von den HDMI-Signalen erfasst, und die 
Bilder werden mit der optimalen Auflösung 
ausgegeben.

XGA (1024 × 768) / 60 Hz
WXGA (1280 × 768) / 60 Hz
SXGA (1280 × 1024) / 60 Hz
WXGA+ (1680 × 1050) / 60 Hz
Native Die Ausgabe erfolgt im Systemformat.

3 Legen Sie den Ausgabefarbraum über folgenden 
Menüvorgang fest:

[11] Output >
 OUT3 > color

Auto Über das HDMI-Signal werden 
Geräteinformationen zum Verbindungsziel 
abgerufen, und die Ausgabe erfolgt mit dem 
entsprechenden optimalen Farbraum.

RGB Der Farbraum wird mit dem RGB-Format 
eingestellt.

YUV444 Der Farbraum wird mit Y, Cb, Cr bei 4:4:4 
eingestellt. (Bei dieser Methode werden 
für jeweils 4 horizontale Pixel jeweils 4 
Pixel der Luminanzkomponente und 2 
Farbdifferenzkomponenten verwendet)

YUV422 Der Farbraum wird mit Y, Cb, Cr bei 4:2:2 
eingestellt. 
(Bei dieser Methode wird für jeweils 
2 horizontale Pixel jeweils 1 Pixel der 
Farbdifferenzkomponenten und jedes Pixel der 
Luminanzkomponente abgetastet)

4 Wählen Sie den Skalierungsmodus über folgenden 
Menüvorgang:

[11] Output >
 OUT3 > Scale

Fit-V Das Seitenverhältnis der Ausgangsbilder 
wird beibehalten, und die Größe der Bilder 
wird entsprechend der vertikalen Auflösung 
vergrößert oder verkleinert. 
(Schwarze Streifen werden in die Bereiche 
eingefügt, die keine Bilder enthalten. Die 
überstehenden Teile der Bilder werden 
abgeschnitten.)

Fit-H Das Seitenverhältnis der Ausgangsbilder wird 
beibehalten, und die Größe der Bilder wird 
entsprechend der horizontalen Auflösung 
vergrößert oder verkleinert.
(Schwarze Streifen werden in die Bereiche 
eingefügt, die keine Bilder enthalten. Die 
überstehenden Teile der Bilder werden 
abgeschnitten.)

Full Die Größe der Ausgangsbilder wird 
entsprechend der Systemauflösung vergrößert 
oder verkleinert.

Full80% Die Größe des ausgegebenen Bilds 
wird entsprechend der 80%-Größe der 
Systemauflösung vergrößert oder verkleinert.

Full90% Die Größe des ausgegebenen Bilds 
wird entsprechend der 90%-Größe der 
Systemauflösung vergrößert oder verkleinert.

 p Das Seitenverhältnis wird nicht auf der Einstellung “Full”, 
“Full80%” oder “Full90%” beibehalten. 
Die Rate, mit der die Bildgröße in vertikaler und 
horizontaler Richtung vergrößert oder verkleinert wird, 
ändert sich.

5 Legen Sie die Empfindlichkeit der 
Bildbewegungserkennung über folgenden Menüvorgang 
fest:

[11] Output >
 OUT3 > Move Detect

1 In Richtung Standbilder

3 Standard

5 In Richtung Bewegtbilder
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Einstellen der SRT-Ausgangssignale

Dieses Gerät kann maximal 2 SRT-Signale ausgeben.

Sie können SRT-Ausgangssignale zuweisen.

1 Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output >
 OUTx > Assign

 Siehe “Zuweisen der Ausgangssignale”.
2 Legen Sie den Verbindungsmodus über folgenden 

Menüvorgang fest:

[11] Output >
 OUTx > Mode

Caller Diese Einstellung wird benötigt, wenn 
Sie die Server-URL und die Portnummer 
des Übertragungsziels angeben, um den 
Übertragungsbeginn von diesem Gerät 
anzufordern.

Listener Diese Einstellung wird benötigt, wenn Sie 
den Bereitschaftsport für extern gestartete 
Übertragungen angeben.

3 Legen Sie URL, Port und Stream-ID über folgenden 
Menüvorgang fest (nur für Caller):

[11] Output >
 OUTx > Destination URL

[11] Output >
 OUTx > Destination Port

[11] Output >
 OUTx > Stream ID

Destination URL URL des verbundenen Servers
Destination Port Port des verbundenen Servers
Stream ID Stream-ID des verbundenen Servers

 p Die DNS-Einstellungen werden benötigt, um den 
Domainnamen des verbundenen Servers aufzulösen.

<Für Dateinamen verwendbare Zeichen>

A bis Z, a bis z, 0 bis 9

4 Legen Sie den Bereitschaftsport über folgenden 
Menüvorgang fest (nur für Listener):

[11] Output >
 OUTx > Port

 p Eine Meldung wird angezeigt, wenn Sie einen nicht 
verfügbaren Port auswählen.

5 Legen Sie die TTL/HOP-Obergrenze über folgenden 
Menüvorgang fest:

[11] Output >
 OUTx > TTL/HOP limit

6 Legen Sie die Verzögerung zwischen dem Senden der 
Bilder und der Wiedergabe auf dem Empfangsgerät über 
folgenden Menüvorgang fest:

[11] Output >
 OUTx > Latency(ms)

 p Die gewünschte Dauer kann abhängig von der 
Netzwerkbandbreite möglicherweise nicht garantiert 
werden.

7 Legen Sie den Verschlüsselungsmodus für zu 
übertragende Bilder über folgenden Menüvorgang fest:

[11] Output >
 OUTx > Encryption

Disable Bilder werden unverschlüsselt übertragen.
AES128 Bilder werden mit AES-128-Verschlüsselung 

übertragen.
AES256 Bilder werden mit AES-256-Verschlüsselung 

übertragen.

8 Geben Sie die Phrase zum Decodieren der 
verschlüsselten Bilder über folgenden Menüvorgang an:

[11] Output >
 OUTx > Passphrase

9 Wählen Sie eines der Bildformate “H.264” und “H.265” 
über folgenden Menüvorgang:

[11] Output >
 OUTx > Codec

:  Legen Sie den Bitraten-Kontrollmodus für das Bildformat 
über folgenden Menüvorgang fest:

[11] Output >
 OUTx > Rate Control Mode

CBR Die Übertragung erfolgt mit der eingestellten 
Soll-Bitrate (Target Bit Rate).

VBR Die “Max bit rate” ist die höchste zulässige 
Bitrate. Es wird versucht, Übertragungen 
annähernd mit der eingestellten Soll-Bitrate 
durchzuführen.
Die tatsächliche Bitrate ist vom übertragenen 
Video abhängig.

;  Legen Sie die Soll-Bitrate für die Übertragung über 
folgenden Menüvorgang fest:

[11] Output >
 OUTx > Target bit rate

<  Legen Sie die maximale Bitrate für die Übertragung über 
folgenden Menüvorgang fest (nur für VBR):

[11] Output >
 OUTx > Max bit rate



80

Ein-/Ausgangssignal-Einstellungen

Einstellen der NDI-Ausgangssignale

Dieses Gerät kann maximal 2 NDI-Signale ausgeben.
Es können keine NDI|HX-Signale ausgegeben werden.

Für NDI-Signale stehen dauerhaft eine Ausgabe mit hoher 
und eine Ausgabe mit niedriger Bandbreite pro NDI-Ausgang 
zur Verfügung.

NDI|HX

Diese Einheit kann nur NDI-Signale ausgeben. Die Ausgabe 
von NDI|HX-Signalen in Version 1/2 ist nicht möglich.

Zuweisen der NDI-Ausgangssignale

Sie können NDI-Ausgangssignale zuweisen.

Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output >  
 OUTx > Assign

 Siehe “Zuweisen der Ausgangssignale”.

Gemeinsame NDI-Ausgangssignal-
Einstellungen

Sie können mit dieser Einheit die Parameter Machine Name 
und Source Name festlegen, die bei der Suche mit einem 
NDI-Empfänger angezeigt werden.

1 Legen Sie den für den NDI-Empfänger anzuzeigenden 
Namen über folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Machine Name

 p Sie können bis zu 20 Zeichen eingeben.
2 Legen Sie den für den NDI-Empfänger anzuzeigenden 

Namen über folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Source Name

 p Sie können bis zu 32 Zeichen eingeben.
<Für Dateinamen verwendbare Zeichen>

A bis Z, a bis z, 0 bis 9, Leerzeichen, -, _

NDI-Übertragungsprotokoll-Einstellungen

Sie können das Protokoll für die Kommunikation mit dem 
NDI-Empfänger festlegen.

1 Legen Sie das Protokoll für den NDI-Empfänger über 
folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Protocol

TCP Für die Kommunikation mit dem NDI-Empfänger 
wird TCP verwendet. (Vorgabe)
Die Kommunikation über sTCP ist möglich.

UDP Für die Kommunikation mit dem NDI-Empfänger 
wird UDP verwendet.
Die Kommunikation über UDP und sTCP ist 
möglich.

 p Das zu bevorzugende Protokoll wird durch 
Verhandlungen mit den Protokolleinstellungen auf der 
NDI-Sender-Seite ausgewählt.

 p sTCP (Single-TCP): Eine verbindungsorientierte 
Kommunikationsmethode, die akkurate 
Lieferung von Daten garantiert, aber die 
Kommunikationsgeschwindigkeit ist langsamer im 
Vergleich zu UDP.

 p UDP: Eine verbindungsfreie Kommunikationsmethode, 
die Datenübertragung mit hoher Geschwindigkeit 
ermöglicht, aber die Verlässlichkeit der Daten ist 
geringer als bei TCP.

 p Es ist notwendig, das Protokoll auf UDP festzulegen, 
wenn Multicast-Übertragungen durchgeführt werden.

Hinweise



81

Ein-/Ausgangssignal-Einstellungen

NDI-Multicast-Einstellungen

Sie können die Multicast-Übertragung für den NDI-Empfänger 
aktivieren oder deaktivieren.
Wenn Multicast-Übertragungen aktiviert sind, werden dafür 
die Einstellungen für IP-Adresse, Subnetzmaske und TTL/
HOP-Limit übernommen.
Sie können mit dieser Einheit Multicast-Übertragungen im 
selben Subnetz vornehmen.

1 Aktivieren oder deaktivieren Sie Multicast-Übertragungen 
über folgenden Menüvorgang:

[11] Output >  
 OUTx > Multicast > Multicast

Enable Die Multicast-Übertragung zum NDI-Empfänger 
ist aktiviert.

Disable Die Multicast-Übertragung zum NDI-Empfänger 
ist deaktiviert. (Vorgabe)

2 Legen Sie IP-Adresse. Subnetzmaske und TTL über 
folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Multicast > IP Address

[11] Output > 
 OUTx > Multicast > Subnet Mask

[11] Output > 
 OUTx > Multicast > TTL/HOP Limit

Einstellen von NDI-Gruppen

Sie können NDI-Sender und -Empfänger in Gruppen 
unterteilen und später die Suche nach Maschinen auf eine 
Gruppe beschränken.
Trennen Sie mehrere Gruppen mit Kommata voneinander.

1 Aktivieren oder deaktivieren Sie die Gruppensuche über 
folgenden Menüvorgang:

[11] Output > 
 OUTx > Group > Group

Enable Die Gruppensuche ist aktiviert.
Disable Die Gruppensuche ist deaktiviert. (Vorgabe)

2 Geben Sie den Gruppennamen über folgenden 
Menüvorgang ein:

[11] Output > 
 OUTx > Group > Group Name

 p Sie können bis zu 64 Zeichen eingeben.
<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

NDI-Discovery-Server-Einstellungen

Sie können die Funktion für die automatische Suche von NDI-
Quellen so einstellen, dass gefundene Quellen auf einem 
externen Server erfasst werden.
Diese Einstellung ist nützlich, wenn es sehr viele NDI-Quellen 
im Netzwerk gibt, und sie den Traffic möglichst nicht erhöhen 
möchten, oder wenn eine Multicast-Übertragung nicht 
möglich oder nicht wünschenswert ist.

1 Aktivieren oder deaktivieren Sie die Einstellungen für 
externe Server über folgenden Menüvorgang:

[11] Output > 
 OUTx > Use Discovery server > 

Use Discovery server

Enable Einstellungen für externen Server sind aktiviert
Disable Einstellungen für externen Server sind 

deaktiviert (Vorgabe)

2 Geben Sie die IP-Adresse für Einstellungen für externe 
Server über folgenden Menüvorgang an:

[11] Output > 
 OUTx > Use Discovery server > 

Discovery server IP
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Ein-/Ausgangssignal-Einstellungen

Einstellen der RTMP-Ausgangssignale

Dieses Gerät kann maximal 2 RTMP-Signale ausgeben.

Sie können RTMP-Ausgangssignale zuweisen.

1 Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output > 
 OUTx > Assign

 Siehe “Zuweisen der Ausgangssignale”.
2 Geben Sie URL und Stream-Key des Servers über 

folgenden Menüvorgang an:

[11] Output > 
 OUTx > Server URL

[11] Output > 
 OUTx > Stream Key

Server URL URL des verbundenen Servers
Stream Key Stream-Key des verbundenen Servers

 p Die DNS-Einstellungen werden benötigt, um den 
Domainnamen des verbundenen Servers aufzulösen.

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3 Legen Sie den Bitraten-Kontrollmodus für das Bildformat 
über folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Rate Control Mode

CBR Die Übertragung erfolgt mit der eingestellten 
Soll-Bitrate (Target Bit Rate).

VBR Die “Max bit rate” ist die höchste zulässige 
Bitrate. Es wird versucht, Übertragungen 
annähernd mit der eingestellten Soll-Bitrate 
durchzuführen.
Die tatsächliche Bitrate ist vom übertragenen 
Video abhängig.

4 Legen Sie die Soll-Bitrate für die Übertragung über 
folgenden Menüvorgang fest:

[11] Output > 
 OUTx > Target bit rate

5 Legen Sie die maximale Bitrate für die Übertragung über 
folgenden Menüvorgang fest (nur für VBR):

[11] Output > 
 OUTx > Max bit rate

Einstellen der UVC-Ausgangssignale

Das Gerät unterstützt sowohl UVC (USB Video Class) als 
auch UAC (USB Audio Class).
Wenn Sie den USB-Anschluss (Typ C) mit einem Computer 
verbinden, kann das Gerät als Webcam eingesetzt werden.

Sie können UVC-Ausgangssignale zuweisen.

Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[11] Output > 
 OUTx > Assign

 Siehe “Zuweisen der Ausgangssignale”.

Wenn das Ausgabeformat durch Änderungen an den 
Systemformateinstellungen geändert wird, müssen Sie die 
App neu starten, die auf dem Computer die UVC-Bilder 
empfängt.

Hinweis
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Ausgangseinstellungen für Analogaudio

Dieses Gerät besitzt eine Kopfhörerbuchse [  ] (Φ3,5-mm-
Stereo-Miniklinke).

Weisen Sie analoge Ausgangssignale zu.

1 Legen Sie den Ausgangssignaltyp über folgenden 
Menüvorgang fest:

[15] Ancillary/Audio >
 Analog OUT > Assign

PGM Die Audiodaten der ausgewählten Quelle 
werden ausgegeben.

PVW
AUX1, 2
CLN

2 Passen Sie die Lautstärke mit dem Monitoring-
Lautstärkeregler an.  
Die Werte können im folgenden Menü überprüft werden:

[15] Ancillary/Audio >
 Analog OUT > Volume

3 Die analoge Audioausgabe kann unabhängig von der 
Monitoring-Lautstärke stummgeschaltet werden.  
Verwenden Sie dazu das folgende Menü:

[15] Ancillary/Audio >
 Analog OUT > Mute

OFF Die Audioausgabe ist nicht stummgeschaltet.
ON Die Audioausgabe ist stummgeschaltet.

Der unter 2 eingestellte Lautstärkewert wird 
nicht geändert.

Ein-/Ausgangssignal-Einstellungen
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Ein-/Ausgangssignal-Einstellungen

Sendevorgänge für SRT/RTMP-Signale

Starten und Stoppen von SRT/RTMP-Signalen erfolgen mit der Taste [STREAM].

OFF

Gedrückt halten  
(1 Sekunde)

Gedrückt halten  
(1 Sekunde)

Gedrückt halten  
(1 Sekunde)

Kurzes 
Drücken Kurzes Drücken

Kurzes Drücken
On-Air Stand-by

OFF Die anfängliche Einstellung ist beim Einschalten 
des Geräts aktiv. Es werden keine Signale 
gesendet. Die Taste [STREAM] ist aus.

Stand-by Die für diesen Modus eingestellten Bilder werden 
gesendet. Die Taste [STREAM] leuchtet grün.

On-Air Die für diesen Modus eingestellten Bilder werden 
gesendet. Die Taste [STREAM] leuchtet rot.

Das Ziel wird durch Drücken der Taste [SHIFT] umgeschaltet.

[SHIFT] nicht 
gedrückt

IP OUT1

[SHIFT] gedrückt IP OUT2

Der Status von IP OUT1/2 kann über folgenden Menüvorgang 
verknüpft werden:

[11] Output >
 OUTx > Streaming Link

Außerdem können Sie das Bildsignal für “Stand-by” während 
der SRT/RTMP-Ausgabe über folgenden Menüvorgang 
zuweisen:

[11] Output >
 OUTx > Assign STDBY

 Siehe “Zuweisen der Ausgangssignale”.
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Die vom System zu verwendenden Sync-Signale können 
ausgewählt werden.
Externes Sync-Signal:

Für Synchronisierung mit einem externen Sync-Signal  
(Genlock). 
Das Referenz-Eingangssignal wird durchgeschleift und 
ausgegeben.

BB Black-Burst-Signal (vertikale Phase von 0H)
Tri-level sync Tri-Level-Sync-Signal (vertikale Phase von 0H)
Internal Für Synchronisierung mit einem internen 

Referenzsignal (INT). 
Das Signal REFOUT (Black-Burst-Signal) 
wird über die beiden Referenzsignalbuchsen 
ausgegeben.

 p Dieses Gerät unterstützt Synchronisierungssignale für 
Halbbildfrequenzen, die mit denen des Systemformats 
identisch sind.

1 Wählen Sie das Synchronisationssignal über den 
folgenden Menüvorgang aus, und drücken Sie den OSD/
TIME-Knopf, um den ausgewählten Inhalt zu bestätigen:

[13] System > 
 Reference > Sync Select

2 Der Genlock-Status wird im folgenden Menü angezeigt:

[13] System > 
 Reference > Status

Locked Synchronisierung mit dem externen Sync-Signal 
oder dem internen Referenzsignal.

UnLock Keine Synchronisierung mit dem externen Sync-
Signal oder dem internen Referenzsignal.

Ein-/Ausgangssignal-Einstellungen

Einstellen der Sync-Signale
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Die Phase der Ausgangs-Videosignale kann eingestellt 
werden.

1 Wählen Sie “0H” oder “1H” über folgenden Menüvorgang:

[13] System > 
 Output Phase > System

0H Die Ausgangs-Videosignale werden 
phasengleich zum Reference-Signal des 
Systems ausgegeben. 
Die Frame Synchronizer-Funktion ist für alle 
Eingangssignale aktiviert. 

1H Die Ausgangs-Videosignale werden mit 
1H-Verzögerung zum Reference-Signal des 
Systems ausgegeben. 
Wenn die Frame-Synchronizer-Funktion aktiviert 
ist, werden die Ausgangs-Videosignale mit einer 
Verzögerung von 1 Vollbild + 1H ausgegeben.

2 Passen Sie die H-Phase über folgenden Menüvorgang an:

[13] System > 
 Output Phase > H-Phase

Die H-Phase kann innerhalb des Bereichs von –0,50H bis 
+0,49H eingestellt werden.

 p Die auf dem Menü angezeigte Einstellung hängt vom 
Systemformat ab.

3 Passen Sie die V-Phase über folgenden Menüvorgang an:

[13] System > 
 Output Phase > V-Phase

Die V-Phase kann innerhalb des Bereichs von –100H bis 
+100H eingestellt werden.

Ein-/Ausgangssignal-Einstellungen

Einstellen der Ausgangssignalphase
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Ein-/Ausgangssignal-Einstellungen

Zusatzdaten-Einstellungen für AUX-Bus, PGM und PVW
Hier stellen Sie die Funktion ein, welche die V-Zusatzdaten 
und die eingebetteten Audiodaten des SDI/HDMI-
Eingangssignals durchleitet.

Einstellung für die Ausgangssignale der AUX-Busse 
(AUX1, AUX2)

1 Verwenden Sie folgenden Menüvorgang zum ein- bzw. 
ausschalten:

[13] Ancillary/Audio > 
 Ancillary > AUX

OFF Die Zusatzdaten und eingebetteten Audiodaten 
der AUX-Busausgänge (AUX1, AUX2) werden 
nicht durchgeleitet.

ON Die Zusatzdaten und eingebetteten Audiodaten 
der AUX-Busausgänge (AUX1, AUX2) werden 
durchgeleitet.

Einstellung für die Programm-Ausgangssignale

2 Verwenden Sie folgenden Menüvorgang zum ein- bzw. 
ausschalten:

[13] Ancillary/Audio > 
 Ancillary > PGM

OFF Die Zusatzdaten und eingebetteten Audiodaten 
der PGM-Ausgänge werden nicht durchgeleitet.

ON Die Zusatzdaten und eingebetteten Audiodaten 
der PGM-Ausgänge werden durchgeleitet.

Einstellung für die Vorschau-Ausgangssignale

3 Verwenden Sie folgenden Menüvorgang zum ein- bzw. 
ausschalten:

[13] Ancillary/Audio > 
 Ancillary > PVW

OFF Die Zusatzdaten und eingebetteten Audiodaten 
der PVW-Ausgänge werden nicht durchgeleitet.

ON Die Zusatzdaten und eingebetteten Audiodaten 
der PVW-Ausgänge werden durchgeleitet.

Einstellung für saubere Ausgangssignale

4 Verwenden Sie folgenden Menüvorgang zum ein- bzw. 
ausschalten:

[13] Ancillary/Audio > 
 Ancillary > CLN

OFF Die Zusatzdaten und eingebetteten Audiodaten 
der CLN-Ausgänge werden nicht durchgeleitet.

ON Die Zusatzdaten und eingebetteten Audiodaten 
der CLN-Ausgänge werden durchgeleitet.

Einstellung für die Ausgangssignale der 
Mehrfeldanzeige

5 Wählen Sie über folgenden Menüvorgang zwischen PGM/
PVW/OFF:

[13] Ancillary/Audio > 
 Ancillary > MV

PGM Die Zusatzdaten und eingebetteten Audiodaten 
des PGM werden an alle MV-Ausgänge 
durchgeleitet.

PVW Die Zusatzdaten und eingebetteten Audiodaten 
des PVW werden an alle MV-Ausgänge 
durchgeleitet.

OFF Die Zusatzdaten und eingebetteten Audiodaten 
werden nicht an MV-Ausgänge durchgeleitet.

 pWenn Key kombiniert wird, werden auch die 
Audiosignale überlagert.

 p VANC-Daten werden nicht durchgeleitet, wenn sich 
das Format des Eingangssignals vom Systemformat 
unterscheidet.

Hinweise
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Ein-/Ausgangssignal-Einstellungen

Audio-Einstellungen für AUX-Bus, PGM und PVW

Wählen Sie ein Audioelement pro Eingangssignal aus, und nehmen Sie Einstellungen für die Durchleitung der einzelnen 
Ausgangssignale vor.
Für jedes Ausgangssignal können Sie nur 1 Eingangssignal unter den folgenden Optionen auswählen.
IN1 bis 9 Das in jedem Eingangssignal eingebettete Audio wird durchgeleitet.

Analog Das Audiosignal des Audioeingangs wird durchgeleitet.

Follow Video Das eingebettete Audio in Eingangssignalen, die über einen Bus ausgewählt 
wurden, wird durchgeleitet.

OFF Das eingebettete Audio wird nicht durchgeleitet.

Die Zusatzdaten-Einstellungen für jeden Bus sollten auf ON gestellt sein, um diese Funktion zu aktivieren.

Audioeinstellung für die Ausgangssignale der AUX-
Busse (AUX1, AUX2)

1 Legen Sie das Eingangssignal, das durch die Audiodaten 
durchgeleitet wird, über folgenden Menüvorgang fest:

[15] Ancillary/Audio >
 Audio Assign > AUX1

[15] Ancillary/Audio >
 Audio Assign > AUX2

Audioeinstellung für die Programm-Ausgangssignale

2 Legen Sie das Eingangssignal, das durch die Audiodaten 
durchgeleitet wird, über folgenden Menüvorgang fest:

[15] Ancillary/Audio >
 Audio Assign > PGM

Audioeinstellung für die Vorschau-Ausgangssignale

3 Legen Sie das Eingangssignal, das durch die Audiodaten 
durchgeleitet wird, über folgenden Menüvorgang fest:

[15] Ancillary/Audio >
 Audio Assign > PVW

Audioeinstellung für saubere Ausgangssignale

4 Legen Sie das Eingangssignal, das durch die Audiodaten 
durchgeleitet wird, über folgenden Menüvorgang fest:

[15] Ancillary/Audio >
 Audio Assign > CLN
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Einstellen der Mehrfeldanzeige

Einstellen des Bildschirmlayouts

Sie können eines der folgenden 10 Anordnungen für das Bildschirmlayout auswählen.
Das Multi-View-Display dieses Geräts unterstützt MV.

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit
9Split 10-aSplit 10-bSplit 12Split 16Split

Die Anzeige der folgenden Signale kann den Teilbildschirmen 1 bis 16 zugewiesen werden.

Zuweisbare Signale
IN1 bis 9, Black, CBGD1, CBGD2, CBAR, Still1V, Still1K, Still2V, Still2K, PGM, PVW, CLN, Key Out, AUX1, AUX2, Clock, Analog IN, IP 
OUT1, IP OUT2*1

*1  Der Status wird angezeigt, wenn IP OUT1(OUT4) oder IP OUT2(OUT5) auf SRT oder RTMP eingestellt ist.
Anders als beim Codieren von Bildern wird die angezeigte Bitrate mit Priorität auf dem Anzeigeintervall berechnet. Es 
kann daher vorkommen, dass der tatsächliche Wert sich von der Ausgabeeinstellung unterscheidet.

1 Richten Sie den Mehrfeldmodus über folgenden Menüvorgang ein:

[9] MultiView >
 Split

2 Legen Sie den Größenmodus für den geteilten Bildschirm über folgenden Menüvorgang fest:

[9] MultiView >
 Größe

Fit Geteiltes Bild und geteilter Bildschirm haben die gleiche Größe.
SQ Geteiltes Bild und geteilter Bildschirm werden verkleinert, und Materialname, Pegelmesser usw. werden 

außerhalb des geteilten Bildschirms angezeigt.

3 Legen Sie den in den Unterbildschirmen (1 bis 16) anzuzeigenden Signalnamen über folgenden Menüvorgang fest:

[9] MultiView >
 Source Select

 pWenn Eingangssignale (IN1 bis 9) ausgewählt sind, hängen die in den folgenden Menüs angezeigten Materialnamen von 
den Zeichen und Symbolen ab:

[10] Input >
 INx > Name Type

[10] Input >
 INx > Name

 pWenn AUX-Busse (AUX1, AUX2) als Eingangssignal ausgewählt sind, hängt der in [  ] angezeigte Materialname von den 
Zeichen und Symbolen ab.
 pWenn der AUX-Bus, für den “MV” gewählt wurde, auf dem Unterbildschirm der Mehrfeldanzeige angezeigt wird, werden die 
Bilder vervielfältigt, als ob zwei Spiegel einander gegenüber gestellt worden wären.
 p Für 720p können nicht 12 geteilte Bilder ausgewählt werden.
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<Anzeigemodi>

43

21
21

53 4 21

53 4
21

64 53 21

64 53

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit

7 8 9

4 5 6

1 2 3
1

3 4 5 6

7 8 9 10

2

1

3 4 5 6

7 8 9 10

2

21

653 4 7

11108 9 12

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

9Split 10-aSplit 10-bSplit 12Split 16Split

Einstellen der Mehrfeldanzeige
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Einstellen der Mehrfeldanzeige

Einstellen von Trennungsrahmen und 
Zeichen

Sie können die Helligkeit des Rahmens und der Zeichen 
sowie den Hintergrund der auf der Mehrfeldanzeige 
angezeigten Teilbildschirme einstellen.

1 Legen Sie die Helligkeit für das geteilte Bild und 
die Darstellung des geteilten Bildes über folgenden 
Menüvorgang fest:

[9] MultiView > 
 MV Frame

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Wählen Sie eine dieser Einstellungen 
für die Helligkeit des Trennungsrahmens 
(Graustufenskala).

Off Der Trennungsrahmen wird nicht angezeigt.

2 Legen Sie die Helligkeit der Zeichen und die Darstellung 
der Zeichen über folgenden Menüvorgang fest:

[9] MultiView > 
 MV Character

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Wählen Sie eine dieser 
Zeichenhelligkeitseinstellungen 
(Graustufenskala).

Off Die Zeichen werden nicht angezeigt. 
Der Zeichenhintergrund wird ebenfalls nicht 
angezeigt.

3 Legen Sie den Zeichenhintergrund (Halbton) über 
folgenden Menüvorgang fest:

[9] MultiView > 
 MV Label

Ein Der Zeichenhintergrund wird angezeigt.
Off Der Zeichenhintergrund wird nicht angezeigt.

 p Dies ist aktiviert, wenn der Modus Anpassen 
eingeschaltet ist.

Einstellen der Tally-Anzeigen

Sie können die auf den Trennungsrahmen der 
Mehrfeldanzeige einzublendenden Tally-Anzeigen einstellen.
Sie können 2 Tally-Gruppen auf diesem Gerät einstellen, und 
für jede Gruppe lassen sich Materialien festlegen.
Die rote Tally und die grüne Tally können auf dem Multi-View-
Display angezeigt werden.

1 Wählen Sie das Material, das rotem und grünem 
Tally zugewiesen werden soll, über den folgenden 
Menüvorgang:

[13] System > 
 Tally Settings > Tally Target > Red Tally

[13] System >
 Tally Settings > Tally Target > Green Tally

Off Kein Signal
PGM Programm-Videosignal
PVW Vorschau-Videosignal
CLN Reinsignal
KeyOut Key-Ausgangssignal
AUX1 AUX1-Bus-Ausgangssignal
AUX2 AUX2-Bus-Ausgangssignal
IP OUT1 IP-OUT1-Ausgangssignal
IP OUT2 IP-OUT2-Ausgangssignal

2 Die folgenden Menüs sind verfügbar:

[9] MultiView > 
 Red Tally

[9] MultiView > 
 Green Tally

 p Die roten und grünen Tallys, die oben unter  
eingestellt wurden, können für die Anzeige auf dem 
Mehrfeldanzeige eingerichtet werden.

3 Sie können die auf den Trennungsrahmen der 
Mehrfeldanzeige einzublendenden Tally-Anzeigen 
einstellen.

IN1Label links Label 
rechts

Kasten

On Tally-Anzeigen werden angezeigt.
Off Es werden keine Tally-Anzeigen angezeigt.
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Einstellen der Mehrfeldanzeige

Ändern von Materialnamen (Eingangssignal)

Die Materialnamen für Eingangssignale (IN1 bis 9), die auf 
der Multi-View-Anzeige eingestellt werden sollen, können 
geändert werden.
Diese Namen können von den Standardeinstellungen oder 
Benutzereinstellungen ausgewählt werden.

1 Wählen Sie den Materialnamenstyp über folgenden 
Menüvorgang:

[10] Input > 
 INx > Name Type

Default
(Standard-
einstellungen)

Die folgenden Materialnamen werden 
automatisch gewählt.  
IN1 bis 9

User
(Benutzer-
einstellungen)

Die Materialnamen können bis zu 
32 Zeichen lang sein.

Benutzertyp-Einstellverfahren

1 Wählen Sie den Materialnamenstyp “User” über folgenden 
Menüvorgang:

[10] Input > 
 INx > Name Type

2 Geben Sie den Materialnamen über folgenden 
Menüvorgang ein:

[10] Input > 
 INx > Name

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Ändern von Materialnamen (Ausgangssignal)

Die Materialnamen für Ausgangssignale (AUX1, AUX2), die 
auf der Multi-View-Anzeige eingestellt werden sollen, können 
geändert werden.
Diese Namen können von den Standardeinstellungen oder 
Benutzereinstellungen ausgewählt werden.

Wählen Sie den Materialnamenstyp für AUX1 und AUX2 über 
folgenden Menüvorgang:

[12] Config > 
 AUX Name > AUX1 Type

[12] Config > 
 AUX Name > AUX2 Type

Default
(Standard-
einstellungen)

Die folgenden Materialnamen werden 
automatisch gewählt.  
AUX1, AUX2

User
(Benutzer-
einstellungen)

Die Materialnamen können bis zu 
32 Zeichen lang sein.

Benutzertyp-Einstellverfahren

1 Wählen Sie den Materialnamenstyp “User” über folgenden 
Menüvorgang:

[12] Config > 
 AUX Name > AUX1 Type

[12] Config > 
 AUX Name > AUX2 Type

2 Geben Sie den Materialnamen über folgenden 
Menüvorgang ein:

[12] Config > 
 AUX Name > AUX1 Name

[12] Config > 
 AUX Name > AUX2 Name

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Einstellen der Pegelmesser

Sie können auf jedem geteilten Bildschirm die Pegelanzeigen 
für die Audiosignale einblenden, die zusammen mit den 
einzelnen Ein- und Ausgaben übertragen werden.

Linke Anzeige: Kanal 1 von Gruppe 1
Rechte Anzeige: Kanal 2 von Gruppe 1

Blenden Sie die Pegelanzeigen über folgenden Menüvorgang 
ein bzw. aus:

[9] MultiView > 
 Display > Level Meter

OFF Die Pegelanzeigen werden nicht angezeigt.
IN ON Die Pegelanzeigen für Eingangssignal 

(einschließlich Audioeingang) und Farbbalken 
werden angezeigt.

OUT ON Die Pegelanzeigen für PGM/PVW/CLN/AUX 
werden angezeigt.

IN/OUT ON Die Pegelanzeigen für Eingangssignal 
(einschließlich Audioeingang), Farbbalken und 
PGM/PVW/CLN/AUX werden angezeigt.
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Einstellen der Mehrfeldanzeige

Einstellen der Eingangssignalmarkierungen

Der Status der Eingangssignale kann vor den auf den 
Bildschirmfeldern angezeigten Materialnamen angezeigt 
werden.

Zeichen “F”:
Dieses Zeichen erscheint, wenn die Eingangssignale 
eingefroren sind.

“ ! ”-Markierung:
Dieses Zeichen erscheint, wenn keine Signale 
eingegeben werden, oder wenn Signale mit 
unterschiedlichen Formaten eingegeben werden.
  Wenn das Zeichen “F” angezeigt wird, erscheint das 

Zeichen “!” nicht.

Legen Sie die Eingangssignal-Statusanzeige über folgenden 
Menüvorgang fest:

[9] MultiView > 
 Display > Input Status

On Der Eingangssignalstatus wird angezeigt.
Off Der Eingangssignalstatus wird nicht angezeigt.

Einstellen der Markierungen

Sicherheitsmarkierungen können für das Mehrfeldanzeige-
Material angezeigt werden.

1 Legen Sie die Markeranzeige über folgenden 
Menüvorgang fest:

[9] MultiView > 
 Display > Marker

4:3 Die Markierungen werden mit dem 
Seitenverhältnis 4:3 angezeigt.

16:9 Die Markierungen werden mit dem 
Seitenverhältnis 16:9 angezeigt.

Off Die Markierungen werden nicht angezeigt.

2 Legen Sie die Markergröße über folgenden Menüvorgang 
fest:

[9] MultiView > 
 Display > Marker Size
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Einstellen des Systemformats
Ein Systemformat (Ein-/Ausgangssignal) kann gewählt 
werden.

Ändern Sie das Format nicht während einer der 
folgenden Operationen:

 pWenn Daten von einer Speicherkarte gelesen oder auf 
ein USB-Speichergerät geschrieben werden

 p Beim Wiederherstellen von Daten aus dem 
Videospeicher oder beim Speichern von Daten im 
internen Speicher

 pWenn Bewegtbilder oder Standbilder aufgenommen 
werden

Wählen Sie das Format über den folgenden Menüvorgang 
aus, und drücken Sie den OSD/TIME-Knopf, um den 
ausgewählten Inhalt zu bestätigen:

[13] System > 
 System Format

Zuweisen von Signalen zu den Kreuzpunkten

Externe Video-Eingangssignale und intern erzeugte Signale 
können den Kreuzpunkttasten 1 bis 12 zugewiesen werden.
Der Zuweisungsstatus der Kreuzpunkttasten 1 bis 12 wird auf 
dem Ausgabeziel für das OSD-Menü angezeigt, während Sie 
die Kreuzpunkttasten 1 bis 12 gedrückt halten.

Wird die aktuelle Zuordnung der mit den Kreuzpunkttasten 
gewählten Signale geändert, ändern sich die Positionen 
der leuchtenden Kreuzpunkttasten in Übereinstimmung 
mit der Zuordnungsänderung. Die zu diesem Zeitpunkt 
ausgegebenen Bilder bleiben unverändert.

Die nachstehende Tabelle listet die zuweisbaren Signale auf.

Signal Display-
Anzeige Description

IN1 bis 9 IN1 bis 9 Eingang 1 bis 9
Informationen zur erweiterten 
Signalzuweisung finden Sie unter 
“Eingangssignal-Einstellungen”.

Black Schwarz Intern erzeugtes Signal (Schwarz)

CBGD1, 
CBGD2

CBGD1, 
CBGD2

Intern erzeugtes Signal 
(Farbhintergrund)

CBAR CBAR Intern erzeugtes Signal (Farbbalken)

Still1V, 
Still1K, 
Still2V, 
Still2K

Still1V, 
Still1K, 
Still2V, 
Still2K

Standbild-Videospeicher

CLN CLN CLN (nur AUX-Bus und Bilder auf 
dem eingebauten Display)

KeyOut KeyOut KeyOut (nur AUX-Bus und Bilder auf 
dem eingebauten Display)

None None Keine Zuweisung

 p Durch Drücken einer Taste, der “None” zugewiesen ist, wird 
das Bild nicht geändert.

Die nachstehende Tabelle listet die Standardeinstellungen 
auf.

Taste Display-
Anzeige Taste Display-

Anzeige
XPT1 IN1 XPT7 IN7

XPT2 IN2 XPT8 IN8

XPT3 IN3 XPT9 IN9

XPT4 IN4 XPT10 CBAR

XPT5 IN5 XPT11 CBGD1

XPT6 IN6 XPT12 CBGD2

Einstellen der Kreuzpunktumschaltung

Der Zeitpunkt, zu dem die Kreuzpunkte umgeschaltet werden 
sollen, kann eingestellt werden.
Diese Umschaltung beinhaltet die Operationen der 
Kreuzpunkttasten und der Taste [Cut].

Wählen Sie den Zeitpunkt für das Umschalten über folgenden 
Menüvorgang:

[8] XPT Assign > 
 Switch Timing

Any Die Kreuzpunkte werden im nächsten Halbbild 
umgeschaltet. Dies eignet sich für Live-
Anwendungen.

Field1 Die Kreuzpunkte werden in Halbbild 1 
umgeschaltet. 
Dies eignet sich für Schnitt-Anwendungen.

Field2 Die Kreuzpunkte werden in Halbbild 2 
umgeschaltet. 
Dies eignet sich für Schnitt-Anwendungen.

Einstellen der Kreuzpunkte
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Tastenzuweisungen

Einstellen der Benutzertasten

Der Benutzer kann den sechs Benutzertasten (U1 bis U6) 
mehrere Funktionen zuweisen, die mithilfe der Menüposten 
festgelegt werden können.
Die Benutzertasten leuchten in Gelb auf, wenn die 
zugewiesene Funktion aktiv ist, und erlöschen, wenn die 
zugewiesene Funktion inaktiv ist. 
Bei jedem Drücken der Benutzertaste wechselt die 
Funktionseinstellung zwischen EIN und AUS.

Die nachstehende Tabelle listet die Funktionen auf, die den 
Benutzertasten (U1 bis U6) zugewiesen werden können.

Funktionsname Beschreibung der Funktion
KEY1 PVW Gibt das Bild KEY1 am Vorschau-Ausgang 

aus.

KEY2 PVW Gibt das Bild KEY2 am Vorschau-Ausgang 
aus.

GPII-EN Aktiviert oder deaktiviert GPI-In.

GPIO-EN Aktiviert oder deaktiviert GPI-Out.

AUX TRANS Aktiviert oder deaktiviert die AUX-Bus-
Übergänge.

AUX1 TRANS Aktiviert oder deaktiviert die AUX1-Bus-
Übergänge.

AUX2 TRANS Aktiviert oder deaktiviert die AUX2-Bus-
Übergänge.

Effect Dissolve Schaltet den Auflösungseffekt EIN bzw. AUS.

None Nichts ist zugeordnet.

Shot  
Memory1 bis 12

Ruft die Shot-Speicher 1 bis 12 ab.

XPT Disable Aktiviert oder deaktiviert XPT Disable für 
Shot-Speicher.

■ Standardeinstellungen

Taste Funktionsname Taste Funktionsname
U1 KEY1 PVW U4 Shot Memory2

U2 KEY2 PVW U5 Shot Memory3

U3 Shot Memory1 U6 Shot Memory4

<Einstellverfahren>
Wählen Sie die den Tasten U1 bis U6 zuzuweisenden 
Funktionen über den folgenden Menüvorgang:

[12] Config >
 User Button > User 1

[12] Config >
 User Button > User 2

[12] Config >
 User Button > User 3

[12] Config >
 User Button > User 4

[12] Config >
 User Button > User 5

[12] Config >
 User Button > User 6
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Einstellen von Datum und Uhrzeit
Der Benutzer kann das Datum und die Uhrzeit einstellen, die 
als Zeitstempel für das USB-Speichergerät verwendet werden 
sollen. 
Diese Einstellungen müssen unbedingt durchgeführt werden, 
wenn ein USB-Speichergerät verwendet werden soll.

Einstellen des Datums

1 Drücken Sie den OSD/TIME-Knopf im Menü “Date/
Time > Date Setting”, um Jahr, Monat und Tag (in dieser 
Reihenfolge) einzustellen.

[13] System > 
 Date/Time > Date Setting

2 Drücken Sie nach dem Einstellen des Tages den OSD/
TIME-Knopf, um Jahr, Monat und Tag zu bestätigen.

Einstellen der Uhrzeit

1 Drücken Sie den OSD/TIME-Knopf im Menü “Date/Time 
> Time Setting”, um Stunden, Minuten und Sekunden (in 
dieser Reihenfolge) einzustellen.

[13] System > 
 Date/Time > Time Setting

2 Drücken Sie nach dem Einstellen der Sekunden den OSD/
TIME-Knopf, um Stunden, Minuten und Sekunden zu 
bestätigen.
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Nehmen Sie die Netzwerkeinstellungen vor, um solche 
Aufgaben wie das Aktualisieren der Software-Version über 
LAN durchzuführen.
Ab Werk sind folgende Werte zugewiesen: IP-Adresse: 
192.168.0.8, Subnetzmaske: 255.255.255.0. 
Wenn der Hostcomputer mit Einstellungen verwendet wird, 
die der Ersteinrichtung entsprechen, erübrigt sich eine 
Einrichtung über das Menü.

Eingeben der IP-Adresse

Legen Sie die IP-Adresse über folgenden Menüvorgang fest:

[16] Network >
 LAN > IP Address

Eingeben der Subnetzmaske

Legen Sie die Subnetzmaske über folgenden Menüvorgang 
fest:

[16] Network >
 LAN > Subnet Mask

Einstellen des Standard-Gateways

Legen Sie das Standard-Gateway über folgenden 
Menüvorgang fest:

[16] Network >
 LAN > Default Gateway

Anzeigen der MAC-Adresse

Im folgenden Menü können Sie die MAC-Adresse überprüfen:

[16] Network >
 LAN > MAC Address

DNS-Servereinstellungen

Legen Sie den primären und den sekundären DNS-Server 
über folgenden Menüvorgang fest:

[16] Network >
 Primary DNS > IP Address

[16] Network >
 Secondary DNS > IP Address

 p Diese Angaben werden zur Auflösung von Domainnamen 
für SRT oder RTMP benötigt.

 p Dies ist leer, wenn keine Einstellung vorgenommen wurde.

Systemeinstellungen

Netzwerkeinstellungen
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Einstellen der Tastenbeleuchtung

Tastenbeleuchtung

Die Tastenbeleuchtung kann dauerhaft eingeschaltet bleiben. 
So ist die Beschriftung für die Tasten für die Bedienung auch 
an dunklen Orten gut sichtbar.

1 Legen Sie die Einstellungen für die ausgewählte Taste 
über folgenden Menüvorgang fest:

[12] Config > 
 Button Illumination > Button Illumination > 

Lighting

80% bis 
150%

Die Tastenbeleuchtung leuchtet. Die Helligkeit 
kann zwischen 80% und 150% eingestellt 
werden.

2 Legen Sie die Tasteneinstellungen bei ausgeschaltetem 
Gerät über folgenden Menüvorgang fest:

[12] Config > 
 Button Illumination > Button Illumination > 

XPT Color

Input Stellen Sie [Color Group1] bis [Color Group8] für 
jedes der Materialien “Color Group IN”, “Color 
Group Internal”, “Color Group Still” und “Color 
Group Other” fest.

Color 
Group1 bis 8

Es können 8 verschiedene Farben eingestellt 
werden.

3 Legen Sie die Einstellungen für [R], [G] und [B] für die 
Tastenbeleuchtung über folgenden Menüvorgang fest:

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group1

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group2

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group3

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group4

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group5

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group6

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group7

[12] Config > 
 Button Illumination > Button Illumination > 

Button Color Group8
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Alarmstatusanzeigen

Alarme informieren über Probleme mit der Stromversorgung 
oder Kühlung des Geräts. Sie werden auf dem Ausgabeziel 
für das OSD-Menü angezeigt.

Die folgenden Menüs sind verfügbar:

[13] System >
 Alarm > Power

[13] System >
 Alarm > Fan

[13] System >
 Alarm > Temperature

Der Alarmstatus der Stromversorgungen wird beim Posten 
“Power” angezeigt.
Der Alarmstatus des Lüfters wird beim Posten “Fan” 
angezeigt.
Der Alarmstatus der internen Temperatur wird im Posten 
“Temperature” angezeigt.

No Alarm Keine Unregelmäßigkeit
Alarm Unregelmäßigkeit

Alarmmeldung

Meldungen werden auf dem Ausgabeziel für das OSD-Menü 
angezeigt, wenn ein Alarm auftritt.
Diese Meldungen sind nur sichtbar, wenn die OSD-Menüs 
angezeigt werden.

 Angezeigte 
Alarmmeldung Störungsart Betrieb

ALARM ! Fan 
Stop.

Abschaltung des 
Lüfters

Durch Drücken 
von OK wird die 
Alarmmeldung 
gelöscht.
  Kontaktieren Sie 

unverzüglich Ihren 
Händler.

ALARM ! Power 
Stop.

Abfall der 
Versorgungsspannung

ALARM ! High 
temperature.

Anstieg der Temperatur 
im Gerät

Anzeigen der Versions-Information

Sie können die Versions-Information für die Software und 
Hardware des Geräts anzeigen lassen.

Die folgenden Menüs sind verfügbar:

[13] System >
 System Information

 p Die Systemversionsinformation des Gerätes wird im Posten 
“System Version” angezeigt.

Systemeinstellungen

Statusanzeigen
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Initialisieren der Einstellungsdaten

Durch die Initialisierung werden die eingestellten Daten auf 
die Werksvorgaben vor dem Versand zurückgestellt.
Bei der Initialisierung der Einstellungsdaten wird der 
Videospeicher gelöscht, die im internen Speicher 
gespeicherten Standbilddaten und Projektdateien werden 
jedoch nicht gelöscht.

<Posten und Daten, die nicht initialisiert werden>
 p Die Posten des Menüs sind unten aufgelistet:

[13] System > 
 Date/Time

[16] Network

1 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü zum Initialisieren.

[13] System > 
 Initial > Initial Settings

2 Verwenden Sie den OSD/TIME-Knopf, um “YES” (JA) 
auszuwählen, und drücken Sie den Knopf, um die 
Initialisierung durchzuführen.

 p Verwenden Sie den OSD/TIME-Knopf, um “NO” (NEIN) 
auszuwählen, und drücken Sie den Knopf, um den 
Vorgang abzubrechen.

Initialisieren des Faders

Der Bereich für die Ausführung eines Übergangs kann durch 
Betätigen des Überblendhebels initialisiert werden.
Die Initialisierung sollte durchgeführt werden, wenn 
Übergänge nicht bis zu Ende ausgeführt werden, obwohl der 
Überblendhebel bis zum Anschlag bewegt worden ist.

1 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü zum Initialisieren.

[13] System > 
 Initial > Initial Fader

2 Verwenden Sie den OSD/TIME-Knopf, um “YES” (JA) 
auszuwählen, und drücken Sie den Knopf, um die 
Initialisierung durchzuführen.

 p Verwenden Sie den OSD/TIME-Knopf, um “NO” (NEIN) 
auszuwählen, und drücken Sie den Knopf, um den 
Vorgang abzubrechen.

Systemeinstellungen

Initialisierung
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Funktionen für Netzwerkkamera-Verbindungen
Sie können bis zu 9 Netzwerkkameras über LAN mit diesem Gerät verbinden und fernsteuern.
Informationen zur Kompatibilität von Netzwerkkameras, zu denen eine Verbindung aufgebaut werden kann, finden Sie auf der 
Seite zum AV-HSW10 auf der folgenden Website:

https://pro-av.panasonic.net/en/

w	Verbindungsbeispiele

SDI/HDMI-
Videosignale

Switching-Hub

LAN-Kabel

Kompakter Live Switcher
AV-HSW10

Monitor 1

Monitor 2

Monitor Monitor

LAN-Kabel

Kamera-Steuereinheit

Externes 
Netzgerät

Externes 
Netzgerät

LAN-Buchse

Netzwerkkamera (max. 9)

 p Verwenden Sie für die Verbindung zwischen dem Gerät und den Netzwerkkameras einen GbE-kompatiblen Switching-Hub 
und STP-LAN-Kabel der Kategorie Cat5e oder besser.

 p Achten Sie ferner bei der Netzwerkeinrichtung darauf, dass sich die IP-Adressen von Gerät und Netzwerkkameras im selben 
Subnetz befinden.
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Funktionen für Netzwerkkamera-Verbindungen
Zur Steuerung der mit diesem Gerät verbundenen Netzwerkkameras stehen folgende Funktionen zur Verfügung:

 p Automatische Erkennung der IP-Adresse
 p Verbundene Netzwerkkameras können abhängig vom Tally-Status dieses Geräts per Tally gesteuert werden

Einstellungen für die Verbindung mit Netzwerkkameras

Auswahl der Anschlüsse für die Verbindung 
mit Netzwerkkameras

Wählen Sie im folgenden Menü das Eingangssignal aus, an 
das die Netzwerkkamera angeschlossen ist:

[10] Input

 p Die folgenden Netzwerkkamera-Einstellungen sind 
entsprechend dem Eingang IN1 bis 9 möglich.

IP-Adresseinstellungen

Automatisch einstellen

Sie können nach den Scan IP Address, die in den 
verbundenen Netzwerkkameras eingestellt sind und diese in 
diesem Gerät einstellen.

Verwenden Sie das folgende Menü, um nach den 
IP-Adressen der verbundenen Netzwerkkameras zu suchen:

[10] Input >
  INx > Camera Setting > Scan IP Address

 p Die Scanergebnisse werden in der Liste des Menüpunkts 
IP-Adresse angezeigt.

[10] Input > 
 INx > Camera Setting > IP Address

 pWenn “Select From List” angezeigt wird, wählen Sie mit 
dem OSD/TIME-Knopf die IP-Adresse der verbundenen 
Netzwerkkamera im Posten für die IP-Adresse aus.
 pWenn die IP-Adresse der Netzwerkkamera nicht erkannt 
werden konnte, wird “Not Detected” angezeigt.
 p Ändern Sie die IP-Adresse des Geräts oder der 
Netzwerkkamera und stellen Sie die Adressen so ein, 
dass sie nicht doppelt vorhanden sind.
 pWenn die IP-Adresse der Netzwerkkamera doppelt 
vorhanden ist, wird die Fehlermeldung “Duplicate IP 
Address Detected. (ErrNo = – 650)” angezeigt.

Manuelle Einstellung

Sie können in diesem Gerät die in den verbundenen 
Netzwerkkameras eingestellten IP-Adressen direkt einstellen.

Verwenden Sie das folgende Menü, um die IP-Adressen der 
verbundenen Netzwerkkameras einzugeben:

[10] Input > 
 INx > Camera Setting > Edit IP Address

Porteinstellungen für Netzwerkkameras

Legen Sie die Ports der verbundenen Netzwerkkameras über 
folgenden Menüvorgang fest:

[10] Input > 
 INx > Camera Setting > Port

Authentifizierungseinstellungen für 
Netzwerkkameras
1 Verwenden Sie das folgende Menü, um den 

Benutzernamen festzulegen, der für die Authentifizierung 
an den Netzwerkkameras verwendet wird:

[10] Input > 
 INx > Camera Setting > Edit User Name

2 Verwenden Sie das folgende Menü, um das Passwort 
festzulegen, das für die Authentifizierung an den 
Netzwerkkameras verwendet wird:

[10] Input > 
 INx > Camera Setting > Edit Password

<Für Dateinamen verwendbare Zeichen>
A bis Z, a bis z, 0 bis 9, Leerzeichen, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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Überprüfen des Verbindungsstatus der 
Netzwerkkamera
1 Die in den Netzwerkkameras eingestellten Kameranamen 

werden im folgenden Menü angezeigt:

[10] Input > 
 INx > Camera Setting > Name

2 Der IP-Verbindungsstatus des Geräts und der 
Netzwerkkameras wird im folgenden Menü angezeigt:

[10] Input > 
 INx > Camera Setting > Network Status

No IP Address Die IP-Adresse der Kamera wurde nicht im 
Menü Eingang eingegeben.

Now 
Checking…

Das Gerät und die Netzwerkkamera 
kommunizieren miteinander.

Connected Das Gerät und die Netzwerkkamera sind 
miteinander verbunden.

Unauthorized Es wurden keine oder falsche 
Authentifizierungsinformationen eingegeben.

Not Connected Es liegt ein Kommunikationsfehler vor.

Tally-Steuerungseinstellungen für 
Netzwerkkameras

Sie können die rote und grüne Tally-Steuerung der mit 
diesem Gerät verbundenen Netzwerkkameras mit der roten 
und grünen Tally-Steuerung dieses Geräts verknüpfen.

1 Stellen Sie die Verknüpfung zwischen der roten Tally-
Steuerung an diesem Gerät und der roten Tally-Steuerung 
an der Netzwerkkamera über folgenden Menüvorgang ein:

[10] Input > 
 INx > Camera Setting > Red Tally

Enable Verknüpft.
Disable Nicht verknüpft.

2 Stellen Sie die Verknüpfung zwischen der grünen Tally-
Steuerung an diesem Gerät und der grünen Tally-
Steuerung an der Netzwerkkamera über folgenden 
Menüvorgang ein:

[10] Input > 
 INx > Camera Setting > Green Tally

Enable Verknüpft.
Disable Nicht verknüpft.
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Einstellen von GPI I/O
Der Benutzer kann die über die GPI-Anschlüsse zu 
steuernden Funktionen festlegen und bestimmen, ob die 
Steuerung aktiviert werden soll oder nicht.

1 Aktivieren (On) oder deaktivieren (Off) Sie die 
Steuerung zur Ausführung über die Ports über folgenden 
Menüvorgang:

[12] Config > 
 GPI > GPI-In Setting > GPI-In Enable

[12] Config > 
 GPI > GPI-Out Setting > GPI-Out Enable

2 Stellen Sie über folgenden Menüvorgang den AUX-Bus für 
Tally-Benachrichtigungen ein:

[12] Config > 
 GPI > GPI-In Setting > AUX Sel

[12] Config > 
 GPI > GPI-Out Setting > AUX Tly Sel

3 Weisen Sie jeder Stiftnummer über den folgenden 
Menüvorgang eine Funktion zu:

[12] Config > 
 GPI > GPI-In Port > Port1 Assign

[12] Config > 
 GPI > GPI-In Port > Port2 Assign

[12] Config > 
 GPI > GPI-In Port > Port3 Assign

[12] Config > 
 GPI > GPI-In Port > Port4 Assign

[12] Config > 
 GPI > GPI-In Port > Port5 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 1 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 2 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 3 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 4 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 5 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 6 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 7 Assign

[12] Config > 
 GPI > GPI-Out Port > Port 8 Assign

  Siehe “Steuerung über den GPI-Eingang” und “Ausgabe 
über den GPI-Ausgang”.

 p Die Einstellungen für den Posten “GPI-In Enable” (oder 
“GPI-Out Enable”) können einer der Benutzertasten 
zugewiesen werden.
 Siehe “Einstellen der Benutzertasten”.
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 w Steuerung über den GPI-Eingang

Zuweisungsposten Beschreibung der zugewiesenen Funktion Steuermethode
KEY 1/2 ON Taste KEY1, KEY2 im Übergangsbereich

Die Operationen werden mit 
Kontakteingängen (30 ms oder mehr) 
durchgeführt.

FTB ON Taste FTB im Übergangsbereich

BKGD AUTO Taste AUTO bei Wahl des Hintergrunds

BKGD CUT Taste CUT bei Wahl des Hintergrunds

KEY1 AUTO Taste AUTO bei Wahl des Keys

KEY1 CUT Taste CUT bei Wahl des Keys

REC Still1 Still1 Aufnahme

REC Still2 Still2 Aufnahme

AUX XPT1 bis 12 Die Kreuzpunkttasten (1 bis 12) werden zum Umschalten der AUX-
Busse verwendet.
  Wählen Sie die zu steuernden AUX-Busse (AUX1, AUX2) mithilfe 

des Menüs aus.

RTly DSBL Rotes Tally-Signal wird nicht ausgegeben Die Funktionen werden mit 
Kontakteingängen aktiviert (oder im 
Unterbrechungszustand deaktiviert).

GTly DSBL Grünes Tally-Signal wird nicht ausgegeben

AUXTly DSBL Das AUX-Rotlichtsignal wird nicht ausgegeben

No Assign Keine Funktion zugewiesen

 w Ausgabe über den GPI-Ausgang

Zuweisungsposten Beschreibung der zugewiesenen Funktion Output
CUT Schnittübergang ausgeführt

Niedrige Impulse werden 
ausgegeben (ca. 50 bis 60 ms).

KEY1 ON, KEY2 ON Key1-, 2-Übergang Start

FTB ON FTB-Übergang Start

BKGD CUT Schnittübergang für Hintergrund ausgeführt

KEY1 CUT Schnittübergang für einen Key1 ausgeführt

AUTO Automatische Übergangsausführung läuft

Ein niedriger Pegel wird ausgegeben.BKGD AUTO Automatische Übergangsausführung läuft für Hintergrund

KEY1 AUTO Automatische Übergangsausführung läuft für Key1

RTly SDI IN1 bis 4 Rotes Tally-Signal für SDI IN1 bis IN4

Ein niedriger Pegel wird während der 
Tally-Ausgabe ausgegeben.

RTly HDMI IN1, 2 Rotes Tally-Signal für HDMI IN1, 2

RTly IP IN1 bis 4 Rotes Tally-Signal für IP IN1 bis IN4

GTly SDI IN1 bis 4 Grünes Tally-Signal für SDI IN1 bis IN4

GTly HDMI IN1, 2 Grünes Tally-Signal für HDMI IN1, 2

GTly IP IN1 bis 4 Grünes Tally-Signal für IP IN1 bis IN4

AUXTly SDI IN1 bis 4 Wenn SDI IN1 bis IN4 vom AUX-Bus gewählt worden sind*
Ein niedriger Pegel wird während der 
Eingangswahl ausgegeben.AUXTly HDMI IN1, 2 Wenn HDMI IN1, 2 vom AUX-Bus gewählt worden sind*

AUXTly IP IN1 bis 4 Wenn IP IN1 bis IN4 vom AUX-Bus gewählt worden sind*
No Assign Keine Funktion zugewiesen

*: Wählen Sie die AUX-Busse (AUX1, AUX2), deren Signale ausgegeben werden sollen, mithilfe des Menüs aus.
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Com

GPI Out
ALARM Out

Beispiele von GPI Out- und ALARM-Anschlüssen
Stellen Sie sicher, dass die unten angegebenen 
Bedingungen erfüllt sind.

Durchschlagsfestigkeit: Max. DC 24 V
Stromstärke: Max. 50 mA

AV-HSW10 (Max. Spannung: 24 V)

Tally-LED(Max. Stromstärke: 
50 mA) Com

GPI In

+3.3 V

Beispiel von GPI In-Anschlüssen
Verwenden Sie Kontakteingänge.

AV-HSW10

TALLY/GPI

12345

12 11 10

678

15 14 13 9

Stift-Nr. Signalname
1 GPI-Out1

9 GPI-Out8

2 GPI-Out2

10 GPI-In1

3 GPI-Out3

11 GPI-In2

4 GPI-Out4

12 GPI-In3

5 GPI-Out5

13 GPI-In4

6 ALARM Out

14 GPI-In5

7 GPI-Out6

15 GPI-Com

8 GPI-Out7

LAN

Verbinden Sie das Gerät und den Computer oder das Gerät und ein externes Gerät*.
*:  Ein externes Gerät kann über die Einheit gesteuert werden.

 p Verwenden Sie ein STP (Shielded Twisted Pair)-Straight-Through- oder Crossover-LAN-Kabel der Kategorie CAT5E oder 
besser mit einer Maximallänge von 100 m.
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Steuerung mit externen Konsolen

Mit diesem Gerät können Sie die folgenden Vorgänge über externe Konsolen (*) ausführen, die über ein IP-Netzwerk verbunden 
sind:

 p Materialien für einzelne Busse auswählen
 p Videoübergänge ausführen
 p Shot-Speicher wiedergeben
 p Kreuzpunkt-Auswahl für einzelne Busse

*:  Dieses Gerät unterstützt die LBP-Serie von LAWO. Wenden Sie sich an LAWO, um Informationen zu Einstellungen und 
Bedienvorgängen der LBP-Serie zu erhalten.

Vorbereitungen

Verwenden Sie ein LAN-Kabel, um die externe Konsole 
mit dem LAN-Anschluss auf der Rückseite des Geräts zu 
verbinden.
Sie können bis zu 20 externe Konsolen anschließen. 
Verwenden Sie beim Anschließen mehrerer externer 
Konsolen einen Hub.

Ein-/Ausschalten externer Konsolen und dieses 
Geräts
Beachten Sie beim Ein-/Ausschalten oder Neustarten der 
Geräte die folgenden Punkte.

 pWenn die externe Konsole auch nach Ablauf von 
3 Minuten oder mehr seit dem Neustart dieses Geräts 
nicht verbunden werden kann, starten Sie die externe 
Konsole neu.

 p Bevor Sie eine externe Konsole ausschalten, während 
dieses Gerät eingeschaltet ist, müssen Sie den 
folgenden Posten auf “Disable” setzen. Anschließend 
können Sie die externe Konsole ausschalten.

[17] External Interfaces >
 External Panel Information > Active

Hinweise

Einstellungen für externe Konsolen

Überprüfen Sie die folgenden Einstellungen an diesem 
Gerät und nehmen Sie dann die Einstellungen an den 
angeschlossenen externen Konsolen vor:

 p Stellen Sie die im folgenden Posten angegebene 
IP-Adresse des Geräts, das über die externe Konsole 
gesteuert werden soll, ein:

[16] Network >
 LAN > IP Address

 p Stellen Sie die im folgenden Posten angegebene 
Portnummer des Geräts, das über die externe Konsole 
gesteuert werden soll, ein:

[17] External Interfaces >
 External Panel Information > Port No

Stellen Sie außerdem in den folgenden Menüs die 
Subnetzmaske und das Standardgateway passend zur 
verbundenen Netzwerkumgebung ein:

[16] Network >
 LAN > Subnet Mask

[16] Network >
 LAN > Default Gateway

Einstellungen an diesem Gerät, wenn externe 
Konsolen angeschlossen sind

Empfangsportnummer-Einstellungen

1 Aktivieren (On) oder deaktivieren (Off) Sie die Funktionen 
der externen Konsole über folgenden Menüvorgang:

[17] External Interfaces >
 External Panel Information > Active

2 Legen Sie die Empfangsportnummer, die von diesem 
Gerät verwendet wird, über folgenden Menüvorgang fest:

[17] External Interfaces >
 External Panel Information > Port No

Möglicher Einstellbereich 62000 bis 65535
Standardwert 62010
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Einstellungen für Shot-Speicher-Wiedergabeziele

Legen Sie die Wiedergabeziele fest, die verwendet werden 
sollen, wenn Shot-Speicher auf diesem Gerät durch 
Bedienvorgänge auf externen Konsolen wiedergegeben 
werden.

Legen Sie die Wiedergabeziele für den Shot-Speicher über 
folgenden Menüvorgang fest:

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

BKGD

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

Key1

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

Key2

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

AUX1

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

AUX2

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

CBGD

[17] External Interfaces > 
 External Panel IP > Shot Memory Recall > 

XPT

 p ME, AUX, Farbhintergrund und Kreuzpunktbereich 
können einzeln auf ON/OFF eingestellt werden.

Externe Schnittstellen
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Liste der Bus-IDs und Quell-IDs

Beim Ausführen von Bedienvorgängen an externen Konsolen werden Kreuzpunkt-Einstellungsbefehle ausgegeben, welche die 
Materialien (Quelle) für die Busse (Ziel) angeben.
Wenn dieses Gerät den Kreuzpunkt-Einstellungsbefehl von der externen Konsole empfängt, werden gemäß den im Befehl 
angegebenen Bus- und Materialkombinationen Materialien ausgewählt und Videoübergänge ausgeführt.
In diesem Abschnitt werden die IDs (Nummern) beschrieben, die dieses Gerät zur Identifizierung der einzelnen Busse und 
Materialien verwendet.

IDs können grob in die folgenden 2 Typen eingeteilt werden:

1) Normale Bus-IDs und Material-IDs
Diese IDs identifizieren die Busse im Mischer (PGM, AUX1, usw.) und die Mischermaterialien (IN1, CBGD1, STILL1-V, usw.).
Verwenden Sie eine Zahl zwischen 1 und 512.

2) Erweiterte Bus-IDs und erweiterte Material-IDs
Diese IDs werden für die Wiedergabe von Videoübergängen, Makrospeichern und Shot-Speichern verwendet.
Wenn dieses Gerät einen Kreuzpunkt-Einstellungsbefehl empfängt, der für den Bus und das Material dieselbe erweiterte ID 
angibt, wird die entsprechende Funktion ausgeführt.
Wenn beispielsweise ein Befehl eingeht, der Material BKGD AUTO (ID: 522) für den Bus BKGD AUTO (ID: 522) angibt, wird 
der Übergangstyp AUTO ausgeführt.
Verwenden Sie eine Zahl zwischen 513 und 1024.

Ausführbare Bedienvorgänge Bus- und Materialangabe
ME-Key-Übergang KEY1 AUTO, KEY2 AUTO

ME-Key-Übergang (CUT) KEY1 CUT, KEY2 CUT

ME-AUTO-Übergang BKGD AUTO

ME-CUT-Übergang BKGD CUT

Wiedergabe von Shot-Speichern SHOTPLAY1 bis SHOTPLAY12

Kreuzpunkt-Auswahl für einzelne Busse XPT1 bis XPT12

 pWenden Sie sich an LAWO, um Einzelheiten zum Zuweisen von IDs zu den Bedienvorgängen der einzelnen Tasten der LBP-
Serie zu erhalten.

Einstellungen für die externe Konsole (LBP-Serie von LAWO), die als externe Schnittstelle (ExtPanel) verwendet wird
Beachten Sie die folgenden Punkte, wenn Sie mehrere (2 oder mehr) externe Konsolen anschließen.

 pWenn Sie Konfigurationsdaten für mehrere externe Konsolen erstellen, erstellen Sie die Daten in derselben .snap-Datei.
 p Verwenden Sie für jede eingesetzte externe Konsole die gleichen Parametereinstellungen mit der Ausnahme eines 
unterschiedlichen Routernamens.

Wenn Sie die obigen Maßnahmen nicht beachten und Einstellungen für die erweiterten Bus-IDs/Quell-IDs 810 bis 821 (XPT1 
bis XPT12) der Steuer-IDs an mehreren externen Konsolen vornehmen, werden die externen Konsolen möglicherweise nicht 
ordnungsgemäß funktionieren.

Hinweise
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Bus-ID

ID Bus ID Bus ID Bus ID Bus ID Bus
1 PGM 112 – 152 – 160 MV-8 168 MV-16
2 PVW 113 AUX1 153 MV-1 161 MV-9 169 –
3 KEY1-F 114 AUX2 154 MV-2 162 MV-10 …

4 KEY1-S 115 – 155 MV-3 163 MV-11 512 –

5 KEY2-F … 156 MV-4 164 MV-12
6 KEY2-S 149 – 157 MV-5 165 MV-13
7 – 150 VMEM-V 158 MV-6 166 MV-14

… 151 VMEM-K 159 MV-7 167 MV-15
–: Nicht verwendete ID

Quell-ID
ID Quelle ID Quelle ID Quelle ID Quelle ID Quelle
1 IN1 … … 201 PGM 232 IP OUT2
2 IN2 144 – 164 – 202 – 233 –
3 IN3 145 CBGD1 165 MV 203 PVW …

4 IN4 146 CBGD2 166 – 204 – 250 –

5 IN5 147 CBAR … … 251 CLOCK
6 IN6 148 Black 170 – 226 – 252 –
7 IN7 149 STILL1V 171 Key Out 227 AUX1 …

8 IN8 150 STILL1K 172 CLN 228 AUX2 512 –
9 IN9 151 STILL2V 173 – 229 –
10 Analog IN 152 STILL2K … 230 –
11 – 153 – 200 – 231 IP OUT1

–: Nicht verwendete ID

Erweiterte Bus-ID
ID Bus ID Bus ID Bus ID Bus ID Bus

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9

515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11

517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Deaktivierte ID (-1) gesendet

Erweiterte Quell-ID 
ID Quelle ID Quelle ID Quelle ID Quelle ID Quelle

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9
515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11
517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Nicht verwendete ID
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Externe Steuerung

<Übersicht>
Es ist möglich, mit externen Geräten, die mit dem 
Netzwerk verbunden sind, z. B. Systemcontroller und Tally-
Schnittstellen, alle Materialien auf allen Bussen dieses Geräts 
zu schalten und Materialnamensinformationen aller Busse 
dieses Geräts zu übertragen und zu empfangen.
Es ist auch möglich, die Einstellungen für Key Signal 
Coupling über externe Geräte umzuschalten.
Tally-Informationen und Quell-ID-Informationen können in 
einem Übertragungsformat gesendet und empfangen werden, 
das mit dem TSL-UMD-Protokoll V5.0 kompatibel ist.
Wenn Sie eine Kamera-Steuerungseinheit der AW-RP-
Reihe von Panasonic über IP verbinden, können Sie 
mithilfe der Kamerawahltasten der AW-RP-Einheit 
Materialien umschalten, Tally-Informationen übertragen, die 
Fokusunterstützung nutzen und Materialnamen für die Busse 
des Geräts abrufen.

 p Informationen zu Steuerbus-Einstellungen usw. finden Sie 
in der Bedienungsanleitung der AW-RP-Reihe.

<Vorbereitung>
Schließen Sie das externe Gerät mit einem LAN-Kabel an 
den LAN-Anschluss auf der Rückseite dieses Geräts an.
Das Gerät unterstützt 20 IP-Verbindungen. Verwenden Sie 
beim Anschließen mehrerer externer Geräte einen Hub. 
Stellen Sie die IP-Adresse so ein, dass keine Adressen 
doppelt vorhanden sind.
Prüfen Sie die Netzwerk-Einstellungen dieses Geräts in den 
folgenden Menüs:

[16] Network >
 LAN > IP Address

[16] Network >
 LAN >  Subnet Mask

Die Anfangseinstellungen sind: “192.168.0.50”, 
Subnetzmaske: “255.255.255.0”.

<Einstellungen>
1 Aktivieren (On) oder deaktivieren (Off) Sie die Funktionen 

zur externen Steuerung über folgenden Menüvorgang:

[17] External Interfaces >
 External Control Switcher > Active

2 Richten Sie das Netzwerk über folgenden Menüvorgang 
ein:

[17] External Interfaces >
 External Control Switcher > Port No

3 Legen Sie das Intervall für Befehlsübertragungen über 
folgenden Menüvorgang fest:

[17] External Interfaces >
 External Control Switcher > Interval Time

4 Richten Sie das Senden von 
Änderungsbenachrichtigungen für die Übertragungsquelle 
über folgenden Menüvorgang ein:

[17] External Interfaces >
 External Control Switcher > Response

On Änderungsbenachrichtigung an die 
Übertragungsquelle senden.

Off Keine Änderungsbenachrichtigung an die 
Übertragungsquelle senden.

5 Legen Sie die IP-Adresse des verbundenen externen 
Geräts über folgenden Menüvorgang fest:

[17] External Interfaces >
 External Control AUX Panel > IP AddressXX

6 Legen Sie die Empfangsportnummer, die vom 
verbundenen externen Gerät verwendet wird, über 
folgenden Menüvorgang fest:

[17] External Interfaces >
 External Control AUX Panel > Port No

 p Beim Verbinden mit einer Kamera-Steuerungseinheit der 
AW-RP-Reihe auf 60031 einstellen.

7 Informationen zum Parameter DMSG-CONTROL der über 
TSL-UMD-Protokoll V5.0 übertragenen Befehle

Rote Tally-Einstellungen werden ausgegeben, wenn 
RH-Tally ausgegeben wird.
Grüne Tally-Einstellungen werden ausgegeben, wenn 
TXT-Tally ausgegeben wird.

8 Der folgende Posten muss auf “User” eingestellt sein, falls 
Materialnamen geändert werden sollen:

[10] Input >
 INx > Name Type

<Befehlsspezifikationen>
Siehe die Protokollspezifikationen des AV-HSW10 für die 
Kommunikation mit externen Schnittstellen.
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<Übersicht>
Sie können mehrere Kameras mit diesem Gerät verbinden und zwischen diesen umschalten. Da die Farbdarstellung der 
einzelnen Kameras sich voneinander unterscheiden kann, kommt es beim Umschalten möglicherweise zu ungewünschten 
Eindrücken. Daher müssen Sie einen Abgleich vornehmen, damit nach den Anpassungen für die einzelnen Kameras die 
Farbdarstellung der unterschiedlichen Kameras der Darstellung der Hauptkamera entspricht. Diese Funktion gehört zu den 
Einstellmöglichkeiten des Geräts, sodass der Farbabgleich erleichtert wird.

<Einstellungen>
1 Verwenden Sie die Funktionen der einzelnen Kameras, 

um die jeweiligen Anpassungen vorzunehmen. Die 
Funktionsanpassung kann nicht mit diesem Gerät 
erfolgen. Beachten Sie die Bedienungsanleitung usw. der 
verwendeten Geräte.

2 Legen Sie eine Hauptkamera fest, und gleichen Sie die 
24 Punkte der Farbreferenzkarte (Macbeth-Karte) mit 
den Markern ab (oder gleichen Sie die Marker ab), und 
erstellen Sie eine Aufzeichnung.

 p In dieser Beschreibung gehen wir davon aus, dass Sie 
eine Macbeth-Karte verwenden, aber es funktioniert 
auch mit jeder anderen Farbreferenzkarte.

3 Gleichen Sie die anderen Kameras nacheinander auf 
dieselbe Weise mit den 24 Punkten der Macbeth-Karte 
ab. Verwenden Sie anschließend die Aufzeichnung der 
Hauptkamera für die Kalibrierung.

 p Die Parameter werden durch den Vergleich der 
extrahierten 24 Punkte miteinander ermittelt. Allerdings 
kann die Kalibrierung niemals zu einer absoluten 
Farbgleichheit führen. Vielmehr dient sie dazu, die 
Variationen insgesamt auf ein Minimum zu reduzieren.
 pWenn die Kameraeinstellungen aufgrund veränderte 
Bedingungen usw. geändert werden, müssen Sie auch 
den Farbabgleich erneut durchführen. Daher empfehlen 
wir, einen automatischen Abgleich der Kamera zu 
deaktivieren.

Automatischer Farbtonabgleich
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Aufzeichnung der Hauptkamera

1 Wählen Sie den Zieleingang über folgenden Menüvorgang:

[19] Color Adjust > 
 Target

2 Zeigen Sie über folgenden Menüvorgang einen Marker auf 
dem Zieleingang an:

[19] Color Adjust > 
 Marker

3 Legen Sie die Markerposition über folgenden 
Menüvorgang fest:

[19] Color Adjust > 
 Left

[19] Color Adjust > 
 Top

[19] Color Adjust > 
 Bottom

[19] Color Adjust > 
 Right

[19] Color Adjust > 
 Set capture points

Left Markieren Sie die linke Kante des Bereichs, in 
dem der Punkt erzeugt werden soll.

Top Markieren Sie die obere Kante des Bereichs, in 
dem der Punkt erzeugt werden soll.

Bottom Markieren Sie die untere Kante des Bereichs, in 
dem der Punkt erzeugt werden soll.

Right Markieren Sie die rechte Kante des Bereichs, in 
dem der Punkt erzeugt werden soll.

Set capture 
points

Im angegebenen Bereich werden 24 Punkte in 
einem 6×4-Raster (vertikal × horizontal) erzeugt.

 

Left, Top 

Bottom, Right 

4 Passen Sie die Markerpositionen über folgenden 
Menüvorgang an:

[19] Color Adjust > 
 Points > Point x

5 Wählen Sie die Stelle zur Aufzeichnung der Farbe der 
Markerposition über folgenden Menüvorgang:

[19] Color Adjust > 
 Parameter No

6 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um die markierte Stelle aufzuzeichnen:

[19] Color Adjust > 
 Capture for Master

 pWenn bereits eine Aufzeichnung vorliegt, wird diese 
überschrieben.

7 Legen Sie den Namen für die Aufzeichnung über 
folgenden Menüvorgang fest:

[19] Color Adjust > 
 Parameters > Parameter x > Name

Kalibrieren der anderen Kameras
1 Wählen Sie den Zieleingang über folgenden Menüvorgang:

[19] Color Adjust > 
 Adjust Target

2 Gleichen Sie die Marker ab.
 Siehe  bis  unter “Aufzeichnung der Hauptkamera”.

3 Wählen Sie die Aufzeichnung der Hauptkamera, die als 
Kalibrierreferenz verwendet werden soll, über folgenden 
Menüvorgang:

[19] Color Adjust > 
 Parameter No

4 Drücken Sie den OSD/TIME-Knopf (Ausführen) im 
folgenden Menü, um den Farbabgleich vorzunehmen:

[19] Color Adjust > 
 Adjust Target

 p “[19] Color Corrector > Enable Color Adjust” wird 
automatisch in “Enable” geändert. Wählen Sie hier 
“Disable” aus, um den Abgleich zu deaktivieren.

Automatischer Farbtonabgleich
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Maßzeichnungen
Einheit: mm

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

U
S
B

LEVEL

175

254

67
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Spezifikationen

Stromversorgung:  Gleichstrom (DC, ), 16 V, spezieller 
Netzadapter

Leistungsaufnahme: 3,0 A (48 W)

 ist die Sicherheitsinformation.

Allgemeines
Umgebungstemperatur für 
den Betrieb

0 °C bis 40 °C

Umgebungsluftfeuchtigkeit 
im Betrieb

10 % bis 90 % (Keine Kondensation)

Lagertemperatur 0 °C bis 40 °C
Lagerfeuchtigkeit 10 % bis 90 % (Keine Kondensation)
Gewicht Ca. 1,8 kg
Abmessungen
(B × H × T)

254 mm × 67 mm × 175 mm (gemessen ohne Überstände)

Videoanschlüsse
Anschlüsse <SDI IN 1> bis 
<SDI IN 4>

4 Leitungen
 p Anschlüsse: BNC × 4
 p Mit Frame-Synchronizer.
 p Die Anschlüsse <SDI IN 1> und <SDI IN 2> verfügen über vereinfachte Formatkonverter, die 
Anschlüsse <SDI IN 3> und <SDI IN 4> über Hochleistungs-Formatkonverter.

 p Die Anschlüsse <SDI IN 1> bis <SDI IN 4> sind mit einer vereinfachten Farbkorrektur 
ausgestattet.

*  SDI IN 1 schließt HDMI IN 1 aus.
3G-SDI 3G-SDI, erfüllt den Standard SMPTE424M (kompatibel mit Level-A/Level-B)

 p 0,8 V [p-p] ± 10 % (75 Ω)
 p Automatischer Entzerrer 100 m (bei Verwendung eines Kabels)

HD-SDI HD-SDI, erfüllt den Standard SMPTE292M
 p 0,8 V [p-p] ± 10 % (75 Ω)
 p Automatischer Entzerrer 100 m (bei Verwendung eines Kabels)

Anschlüsse <HDMI IN 1>, 
<HDMI IN 2>

2 Leitungen, HDMI1.4b-kompatibel
Videoformat-Eingänge:
720p/59,94 Hz, 720p/50 Hz, 1080i/59,94 Hz, 1080i/50 Hz, 1080p/59,94 Hz, 1080p/50 Hz, 
1080p/29,97 Hz, 1080p/25 Hz, 1080p/24 Hz, 1080p/23,98 Hz
PC-Format-Eingänge:
WSXGA+ (1680 × 1050, 60 Hz), SXGA (1280 × 1024, 60 Hz), WXGA (1280 × 768, 60 Hz), 
XGA (1024 × 768, 60 Hz)
Modus: Full/Fit-H/Fit-V 

 p Mit Frame-Synchronizer und vereinfachter Farbkorrektur.
 p HDMI IN 2 mit Scaler.
 p Anschlüsse: HDMI × 2
 p Dieser Anschluss unterstützt die CPRM-Verfahren nicht.

*  HDMI IN 1 schließt SDI IN 1 aus.
Anschlüsse <SDI OUT 1>, 
<SDI OUT  2>

2 Leitungen
 p Anschlüsse: BNC × 2
 p PGM, PVW, CLN, MV, AUX1/2 und Key Out können zugewiesen werden.

3G-SDI 3G-SDI, erfüllt den Standard SMPTE424M (kompatibel mit Level-A)
 p 0,8 V [p-p] ± 10 % (75 Ω)

HD-SDI HD-SDI, erfüllt den Standard SMPTE292M
 p 0,8 V [p-p] ± 10 % (75 Ω)

<HDMI OUT>-Anschluss 1 Leitung, HDMI1.4b-kompatibel
 p Anschluss: HDMI × 1
 p Mit Scaler.

Modus: Fit-V, Fit-H, Full, Full-90%, Full-80%
 p PGM, PVW, CLN, MV, AUX1/2 und Key Out können zugewiesen werden.
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<LAN>-Anschluss Kompatibel mit 1000Base-T und AUTO-MDIX (für IP-Übertragung/-Steuerung)
 p Anschlusskabel: LAN-Kabel (CAT5E oder besser), max. 100 m, STP-Kabel (Shielded Twisted 
Pair) empfohlen

 p Anschluss: RJ-45
 IP-Eingangssignal
Zugewiesen zu IN 6 bis 9.

 p IN 6, IN 7: wählbar von SRT/NDI|HX (Version 1/Version 2).
 p IN 8, IN 9: reserviert für NDI-Eingang mit hoher Bandbreite. 
Unterstützt NDI-α-Kanaleingang; wird dabei als Paar mit IN 9 verwendet.

 IP-Ausgangssignal
Zugewiesen zu OUT 4 und OUT 5.

 p OUT 4, OUT 5: wählbar von SRT/High Bandwidth NDI/RTMP.
 p PGM, PVW, CLN, MV, AUX1/2, Key Out können zugewiesen werden.
 p Mit Scaler und i/p-Umwandlung.
 p Mögliche Ausgabeformate: 
1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps 
1280 × 720/60fps, 50fps

<USB>-Anschluss Anschluss für Ausgabe von UVC/UAC
Zugewiesen zu OUT 6

 p Anschluss: USB3.2 Gen1 Typ C, keine USB-Stromversorgung
 p PGM, PVW, CLN, MV, AUX1/2 und Key Out können zugewiesen werden.
 p Mit Scaler und i/p-Umwandlung
 p Mögliche Ausgabeformate: 
1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps* 
1280 × 720/60fps, 50fps, 30fps, 25fps, 24fps

*  Unterstützung nach Firmware-Update geplant
Systemformat 1080/59,94p, 50p, 29,97p, 25p, 24p, 23,98p, 59,94i, 50i

720/59,94p, 50p
Signalverarbeitung R:G:B 4:4:4 8Bit / 4:2:2 10Bit (bei HDMI)

Y:Cb:Cr 4:2:2 10Bit
ME-Nummer 1ME

Audioanschlüsse
<AUDIO IN>-Anschluss  p L/1 und R/2

 p Anschluss: Klinkenbuchse
 p Mit integrierter Funktion für jeden Ausgang
 p Mit Verzögerung/Pegelanpassung

<AUDIO OUT>-Anschluss Anschluss für Monitoring-Kopfhörer
 p Anschluss: Φ3,5 mm TRS
 p Mit Regler für Lautstärkeausgang

Synchronisierungsanschlüsse
<REF>-Anschlüsse  
Referenzeingang

Im Genlock-Modus: wählbar von BB (Black Burst), Tri-Level-Sync und interner Synchronisation
 p Im BB- und Tri-Level-Sync-Modus erfolgt eine Loop-Through-Ausgabe.
 pWenn keine Loop-Through-Ausgabe erfolgen soll, verwenden Sie einen 
75-Ω-Abschlusswiderstand.

 p Anschlüsse: BNC×2
 p Es werden die gleichen Feldfrequenzen wie bei den Systemformaten unterstützt.
 p Für 23,98 Hz und 24 Hz werden nur Tri-Level-Eingang oder interne Synchronisation unterstützt.

Video-Verzögerungszeit 1 Leitung (H) Wenn der Frame-Synchronizer auf [Off] eingestellt ist und weder Upkonverter 
noch Downkonverter aktiv sind

1 Vollbild (F) Wenn der Frame-Synchronizer eingeschaltet ist und Upkonverter und 
Downkonverter aktiv sind

 pWenn die Signale PinP, Mehrfeld, Abwärtswandler oder HDMI IN durchlaufen haben, wird eine 
maximale Verzögerung von 1 Vollbild in jedem Fall angewendet.

Spezifikationen
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Spezifikationen
Steuerungsanschlüsse
<LAN>-Anschluss Kompatibel mit 1000Base-T und AUTO-MDIX (für IP-Steuerung)

 p Verbindungskabel: LAN-Kabel (CAT5E), max. 100 m, STP-Kabel (Shielded Twisted Pair) 
empfohlen

 p Anschluss: RJ-45
Anschlüsse <TALLY GPI> INPUT: 5 Eingänge, Mehrzweck, Optokopplerabtastung

OUTPUT: 8 Ausgänge, gewählt von R/G-Tally, Mehrzweck 
ALARM: 1 Ausgang, Open-Collector-Ausgang (negative Logik)

 p Anschlüsse: D-Sub 15-polig
<USB>-Anschluss  p Anschluss: USB2.0/Typ A, mit USB-Stromversorgung

Verwenden Sie ein USB-Speichergerät zum Speichern und Laden von Konfigurationsdateien und 
Standbilddaten sowie zum Durchführen von Firmware-Aktualisierungen.

Netzadapter

Nenneingangsstrom:  100 V – 240 V Wechselstrom ( ) 50 Hz/60 Hz 
1,6 A – 0,9 A

Nennausgangsstrom: 16 V Gleichstrom ( ), 4,06 A

 ist die Sicherheitsinformation.
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

1 WIPE 1 BKGD Pattern Einstellbereich Einzelne Muster auswählen (Seite  32)

Standardwert 5

2 BKGD 
Transition

Direction Einstellbereich Normal, Reverse, N/R

Standardwert Normal

Border Einstellbereich
Border

On, Off
Width

0.1 bis 100.0

Standardwert Off 5.0

Einstellbereich
Soft

0.0 bis 100.0

Standardwert 0.0

Border Color
Einstellbereich

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 bis 359.9

Standardwert White 0.0

Einstellbereich
Sat

0.0 bis 100.0
Lum

0.0 bis 108.0

Standardwert 0.0 100.0

Position Einstellbereich X- 
Position

–100.00 bis 100.00 Y- 
Position

–100.00 bis 100.00

Standardwert 0.00 0.00

3 Key1 Pattern Einstellbereich Einzelne Muster auswählen (Seite 37)

Standardwert 5

4 Key1 
Transition

Type Einstellbereich MIX, WIPE

Standardwert MIX

Keyout Pattern Einstellbereich Normal, Reverse

Standardwert Normal

Position Einstellbereich X- 
Position

–100.00 bis 100.00 Y- 
Position

–100.00 bis 100.00

Standardwert 0.00 0.00

2 CBGD 1 CBGD Select Einstellbereich CBGD1, CBGD2

Standardwert CBGD1

2 CBGD Main Load Einstellbereich White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Standardwert Blue, Red

Hue Einstellbereich 0.0 bis 359.9

Standardwert 120.0, 0.0

Sat Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Lum Einstellbereich 0.0 bis 108.0

Standardwert 100.0

3 CBGD Sub Load Einstellbereich White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Standardwert White

Hue Einstellbereich 0.0 bis 359.9

Standardwert 0.0

Sat Einstellbereich 0.0 bis 100.0

Standardwert 0.0

Lum Einstellbereich 0.0 bis 108.0

Standardwert 100.0

4 CBGD Wash Wash Einstellbereich On, Off

Standardwert Off

Color Einstellbereich Dual, Rainbow

Standardwert Dual

Rainbow Sat Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Rainbow Lum Einstellbereich 0.0 bis 108.0

Standardwert 100.0
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

2 CBGD 5 CBGD Wave Pattern Einstellbereich Sine, Saw

Standardwert Sine

Cycle Einstellbereich 0.0 bis 100.0

Standardwert 0.0

Phase Einstellbereich –180.0 bis 180.0

Standardwert 0.0

Angle Einstellbereich 0.0 bis 360.0

Standardwert 0.0

6 CBGD Move Move Einstellbereich Off, Roll, Rotation

Standardwert Off

Speed Einstellbereich –50.0 bis 50.0

Standardwert 1.0

3 Key 1 Key Select Einstellbereich Key1, Key2

Standardwert Key1

2 Key Type Einstellbereich Lum (ChromaOff), Lum (ChromaOn), Linear, Chroma, Full

Standardwert Linear

3 Fill Einstellbereich Bus, Matte

Standardwert Bus

4 PVW Einstellbereich Off, On

Standardwert Off

5 Key Adjust Clip Einstellbereich 0.0 bis 108.0

Standardwert 0.0

Gain Einstellbereich 0.0 bis 200.0

Standardwert 100.0

Density Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Invert Einstellbereich On, Off

Standardwert Off

6 Fill Matte Load Einstellbereich White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Standardwert White

Hue Einstellbereich 0.0 bis 359.9

Standardwert 0.0

Sat Einstellbereich 0.0 bis 100.0

Standardwert 0.0

Lum Einstellbereich 0.0 bis 108.0

Standardwert 100.0

7 Edge Type Einstellbereich Off, Border, Drop, Shadow, Outline

Standardwert Off

Width Einstellbereich 0 bis 4

Standardwert 2

Direction Einstellbereich 0, 45, 90, 135, 180, 225, 270, 315

Standardwert 0

Density Einstellbereich 25%, 50%, 75%, 100%

Standardwert 100%

Fill Einstellbereich Color, CBGD1, CBGD2, Still1, Still2

Standardwert Color
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

3 Key 7 Edge Color
Einstellbereich

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 bis 359.9

Standardwert Black 0.0

Einstellbereich
Sat

0.0 bis 100.0
Lum

0.0 bis 108.0

Standardwert 0.0 0.0

8 Mask Size Einstellbereich Off, Manual, 4:3

Standardwert Off

Invert Einstellbereich On, Off

Standardwert Off

Position Einstellbereich
Left

–50.00 bis 50.00
Top

–50.00 bis 50.00

Standardwert –25.00 25.00

Einstellbereich
Bottom

–50.00 bis 50.00
Right

–50.00 bis 50.00

Standardwert –25.00 25.00

9 PinP PinP Einstellbereich On, Off

Standardwert Off

Shape Einstellbereich Square, Circle, Heart, Flower, Star

Standardwert Square

Density Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Full Key Einstellbereich On, Off

Standardwert On

Border Einstellbereich
Border

Off, On
Width

0.1 bis 100.0

Standardwert Off 5.0

Einstellbereich
Soft

0.0 bis 100.0
Mode

Fix, Variable

Standardwert 0.0 Fix

Einstellbereich

Color

Load
White, Yellow, Cyan, Green, Magenta, 
Red, Blue, Black

Standardwert Black

Einstellbereich
Hue

0.0 bis 359.9

Standardwert 0.0

Einstellbereich
Sat

0.0 bis 100.0

Standardwert 0.0

Einstellbereich
Lum

0.0 bis 108.0

Standardwert 0.0

Position Einstellbereich X- 
Position

–100.00 bis 100.00 Y- 
Position

–100.00 bis 100.00

Standardwert 0.00 0.00

Einstellbereich
Size

0.00 bis 100.00

Standardwert 25.00
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

3 Key 9 PinP Trim Einstellbereich
Trim

Off, On
Pair

Off, On

Standardwert Off Off

Einstellbereich
Preset

16:9, 12:9, 9:9, 7:9, 6:9, Manual

Standardwert 16:9

Einstellbereich

Adjust

Left
–50.00 bis 50.00

Standardwert –50.00

Einstellbereich
Top

–50.00 bis 50.00

Standardwert 50.00

Einstellbereich
Bottom

–50.00 bis 50.00

Standardwert –50.00

Einstellbereich
Right

–50.00 bis 50.00

Standardwert 50.00

Sync
Einstellbereich

Symmetry
Off, X, Y, Center, 
Same Copy to 

KEY

Execute

Standardwert Off

10 Key Signal 
Coupling

Einstellbereich Coupling, Independent

Standardwert Coupling

11 Key Priority Key Einstellbereich 1st, 2nd

Standardwert 2nd

4 ChromaKey 1 Marker Einstellbereich On, Off

Standardwert Off

2 Sample Einstellbereich Execute

Standardwert Execute

3 Marker 
Position

X-Position Einstellbereich –50.00 bis 50.00

Standardwert 0,00

Y-Position Einstellbereich –50.00 bis 50.00

Standardwert 0.00

Size Einstellbereich 1.00 bis 80.00

Standardwert 10.00

4 Marker Aspect Einstellbereich –50.00 bis 50.00

Standardwert 0.00

5 Ref Adjust Hue Einstellbereich 0.0 bis 359.9

Standardwert 354.0

Sat Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Lum Einstellbereich 0.0 bis 108.0

Standardwert 7.00

6 Y-Influence Einstellbereich 0.0 bis 100.0

Standardwert 0.0

7 Radius Hue Einstellbereich 0.0 bis 100.0

Standardwert 100.0

Sat Einstellbereich 0.0 bis 100.0

Standardwert 50.0

8 Soft Einstellbereich 0.0 bis 100.0

Standardwert 0.0

9 Cancel Einstellbereich 0.0 bis 100.0

Standardwert 0.0
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

5 TIME 1 BKGD Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

2 Key1 Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

3 Key2 Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

4 FTB Trans Time Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

Source Einstellbereich Still1, Still2, CBGD1, CBGD2, White, Black

Standardwert Black

Mute Einstellbereich Off, On

Standardwert Off

5 Effect Dissolve Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

6 AUX1 Bus 
Trans

Transition Einstellbereich Off, On

Standardwert Off

Trans Time Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

7 AUX2 Bus 
Trans

Transition Einstellbereich Off, On

Standardwert Off

Trans Time Einstellbereich 0 bis 999 (Frame)

Standardwert 1s00f

6 Still 1 Still Select Einstellbereich Still1, Still2

Standardwert Still1

2 Key Status Einstellbereich On, Off

Standardwert –

3 Capture Einstellbereich Execute

Standardwert

4 Capture 
Setting

Video Einstellbereich AUX1, AUX2

Standardwert AUX1

Key Enable Einstellbereich On, Off

Standardwert On

Key Einstellbereich AUX1, AUX2

Standardwert AUX1

Review Einstellbereich On, Off

Standardwert On

5 Test Pattern Load Einstellbereich Execute

Standardwert

7 Shot Memory 1 Target Select ME Einstellbereich On, Off

Standardwert On

AUX Einstellbereich On, Off

Standardwert On

CBGD Einstellbereich On, Off

Standardwert On

2 Effect Einstellbereich Cut, Dissolve

Standardwert Dissolve

3 Hue Path Einstellbereich Short, Long, CW, CCW

Standardwert Short

4 XPT DSBL Einstellbereich Off, On

Standardwert Off
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

8 XPT Assign 1 XPT1
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN1

2 XPT2
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN2

3 XPT3
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN3

4 XPT4
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN4

5 XPT5
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN5

6 XPT6
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN6

7 XPT7
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN7

8 XPT8
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN8

9 XPT9
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert IN9

10 XPT10
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert CBAR

11 XPT11
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert CBGD1

12 XPT12
Einstellbereich

IN1 bis 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Standardwert CBGD2

13 Switch Timing Einstellbereich Any, Field1, Field2

Standardwert Any
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

9 MultiView

**********: 
Name des aktuell 
eingestellten 
Materials

1 Split
Einstellbereich

4Split, 5-aSplit, 5-bSplit, 6-aSplit, 6-bSplit, 9Split, 10-aSplit, 
10-bSplit, 12Split, 16Split

Standardwert 10-aSplit

2 Size Einstellbereich Fit, SQ

Standardwert SQ

3 Source Select Pos1 Source

Einstellbereich

IN1 bis 9 (**********),
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert PGM

Pos2 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert PVW

Pos3 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN1

Pos4 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP-OUT1, IP-OUT2

Standardwert IN2

Pos5 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN3

Pos6 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN4

Pos7 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN5

Pos8 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN6

Pos9 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN7

Pos10 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN8
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

9 MultiView

**********: 
Name des aktuell 
eingestellten 
Materials

3 Source Select Pos11 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert IN9

Pos12 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert Still1V

Pos13 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert Still2V

Pos14 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert CBAR

Pos15 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert CBGD1

Pos16 Source

Einstellbereich

IN1 bis 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Standardwert CBGD2

4 MV Frame Einstellbereich LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Standardwert LUM75%

5 MV Character Einstellbereich LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Standardwert LUM75%

6 MV Label Einstellbereich On, Off

Standardwert On

7 Red Tally Box Einstellbereich On, Off

Standardwert Off

Label Left Einstellbereich On, Off

Standardwert Off

Label Right Einstellbereich On, Off

Standardwert Off

8 Green Tally Box Einstellbereich On, Off

Standardwert Off

Label Left Einstellbereich On, Off

Standardwert Off

Label Right Einstellbereich On, Off

Standardwert Off
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

9 MultiView 9 Display Level Meter Einstellbereich OFF, IN ON, OUT ON, IN/OUT ON

Standardwert OFF

Input Status Einstellbereich On, Off

Standardwert On

Marker Einstellbereich 4:3, 16:9, Off

Standardwert Off

Marker Size Einstellbereich 80 bis 100%

Standardwert 95%

Obere Ebene
Nr. Untermenü Einstellungsposten Einstellung
10 Input 1 IN1(SDI1/

HDMI1)

Nur Anzeige
Menü für 
nächste 
Ebene

Ruft die Unterebene A auf

2 IN2(SDI IN2)

3 IN3(SDI IN3)

4 IN4(SDI IN4)

5 IN5(HDMI IN2)

6 IN6(IP IN1) Ruft die Unterebene B auf

7 IN7(IP IN2)

8 IN8(IP IN3)

9 IN9(IP IN4)

Unterebene A
Nr. Untermenü Einstellungsposten Einstellung

SDI1/HDMI1 1 SDI/HDMI Einstellbereich SDI, HDMI

Standardwert SDI

SDI IN XX 2 Status Format
Nur Anzeige

Audio

3 FS Mode Einstellbereich Off, Normal, Auto

Standardwert Auto

4 FS Delay
Einstellbereich

0F bis 6F

 p SDI IN1 ist 0F bis 2F
Standardwert 0F

5 Freeze Einstellbereich Disable, Enable

Standardwert Disable

6 Freeze Select Einstellbereich Frame, Field

Standardwert Frame

7 Name Type Einstellbereich Default, User

Standardwert Default

8 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

9 Up/Down 
Converter

Move Detect Einstellbereich 1 bis 5

Standardwert 5

Sharp Einstellbereich 1 bis 5

Standardwert 3
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Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung

SDI IN XX 10 Color Correct C/C Einstellbereich On, Off

Standardwert Off

C/C Process Einstellbereich
Y-Gain

0.0 bis 200.0
Pedestal

–20.0 bis 20.0

Standardwert 100.0 0.0

Einstellbereich
C-Gain

0.0 bis 200.0
Hue

0.0 bis 359.9

Standardwert 100.0 0.0

11 Camera Setting IP Address Einstellbereich IP-Adressauswahl

Standardwert

Port Einstellbereich 1 bis 65535

Standardwert 80

Edit IP Address Einstellbereich Execute

Standardwert

Scan IP Address Einstellbereich Execute

Standardwert

Edit User Name Einstellbereich Execute

Standardwert

Edit Password Einstellbereich Execute

Standardwert

Name Einstellbereich Name, der in der Kamera gespeichert ist

Standardwert

Network Status
Einstellbereich

No IP Address, Now Checking…, Connected, Unauthorized, 
Not Connected

Standardwert No IP Address

Red Tally Einstellbereich Disable, Enable

Standardwert Enable

Green Tally Einstellbereich Disable, Enable

Standardwert Enable

HDMI IN XX 2 Status Size

Nur Anzeige
Dot Clock

H-Frequency

V-Frequency

3 Freeze Einstellbereich Disable, Enable

Standardwert Disable

4 Freeze Select Einstellbereich Frame, Field

Standardwert Frame

5 Limited Einstellbereich On, Off

Standardwert Off

6 Name Type Einstellbereich Default, User

Standardwert Default

7 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

8 Scale Einstellbereich Fit-V, Fit-H, Full

Standardwert Full

9 Color Correct C/C Einstellbereich On, Off

Standardwert Off

C/C Process Einstellbereich
Y-Gain

0.0 bis 200.0
Pedestal

–20.0 bis 20.0

Standardwert 100.0 0.0

Einstellbereich
C-Gain

0.0 bis 200.0
Hue

0.0 bis 359.9

Standardwert 100.0 0.0
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Nr. Untermenü Einstellungsposten Einstellung

HDMI IN XX 10 Kameraeinstellung IP Address Einstellbereich IP-Adressauswahl

Standardwert

Port Einstellbereich 1 bis 65535

Standardwert 80

Edit IP Address Einstellbereich Execute

Standardwert

Scan IP Address Einstellbereich Execute

Standardwert

Edit User Name Einstellbereich Execute

Standardwert

Edit Password Einstellbereich Execute

Standardwert

Name Einstellbereich Name, der in der Kamera gespeichert ist

Standardwert

Network Status
Einstellbereich

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Standardwert No IP Address

Red Tally Einstellbereich Disable, Enable

Standardwert Enable

Green Tally Einstellbereich Disable, Enable

Standardwert Enable

Unterebene B
Nr. Untermenü Einstellungsposten Einstellung

IP IN1,2 1 Streaming 
Mode

Einstellbereich NDI|HX, SRT (ausgewählte Quelle wird unten angezeigt)

Standardwert NDI|HX

IP IN3,4 1 Streaming 
Mode

Einstellbereich NDI

Standardwert NDI

NDI IN XX 2 Status Format

Nur Anzeige

Sampling Rate

Audio Channel

Frame Data

Compress

Streaming Mode

3 Alpha Settings Use Alpha Einstellbereich Disable, Enable

Standardwert Disable

Type
Nur Anzeige

Alpha Signal

Key Source 
BKGD

Einstellbereich White, Black

Standardwert White

4 Machine Name
Nur Anzeige

5 Source Name 

6 Scan Mode Einstellbereich HB/HX v2, HX v1

Standardwert HB/HX v2

7 Scan Einstellbereich In anderes Menü wechseln (Liste der Scanergebnisse)

Standardwert

8 Protocol Einstellbereich TCP, UDP

Standardwert TCP
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Nr. Untermenü Einstellungsposten Einstellung

NDI IN XX 9 Group Group Einstellbereich Disable, Enable

Standardwert Disable

Group Name Einstellbereich Es können 64 Zeichen eingegeben werden.

Standardwert

10 Use Discovery 
server

Use Discovery 
server

Einstellbereich Disable, Enable

Standardwert Disable

Discovery server 
IP

Einstellbereich IP-Adresseingabe

Standardwert

11 RTSP Port Einstellbereich 1 bis 65535

Standardwert 554

Request URL Einstellbereich Es können 255 Zeichen eingegeben werden.

Standardwert MediaInput/h264/stream_1

Connect Einstellbereich Execute

Standardwert

12 Name Type Einstellbereich Default, User

Standardwert Default

13 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

14 Camera 
Setting

Control Einstellbereich Panasonic, NDI

Standardwert Panasonic

IP-Adresse Einstellbereich IP-Adressauswahl

Standardwert

Port Einstellbereich 1 bis 65535

Standardwert 80

Edit IP Address Einstellbereich Execute

Standardwert

Scan IP Address Einstellbereich Execute

Standardwert

Edit User Name Einstellbereich Execute

Standardwert

Edit Password Einstellbereich Execute

Standardwert

Name Einstellbereich Name, der in der Kamera gespeichert ist

Standardwert

Network Status
Einstellbereich

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Standardwert No IP Address

Red Tally Einstellbereich Disable, Enable

Standardwert Enable

Green Tally Einstellbereich Disable, Enable

Standardwert Enable
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Nr. Untermenü Einstellungsposten Einstellung

SRT IN XX 2 Status Format

Nur Anzeige

Videoformat (1080/59.94p usw.)

Sampling Rate

Audio Channel

Compress H.264/H.265

3 Name Type Einstellbereich Default, User

Standardwert Default

4 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

5 Mode Einstellbereich Caller, Listener

Standardwert Caller

6 Server URL Einstellbereich URL eingeben: 1 bis 254 Zeichen

Standardwert

7 Server Port Einstellbereich 0 bis 65535

Standardwert 30000

8 Stream ID Einstellbereich Es können 512 Zeichen eingegeben werden.

Standardwert

9 Port Einstellbereich 1024 bis 65535

Standardwert 2020

10 Encryption Einstellbereich Disable, Enable

Standardwert Disable

11 Passphrase Einstellbereich Es können 10 bis 79 Zeichen eingegeben werden.

Standardwert

12 Camera 
Setting

IP Address Einstellbereich IP-Adressauswahl

Standardwert

Port Einstellbereich 1 bis 65535

Standardwert 80

Edit IP Address Einstellbereich Execute

Standardwert

Scan IP Address Einstellbereich Execute

Standardwert

Edit User Name Einstellbereich Execute

Standardwert

Edit Password Einstellbereich Execute

Standardwert

Name Einstellbereich Name, der in der Kamera gespeichert ist

Standardwert

Network Status
Einstellbereich

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Standardwert No IP Address

Red Tally Einstellbereich Disable, Enable

Standardwert Enable

Green Tally Einstellbereich Disable, Enable

Standardwert Enable
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Obere Ebene
Nr. Untermenü Einstellungsposten Einstellung

11 Output 1 OUT1(SDI 
OUT1)

Nur Anzeige
Menü für 
nächste 
Ebene

Ruft die Unterebene A auf

2 OUT2(SDI 
OUT2)

Ruft die Unterebene A auf

3 OUT3(HDMI 
OUT)

Ruft die Unterebene B auf

4 OUT4(IP 
OUT1)

Ruft die Unterebene C auf

5 OUT5(IP 
OUT2)

Ruft die Unterebene C auf

6 OUT6(UVC 
OUT)

Ruft die Unterebene D auf

Unterebene A
Nr. Untermenü Einstellungsposten Einstellung

SDI OUT XX 1 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

Einstellungsmenü-Tabelle
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Unterebene B
Nr. Untermenü Einstellungsposten Einstellung

HDMI OUT 1 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert MV

2 Size Einstellbereich Auto, XGA, WXGA, SXGA, WSXGA+, Native

Standardwert Auto

3 color Einstellbereich Auto, RGB, YUV444, YUV422

Standardwert Auto

4 Scale Einstellbereich Fit-V, Fit-H, Full, Full90%, Full80%

Standardwert Full

5 Move Detect Einstellbereich 1 bis 5

Standardwert 5

Unterebene C
Nr. Untermenü Einstellungsposten Einstellung

IP OUT XX 1 Streaming 
Mode

Einstellbereich NDI, SRT, RTMP (ausgewählte Quelle wird unten angezeigt)

Standardwert NDI

2 Streaming Link Einstellbereich On, Off

Standardwert Off

NDI OUT XX 3 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

4 Machine Name Einstellbereich Bis zu 20 Zeichen

Standardwert AV-HSW10

5 Source Name Nur Anzeige Einstellbereich Bis zu 32 Zeichen

Standardwert NDI Device xx

6 Protocol Einstellbereich TCP, UDP

Standardwert TCP

7 Multicast Multicast Einstellbereich Disable, Enable

Standardwert Disable

IP Address Einstellbereich IP-Adresseingabe

Standardwert 239.192.0.30

Subnet Mask Einstellbereich IP-Adresseingabe

Standardwert 255.0.0.0

TTL/HOP Limit Einstellbereich 1 bis 254

Standardwert 16

8 Group Group Einstellbereich Disable, Enable

Standardwert Disable

Group Name Einstellbereich Es können 64 Zeichen eingegeben werden.

Standardwert

9 Use Discovery 
server

Use Discovery 
server

Einstellbereich Disable, Enable

Standardwert Disable

Discovery server 
IP

Einstellbereich IP-Adresseingabe

Standardwert
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Nr. Untermenü Einstellungsposten Einstellung

SRT OUT XX 3 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

4 Assign STDBY Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

5 Mode Einstellbereich Caller, Listener

Standardwert Caller

6 Destination 
URL

Einstellbereich URL eingeben: 1 bis 254 Zeichen

Standardwert

7 Destination 
Port

Einstellbereich 0 bis 65535

Standardwert 30000

8 Stream ID Einstellbereich Es können 512 Zeichen eingegeben werden.

Standardwert

9 Port Einstellbereich 1024 bis 65535

Standardwert 2020

10 TTL/HOP limit Einstellbereich 1 bis 254

Standardwert 64

11 Latency(ms) Einstellbereich 0 bis 9999

Standardwert 20

12 Encryption Einstellbereich Disable, AES128, AES256

Standardwert Disable

13 Passphrase Einstellbereich Es können 10 bis 79 Zeichen eingegeben werden.

Standardwert

14 Codec Einstellbereich H.264, H.265

Standardwert H.264

15 Rate Control 
Mode

Einstellbereich CBR, VBR

Standardwert CBR

16 Target bit rate Einstellbereich 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Standardwert 14Mbps

17 Max bit rate Einstellbereich 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Standardwert 14Mbps
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Nr. Untermenü Einstellungsposten Einstellung

RTMP OUT XX 3 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

4 Assign STDBY Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

5 Server Einstellbereich 1 bis 3

Standardwert 1

6 Server URL Einstellbereich URL eingeben: 1 bis 254 Zeichen

Standardwert

7 Stream Key Einstellbereich Es können 512 Zeichen eingegeben werden.

Standardwert

8 Timeout (sec) Einstellbereich 1 bis 30

Standardwert 10

9 Codec Einstellbereich H.264

Standardwert H.264

10 Rate Control 
Mode

Einstellbereich CBR, VBR

Standardwert CBR

11 Target bit rate Einstellbereich 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Standardwert 14Mbps

12 Max bit rate Einstellbereich 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Standardwert 14Mbps

Unterebene D
Nr. Untermenü Einstellungsposten Einstellung

UVC OUT 1 Assign Einstellbereich PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Standardwert PGM

2 Menu Out Einstellbereich Off, On

Standardwert Off
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 1 Operate Menu Out Einstellbereich SDI OUT2, HDMI OUT, SDI2+HDMI

Standardwert SDI2+HDMI

Menu Size Einstellbereich FULL, Upper-Left, Upper-Right, Lower-Right, Lower-Left

Standardwert FULL

Menu Back Einstellbereich 70%, 80%, 90%, 100%

Standardwert 100%

Bus Mode Einstellbereich A/B, PGM-A/PST-B, PGM-B/PST-A

Standardwert PGM-A/PST-B

Time Unit Einstellbereich Sec, Frame

Standardwert Sec

Delegation Einstellbereich On, Off

Standardwert On

Fader Einstellbereich BKGD, KEY1, BKGD+KEY1, NoAssign

Standardwert BKGD

2 Key1/2 Link Einstellbereich Off, On

Standardwert Off

3 CBAR Type Einstellbereich Type1, Type2, Type3

Standardwert Type1

Test Tone Einstellbereich Normal, Low, Off

Standardwert Off

4 Button 
Illumination

Button 
Illumination

Einstellbereich
Dimmer

Off, On

Standardwert Off

Einstellbereich
Lighting

80%, 90%, 100%, 110%, 120%, 130%, 140%, 150%

Standardwert 150%

Einstellbereich XPT 
Color

Input, Color Group1, Color Group2, Color Group3, 
Color Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Standardwert Input

Color Group IN
Einstellbereich

IN1(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN2(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN3(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN4(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN5(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN6(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1



136

Einstellungsmenü-Tabelle
Nr. Untermenü Einstellungsposten Einstellung
12 Config 4 Button 

Illumination
Color Group IN

Einstellbereich
IN7(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN8(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
IN9(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Color Group 
Internal Einstellbereich

Black

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
CBGD1

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
CBGD2

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
CBAR

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Color Group Still
Einstellbereich

Still 1V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
Still 1K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
Still 2V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
Still 2K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 4 Button 

Illumination
Color Group Other

Einstellbereich
CLN

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
Key Out

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich
STREAM

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich AUX 
BUS 
DELEG

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Einstellbereich AUX 
SOURCE

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Standardwert Color Group1

Button Color 
Group1

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.1 0.1

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.1

Button Color 
Group2

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.1 0.1

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.0

Button Color 
Group3

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.0 0.1

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.1

Button Color 
Group4

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.0 0.1

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.0

Button Color 
Group5

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.1 0.0

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.1

Button Color 
Group6

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.1 0.0

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.0

Button Color 
Group7

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.0 0.0

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.1
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 4 Button 

Illumination
Button Color 
Group8

Einstellbereich
R

0.0 bis 1.5
G

0.0 bis 1.5

Standardwert 0.0 0.0

Einstellbereich
B

0.0 bis 1.5

Standardwert 0.0

5 User Button User 1
Einstellbereich

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12, XPT Disable

Standardwert Key1 PVW

User 2
Einstellbereich

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12, XPT Disable

Standardwert Key2 PVW

User 3
Einstellbereich

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12, XPT Disable

Standardwert Shot Memory1

User 4
Einstellbereich

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12, XPT Disable

Standardwert Shot Memory2

User 5 Einstellbereich Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12

Standardwert Shot Memory3

User 6
Einstellbereich

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 bis 
12

Standardwert Shot Memory4

6 AUX Name AUX1 Type Einstellbereich Default, User

Standardwert Default

AUX1 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

AUX2 Type Einstellbereich Default, User

Standardwert Default

AUX2 Name Einstellbereich Es können 32 Zeichen eingegeben werden.

Standardwert

7 GPI GPI-In Setting Einstellbereich GPI-In 
Enable

On, Off
AUX Sel

AUX1, AUX2

Standardwert Off AUX1

GPI-In Port

Einstellbereich Port1 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 bis 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Standardwert GTly DSBL

Einstellbereich Port2 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 bis 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Standardwert BKGD AUTO

Einstellbereich Port3 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 bis 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Standardwert BKGD CUT
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 7 GPI GPI-In Port

Einstellbereich Port4 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 bis 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Standardwert KEY1 ON

Einstellbereich Port5 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 bis 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Standardwert KEY2 ON

GPI-Out Setting Einstellbereich GPI-Out 
Enable

On, Off AUX Tly 
Sel

AUX1, AUX2

Standardwert On AUX1

GPI-Out Port

Einstellbereich Port 1 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert RTly SDI IN1

Einstellbereich Port 2 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert RTly SDI IN2

Einstellbereich Port 3 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert RTly SDI IN3

Einstellbereich Port 4 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert RTly SDI IN4

Einstellbereich Port 5 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert RTly HDMI IN2

Einstellbereich Port 6 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert KEY1 ON
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 7 GPI GPI-Out Port

Einstellbereich Port 7 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert No Assign

Einstellbereich Port 8 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 bis 4, RTly HDMI IN1, 2, RTly IP 
IN1 bis 4, GTly SDI IN1 bis 4, GTly HDMI IN1, 2, GTly 
IP IN1 bis 4, AUXTly SDI IN1 bis 4, AUXTly HDMI 
IN1, 2, AUXTly IP IN1 bis 4

Standardwert No Assign

8 Key Source 
Signal 
Coupling

Fill/Source Einstellbereich Fill To Source, Source To Fill

Standardwert Fill To Source

IN1(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN1

IN2(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN2

IN3(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN3

IN4(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN4

IN5(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN5

IN6(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN6

IN7(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN7

IN8(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN8

IN9(***)
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert IN9

Schwarz
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert Black
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Nr. Untermenü Einstellungsposten Einstellung
12 Config 8 Key Source 

Signal 
Coupling

CBGD 1
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert CBGD 1

CBGD 2
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert CBGD 2

CBAR
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert CBAR

Still 1V
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert Still 1V

Still 1K
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert Still 1K

Still 2V
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert Still 2V

Still 2K
Einstellbereich

IN1(***) bis IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Standardwert Still 2K

9 System Menu 
Lock

Einstellbereich On, Off

Standardwert Off

Einstellungsmenü-Tabelle
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Nr. Untermenü Einstellungsposten Einstellung
13 System 1 System Format

Einstellbereich
1080/59.94p, 50p, 59.94i, 50i, 29.97p, 25p, 24p, 23.98p, 
720/59.94p, 50p

Standardwert 1080/59.94p

2 Reference Reference Select Einstellbereich BB, Tri-Level-Sync, Internal

Standardwert BB

Status Einstellbereich

Standardwert

3 Output Phase System Einstellbereich 0H, 1H

Standardwert 0H

H-Phase Einstellbereich – 0.50 bis 0.49

Standardwert 0.00

V-Phase Einstellbereich – 100 bis 100

Standardwert 0

4 User Auth User Name Einstellbereich

Standardwert

Password Einstellbereich Execute

Standardwert

5 Alarm Power Einstellbereich Alarm, No Alarm

Standardwert

Fan Einstellbereich Alarm, No Alarm

Standardwert

Temperature Einstellbereich Alarm, No Alarm

Standardwert

6 Tally Settings Tally Mode Einstellbereich Off, On

Standardwert On

Tally Target

Einstellbereich Red 
Tally

Off, PGM, CLN, Key 
Out, AUX1, AUX2, IP 
OUT1, IP OUT2 Green 

Tally

Off, PGM, PVW, 
CLN, Key Out, AUX1, 
AUX2, IP OUT1, IP 
OUT2

Standardwert PGM PVW

7 Date/Time Date Setting Einstellbereich yyyy / mm / dd

Standardwert

Time Setting Einstellbereich hh : mm : ss

Standardwert

8 Initial Initial Settings Einstellbereich Execute

Standardwert

Initial Fader Einstellbereich Execute

Standardwert

9 System 
Information

System Version Einstellbereich Nur Anzeige

Standardwert

System Core1 
Version

Einstellbereich Nur Anzeige

Standardwert

System Core2 
Version

Einstellbereich Nur Anzeige

Standardwert

System Core 
Update

Einstellbereich Execute

Standardwert
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Nr. Untermenü Einstellungsposten Einstellung
14 Project 1 Project File Project 1 Einstellbereich

Protect
Off, On

Load
Execute

Standardwert Off

Einstellbereich
Save

Execute
Delete

Execute

Standardwert

Einstellbereich
Name

32 Zeichen
Date

Nur Anzeige

Standardwert

Project 2 Einstellbereich
Protect

Off, On
Load

Execute

Standardwert Off

Einstellbereich
Save

Execute
Delete

Execute

Standardwert

Einstellbereich
Name

32 Zeichen
Date

Nur Anzeige

Standardwert

Project 3 Einstellbereich
Protect

Off, On
Load

Execute

Standardwert Off

Einstellbereich
Save

Execute
Delete

Execute

Standardwert

Einstellbereich
Name

32 Zeichen
Date

Nur Anzeige

Standardwert

2 Last Load File 
Name

Einstellbereich I: *****, U: *****, L: *****

Standardwert

3 Last Load Date Einstellbereich yyyy/mm/dd hh:mm

Standardwert
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Nr. Untermenü Einstellungsposten Einstellung
15 Ancillary/Audio 1 Ancillary AUX Einstellbereich Off, On

Standardwert On

PGM Einstellbereich Off, On

Standardwert On

PVW Einstellbereich Off, On

Standardwert On

CLN Einstellbereich Off, On

Standardwert On

MV Einstellbereich PGM, PVW, Off

Standardwert Off

2 Audio Assign AUX1 Einstellbereich IN1(***) bis IN9(***), Analog, Follow Video, OFF

Standardwert Follow Video

AUX2 Einstellbereich IN1(***) bis IN9(***), Analog, Follow Video, OFF

Standardwert Follow Video

PGM Einstellbereich IN1(***) bis IN9(***), Analog, Follow Video, OFF

Standardwert Follow Video

PVW Einstellbereich IN1(***) bis IN9(***), Analog, Follow Video, OFF

Standardwert Follow Video

CLN Einstellbereich IN1(***) bis IN9(***), Analog, Follow Video, OFF

Standardwert Follow Video

3 Analog IN Audio Einstellbereich Off, On

Standardwert On

Input Type Einstellbereich LINE, MIC

Standardwert LINE

Gain
Einstellbereich

–36dB, –33dB, –30dB, –27dB, –24dB, –21dB, –18dB, –15dB, 
–12dB, –9dB, –6dB, –3dB, 0dB, 3dB, 6dB, 9dB, 12dB

Standardwert 0dB

Delay(ms) Einstellbereich 0 bis 512

Standardwert 0

4 Analog OUT Assign Einstellbereich PGM, PVW, AUX1, AUX2, CLN

Standardwert PGM

Mute Einstellbereich Off, On

Standardwert Off

Volume Einstellbereich 0 bis 100

Standardwert

16 Network 1 LAN IP Address Einstellbereich 0 bis 255.255.255.255

Standardwert 192.168.0.8

Subnet Mask Einstellbereich 0 bis 255.255.255.255

Standardwert 255.255.255.0

Default Gateway Einstellbereich 0 bis 255.255.255.255

Standardwert 192.168.0.1

MAC Address Einstellbereich –

Standardwert –

2 Primary DNS IP Address Einstellbereich 0 bis 255.255.255.255

Standardwert –

3 Secondary 
DNS

IP Address Einstellbereich 0 bis 255.255.255.255

Standardwert –
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Nr. Untermenü Einstellungsposten Einstellung
17 External 

Interfaces
1 External Panel 

Information
Active Einstellbereich Disable, Enable

Standardwert Disable

Port No Einstellbereich 62000 bis 65535

Standardwert 62010

2 External Panel 
IP

Shot Memory 
Recall

BKGD Einstellbereich
Target 

Off, On
XPT

Off, On

Standardwert Off Off

Key1 Einstellbereich
Target 

Off, On
XPT

Off, On

Standardwert Off Off

Key2 Einstellbereich
Target 

Off, On
XPT

Off, On

Standardwert Off Off

AUX1 Einstellbereich Off, On

Standardwert Off

AUX2 Einstellbereich Off, On

Standardwert Off

CBGD Einstellbereich Off, On

Standardwert Off

XPT Einstellbereich Off, On

Standardwert Off

3 External 
Control 
Switcher

Active Einstellbereich Disable, Enable

Standardwert Disable

Port No Einstellbereich 62000 bis 65535

Standardwert 62000

Interval Time Einstellbereich 0ms, 16ms, 32ms, 48ms, 64ms, 80ms

Standardwert 16ms

Response Einstellbereich On, Off

Standardwert On

4 External 
Control AUX 
Panel

Port No Einstellbereich 62000 bis 65535

Standardwert 65000

IP Address1 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address2 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address3 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address4 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address5 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address6 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address7 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address8 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address9 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address10 Einstellbereich 0 bis 255

Standardwert 0.0.0.0
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Nr. Untermenü Einstellungsposten Einstellung
17 External 

Interfaces
4 External 

Control AUX 
Panel

IP Address11 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address12 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address13 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address14 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address15 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address16 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address17 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address18 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address19 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

IP Address20 Einstellbereich 0 bis 255

Standardwert 0.0.0.0

18 USB Memory 1 Load Load Type Einstellbereich Still1, Still2, Project, Update

Standardwert Still1

Load Einstellbereich Execute

Standardwert

2 Save Save Type Einstellbereich Still1, Still2, Project, Log

Standardwert Project

Setup Einstellbereich On, Off

Standardwert On

Shot Einstellbereich On, Off

Standardwert On

Still Einstellbereich On, Off

Standardwert Off

File Format Einstellbereich bmp, tga, png, jpg, tif, gif

Standardwert png

Save Einstellbereich Execute

Standardwert

3 Free Einstellbereich Freier Speicherplatz [KB/MB/GB]

Standardwert

4 Total Einstellbereich Speicherkapazität [KB/MB/GB]

Standardwert

5 Unmount Einstellbereich Execute

Standardwert

6 Format Einstellbereich Execute

Standardwert
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Nr. Untermenü Einstellungsposten Einstellung
19 Color Adjust 1 Target Einstellbereich IN1(***) bis IN5(***)

Standardwert IN1(***)

2 Parameter No Einstellbereich 1 bis 10

Standardwert 1

3 Marker Einstellbereich Off, On

Standardwert Off

4 Capture for 
Master

Einstellbereich Execute

Standardwert

5 Adjust Target Einstellbereich Execute

Standardwert

6 Enable Color 
Adjust

Einstellbereich Disable, Enable

Standardwert Disable

7 Left Einstellbereich –50.00 bis 50.00 (Left<Right)

Standardwert –50.00

8 Top Einstellbereich –50.00 bis 50.00 (Top>Bottom)

Standardwert 50.00

9 Bottom Einstellbereich –50.00 bis 50.00 (Top>Bottom)

Standardwert –50.00

10 Right Einstellbereich –50.00 bis 50.00 (Left<Right)

Standardwert 50.00

11 Set Capture 
Points

Einstellbereich Execute

Standardwert

12 Points Punkt 1 bis 24 Einstellbereich

X-Position

–50.00 bis 50.00

Standardwert
Durch “Left = –50.00, Top = 50.00, Bottom = 
–50.00, Right = 50.00” erzeugter Wert (Nutzung 
des gesamten Bildschirms)

Einstellbereich

Y-Position

–50.00 bis 50.00

Standardwert
Durch “Left = –50.00, Top = 50.00, Bottom = 
–50.00, Right = 50.00” erzeugter Wert (Nutzung 
des gesamten Bildschirms)

13 Parameters Parameter 1 bis 
10

Einstellbereich
Master

IN1 bis 5

Standardwert

Einstellbereich
Name

16 Zeichen

Standardwert
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Anhang (Glossar)
Im Folgenden werden die in dieser Anleitung verwendeten Begriffe definiert.

Begriff Erläuterung

AB Bus system
AB-Bus-System

Ein Bus-Steuermodus. Durch Ausführung eines Übergangs werden die Signale von 
A-Bus und B-Bus abwechselnd zu den Programmbildern ausgegeben.

Ancillary Data
Zusatzdaten

Die Hilfsdaten außer den Videosignalen, die innerhalb des Datenstroms der seriellen 
Videoschnittstelle übertragen werden. Die in die vertikale Austastlücke eingeblendeten 
Daten werden mit V-Zusatzdaten (VANC) bezeichnet.

Aspect ratio
Bildseitenverhältnis

Das Verhältnis zwischen den horizontalen und vertikalen Abmessungen eines Bilds oder 
Bildschirms.
Es beträgt 16:9 für das HD-Format und 4:3 für das SD-Format.

AUX
[Auxiliary Bus]
[Hilfs-Bus]

Ein Reservebus, der durch andere Signale außer den Hauptleitungs- Ausgangssignalen 
umgeschaltet werden kann.

BB
[Black burst]
[Black-Burst-Signal]

Abkürzung für Black-Burst-Signale. Ein bildschirmfüllendes Schwarzpegel-Composite- 
Signal, das als Referenzsignal für Genlock verwendet wird.

Border
Rand

Der Bereich oder Rand, der zur Kante eines Wipes oder Keys hinzugefügt wird.
Seine Breite und Farbe können eingestellt werden. Die Unschärfe des Bereichs um 
einen Rand nennt man den Soft-Effekt.

Chroma key
Chroma-Key

Dieser Begriff bezieht sich auf die Funktion zur Erzeugung der Key-Signale auf der Basis 
der Farbinformation der Videosignale und auf die Kombination der Keys.

Clip Der Schwellenpegel der Luminanz, wenn Key-Signale von einer Key-Quelle erzeugt 
werden.

Color Background
Farbhintergrund

Die Signale, die vom internen Farbgenerator ausgegeben und als Hintergrundbild 
verwendet werden.

Cut Dieser Begriff bezieht sich auf den Effekt, bei dem die Anzeige augenblicklich auf das 
nächste Bild umgeschaltet wird.

Density
Dichte

Ein Parameter, der zur Einstellung der Dichte der Key-Signale verwendet wird.

Down Converter
Abwärtswandler

Diese Funktion wandelt Material des 4K-Formats in das 2K/HD-Format um.

Embedded Audio
Eingebetteter Ton

Dieser Begriff bezieht sich auf die Audiodatenpakete, die im Datenstrom der seriellen 
Videoschnittstelle übertragen werden.

Flip Flop system
(PGM/PST system)
Flip-Flop-System
(PGM/PST-System)

Ein Bus-Steuermodus. Die vom Programmbus ausgewählten Signale
werden immer als Programmbilder ausgegeben. Durch Ausführung eines
Übergangs erfolgt eine Umschaltung zwischen den Programmbus- und den
Vorwahlbussignalen.

Frame Synchronizer Eine Funktion, welche die Synchronisierung von nicht synchronisierten Video- 
Eingangssignalen anpasst.

Freeze Eine Pausenfunktion für Videosignale.

FTB [Fade to Black]
[Ausblenden zu Schwarz]

Dies ist ein Effekt, bei dem das Hintergrundbild zu einem schwarzen Bildschirm 
ausgeblendet wird.

Genlock Eine Funktion zur Synchronisierung der Videosignale mithilfe eines externen Sync-
Signals als Referenz.

GPI
[General Purpose Interface]
[Schnittstelle für 
Allgemeingebrauch]

Schnittstellensignale, die automatische Übergänge von einer externen Quelle aus 
steuern.

Hue
Farbton

Der Farbton der Videosignale.
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Begriff Erläuterung

Key Edge
Key-Kante

Der Rand oder Schatten, der den Kanten von Keys hinzugefügt wird.

Key Fill Ein Signal, das Key-Kombinationsverarbeitung verwendet, um die Flächen auszufüllen, 
die von den Key-Signalen frei gelassen worden sind.

Key Gain
Key-Verstärkung

Ein Parameter, der zur Einstellung der Amplitude der Key-Signale verwendet wird.

Key Invert Eine Funktion zur Umkehrung der Key-Signale.

Key Mask
Key-Maske

Dies ist eine Funktion, bei welcher der Bereich für die Key-Kombination mithilfe des 
Kastenmusters usw. festgelegt wird. Wenn nur ein Teil des Key- Signalbereichs 
verwendet wird, erfolgt die Ausführung der Key-Kombination unter Maskierung des 
unnötigen Bereichs.

Key Source
Key-Quelle

Die Videosignale zur Erzeugung der Key-Signale.

Line Synchronizer
Line-Synchronizer

Diese Funktion passt die Signalphase des Eingangsbilds automatisch an die Phase des 
Horizontalsynchronisierungs-Referenzsignals an.

Linear Key
Linear-Key

Eine Funktion, die Keys kombiniert und dazu Monochrom-Key-Signale mit Abstufungen 
in ihren Umrissen als Referenz verwendet.

Lum
[Luminance]
[Luminanz]

Der Helligkeitsanteil der Videosignale.

Luminance Key
Luminanz-Key

Eine Funktion, die Key-Signale auf der Basis der Luminanz-Information (Helligkeit) der 
Videosignale erzeugt, um Keys zu kombinieren.

ME
[Mix Effect]
[Mischeffekte]

Eine Video-Effektvorrichtung, die eine Reihe von Videosignalen kombiniert, um Mix-, 
Wipe-, Key- und andere Videosignale zu erzeugen.

Mix Ein Bildwechseleffekt, der durch Überlappen eines Bilds mit dem nächsten erzeugt wird.
Dieser Effekt wird auch “Dissolve” (Überblendung) genannt.

Multi View Display
Mehrfeldanzeige

Diese Funktion kombiniert mehrere Materialien und zeigt sie auf einem Bildschirm an.
Sie ermöglicht die gleichzeitige Vorschau von “PGM-”, “PVW-” und Eingangssignalen auf 
einem einzigen Bildschirm.

PinP [Picture in Picture]
[Bild in Bild]

Diese Funktion kombiniert das Bild eines Unterbildschirms mit dem Hintergrundbild.

PVW
[Preview]
[Vorschau]

Eine Funktion zur Vorprüfung des Bilds, das nach dem nächsten Übergang ausgegeben 
wird. Das Bild wird vom PVW-System ausgegeben.

PGM
[Program Bus]
[Programm-Bus]

Der Bus, der immer die Programm-Ausgangssignale führt.

PST
[Preset Bus]
[Vorwahl-Bus]

Der Bus, der die Programm-Ausgangssignale nach dem nächsten Hintergrundübergang 
führt.

Sat
[Saturation]
[Sättigung]

Damit bezeichnet man die Intensität des Chrominanzpegels der Videosignale.

SDI
[Serial Digital Interface]
[Serielle Digitalschnittstelle]

Ein Standard, nach dem Videosignale in verschiedenen SD- und HD-Formaten über ein 
einzelnes Koaxialkabel übertragen werden.

Self Key
Eigen-Key

Eine Funktion, die Key-Signale von Key Fill-Signalen zur Kombination von Keys erzeugt.

Anhang (Glossar)
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Begriff Erläuterung

Setup Data
Setup-Daten

Ein Speicher, in dem die Steuerpultstatusse gespeichert und abgerufen werden können.
Die Tastenwahlzustände sowie die Informationen von Rand-, Farb- und anderen 
Einstellungen können in diesem Speicher gesichert werden.

Tally Ein Signal, das die Programmausgangszustände der Eingangssignale an ein externes 
Gerät ausgibt. Die LED, die den Programmausgangszustand am Steuerpult anzeigt, wird 
ebenfalls mit Tally bezeichnet.

Transition
Übergang

Eine Funktion zur Umschaltung von einem Bild auf ein anderes.
Wipe, Mix und andere Effekte sind für die Bilder während des Wechsels verfügbar.

Tri-level Sync
Tri-Level Sync

Das für HD-Formate verwendete Sync-Signal.

Trimming
Beschnitt

Dies ist eine Funktion, mit der unnötige Teile am oberen, unteren, linken und/oder 
rechten Rand von den mit der PinP-Funktion kombinierten Bildern entfernt werden.

Up Converter
Aufwärtskonverter

Dies ist eine Funktion, die Material im 2K/HD-Format in das höher auflösende 4K-Format 
konvertiert.

Video Memory
Videospeicher

In diesem Speicher können Bilder (Standbilder) mit Key-Signalen abgelegt werden.

Wipe Ein Videoeffekt, bei dem ein Bild allmählich durch ein anderes ersetzt wird, wobei die 
Grenze zwischen den beiden Bildern nach einem vorgewählten
Muster verschoben wird.

Anhang (Glossar)
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A
ALARM-Anzeige  ......................................................  16

Ancillary/Audio  .....................................................  144
Analog IN  ............................................................  144
Analog OUT  ........................................................  144
Ancillary  ..............................................................  144
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B
Bus-Tally-Anzeigen  ................................................  18

C
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